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In this topic, you will learn about SAP’s recommended methodology and tools for 
managing implementation projects.
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On completion of this topic, you will be able to:
• Describe the Accelerated Implementation Project methodology, including the 

purpose and milestones in each phase.
• Explain how the AIP methodology and related tools can help to manage risk-

free projects. 
• Use the embedded project plans in SAP Business One as the basis for your 

own projects, and create new project plans in accordance with the 
methodology.
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As a new partner, you want your first implementation project to be a success.  You 
need to create a project plan. Where do you start? How do you ensure the plan 
includes all the necessary tasks?

Solution: Successful projects follow a structured, phased approach. SAP’s 
Accelerated Implementation Program (AIP) provides a proven methodology for an 
SAP Business One implementation. It is based on the practical experiences ofSAP Business One implementation. It is based on the practical experiences of 
SAP and many implementation partners. Within this methodology, you will find 
project plans, as well as tools and documents to help you be successful.
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The first part of this topic examines the AIP methodology.
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As an implementation consultant, you are usually engaged at the end of the sales 
cycle, after the partner sales team signs a contract with SAP.  

The partner sales team purchases the required SAP Business One user licenses 
on behalf of the customer. 

Thus, from a contractual standpoint, there is no direct relationship between SAP 
and the end customerand the end customer.

The partner is responsible for implementation and support of the customer. SAP is 
responsible for defects in the SAP Business One software.
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What strategies can you use to be successful in an implementation project?

Take a few moments to review the list and identify one or more strategies that you 
would use to increase your chances of success.

Would you:

 Leverage SAP’s experience?

 Leverage the expertize of other partners?

 Use a detailed project plan to ensure all necessary tasks are completed?

 Set and manage the customer expectations?

 Thoroughly understand the requirements and scope of the project?

 Have a change management process?

 Involve the customer in major project decisions? Involve the customer in major project decisions?

 Assess and mitigate risk continually during the project?
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Successful implementation partners follow a structured or phased process for 
implementation.

The SAP Accelerated Implementation Program (AIP) is specifically designed for 
SAP Business One implementations.

The AIP methodology divides an implementation into five phases. These phases 
cover the period starting with the handover from the sales team to right before thecover the period starting with the handover from the sales team to right before the 
handover to the support organization.

The methodology provides milestones for each phase. Each milestone marks the 
completion of a discreet activity in the project: software installation, system 
configuration, testing, and so on. The milestones have been selected by SAP and 
partners as crucial checkpoints in your project plan.

Since all the methodology materials are published as a template, partners have 
the opportunity to adapt the methodology to their own practices.
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Project Preparation is the first phase in the implementation, during which the 
customer transitions from the sales cycle to implementation mode. 

For the implementation partner, the key activities are to:

• Conduct a project handover with the sales team

• Create a project plan for the implementation

• Conduct an official kick-off meeting with the customer team

• Deliver and install the SAP Business One software and demo database at the 
customer site. 

Note that the customer project manager and other key team members should 
have been appointed during the sales cycle. 

You can use the sample templates provided in the AIP methodology for a pre-
sales business analysis of the customer, handover from sales meeting, project 
plan, and kick-off meeting.
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To keep the project focused and on track, you should complete four milestones in 
this first phase:

1. First, you must clearly and thoroughly understand all aspects of the sales 
process, including the customer background, business processes, any risks or 
constraints, and any special or unusual requirements. You must have this 
information before you meet the customer. The handover meeting with the 
sales team is crucial to ensure a smooth transition of the customer from salessales team is crucial to ensure a smooth transition of the customer from sales 
to implementation. 

2. The kick-off meeting is the next milestone. This meeting marks the official start 
of the project. Ideally this meeting should be a face-to-face meeting, since that 
gives you the opportunity to create a relationship with the customer team and to 
set correct expectations for the implementation. Make sure you cover the 
agenda items outlined in the kickoff meeting template.

3 After the kickoff meeting the delivery and installation of the software is3. After the kickoff meeting, the delivery and installation of the software is 
important contractually. The software, including add-ons, must be fully installed. 
The implementation consultant should install the demo database (OEC 
Computers) for use later in the project. 

4. The last milestone is a checkpoint. A big advantage of the AIP methodology is 
as a control mechanism for keeping the project on track. To achieve this, 
the customer project manager is asked to acknowledge the completion of the 
phase with a signature. This final checkpoint gives you the opportunity to 
ascertain that the customer is happy with the project and does not have 
unrealistic expectations before the project moves on. 
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Business Blueprint is the second phase in the project and the project team 
focuses on a detailed analysis of the customer’s business processes and 
requirements. The requirements are now mapped to a solution in SAP Business 
One. The documentation of the solution is known as the business blueprint.

The AIP methodology recommends you conduct workshops with the customer 
representatives from each business area or department. In these workshops, you p p p , y
should analyze the detailed steps in each of the customers processes. In addition 
to major processes such as sales, purchasing, and service, you should cover 
reporting and financial processes. At the same time, you should identify the 
sources and volume of the legacy data that needs to be migrated. 

Check the templates provided in the AIP for assessing business processes.
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The AIP recommends four milestones for this phase:

1. First you must complete the requirements gathering workshops for each of the 
customer’s processes. 

2. Next, perform a "fit/gap analysis" to map the processes to an SAP Business 
One solution. The documented solution must be reviewed and accepted by the 
customer The blueprint then becomes the focal document for the next phase ofcustomer. The blueprint then becomes the focal document for the next phase of 
the project. 

3. This third milestone serves as a checkpoint to ensure that you assess the 
impact to the project of any gaps or change requests you identify during the 
fit/gap analysis. It is possible that these changes will affect the scope (work 
effort, timeline and/or cost) of the project. Factors that can increase scope 
include a large amount of customized reports, or high volumes of legacy data.  
It i i t t th t th j t l i d t d b d th B i Bl i tIt is important that the project plan is updated based on the Business Blueprint 
and that the customer agrees to the new schedule. Some partners prefer to 
conduct the requirements gathering exercise as a separate project, so that the 
scope can be fully defined and agreed prior to the start of the implementation. 
This is not a problem for the AIP methodology - phases 1 and 2 can be 
switched in sequence.

4. As in all phases, there is a final milestone that is a checkpoint. To keep the p p p
project on track, the customer should agree that all the phase deliverables and 
milestones have been met.
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Project Realization is the heart of the project, and in this phase the consultants 
implement all the business process and technical requirements defined during the 
previous phase. 

In addition, the legacy master data is migrated.

The newly-built system and master data is validated and tested by the customer 
using a test copy of the customer database All issues arising during testingusing a test copy of the customer database. All issues arising during testing 
should be logged and resolved before moving onto the next phase.

At the same time, the project manager draws up plans for training end users, and 
for the cutover period. The cutover periods happens just before go-live, when 
many activities must take place in the correct sequence and in a very short 
timeframe, so that the new system can fully run the production workload.
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The AIP has five milestones for this phase:

1. Milestone one is the Production system installed and configured based on the 
documented business blueprint. This includes the import of legacy master 
data.

2. The second milestone is the validation of the configured system by the 
customer. Validation involves an iterative process whereby the customer tests 

h fi ti h d b th lt t Thi ti it i tieach configuration change made by the consultant. This activity is sometimes 
known as "unit testing.“

3. The third milestone is provided to cover the broader testing that is required 
once the individual processes have been validated. System and integration 
testing involves the testing of entire business processes end-to-end, including 
the integration with other processes and external systems. This testing is 
performed exclusively by the customer team, with support from the 
implementation teamimplementation team. 

4. The next milestone is a project planning milestone. While the production 
system is being built and tested, the project manager focuses on planning for 
go-live.  A plan for training end users and a cutover plan must be completed 
and are crucial to the success of the project. 

5. The final milestone is the checkpoint for completion of the phase. Sign off for 
this phase indicates that the customer has accepted the new system 
functionality.functionality. 
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The Final Preparation phase coves the time period prior to go-live. During this 
phase, the SAP Business One system and the client organization are transitioned 
into production mode. 

This includes training end users to use the new system.

A decision and date for go-live is agreed with the customer.

A ti b l d fi l t ti f th l t t f dAccounting balances and final transactions from the legacy system are transferred 
to the production system. The transfer of the balances takes place before go-live 
in what is called the “cutover” period.

The actual switch to go-live happens at the end of this phase. 
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The AIP includes four milestones for this phase:

1. End users must be fully prepared to use the new system. Escalations can occur if end 
users are not trained in the new system. Depending on the contract terms, end user 
training is sometimes the responsibility of the customer. Even so, the partner still has a 
responsibility to assess that users can perform their jobs effectively. 

2 System readiness is a key decision that you and the customer make together Is the2. System readiness is a key decision that you and the customer make together.  Is the 
system ready for production operations?  Everything must be in place: users trained, 
IT procedures written, backup and recovery tested, external interfaces working, and so 
on. The AIP methodology provides a Phase and Risk Analysis tool to help you 
manage the system readiness and cutover activities. 

3. The third milestone stipulates that all cutover tasks are completed. There are many 
critical activities that must be completed in a short period of time to transfer operations 
f th l t t th SAP B i O t i l difrom the legacy system to the new SAP Business One system, including:

 Import of open transactions from the legacy system
 Entering opening balances from the legacy balance sheet 
 Reconciliation of accounting between the legacy system and the new 

system
 Closing down the legacy system and starting production on SAP Business 

OneOne

4. The last milestone is the checkpoint for the phase. Sign-off indicates that the customer 
agrees that all the conditions for go-live have been met. The SAP Business One 
system can now be put into production, at an agreed time and date. 
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Go-Live and Support is the final phase in the project. As the name suggests, the 
newly-built system is now running in production. 

The implementation team should monitor and resolve any critical problems, then 
hand over the system to the customer team, to the partner support organization, 
and to SAP support. 
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The new system is now running in production. The AIP includes three milestones 
for this final phase:

1. Once the new system has been running with no critical issues for a designated 
period of time, you should hand over the system to your support group, and to 
SAP support. It is a good idea to provide your support staff with the 
documented Business Blueprint. At the same time you must ensure that the p y
customer can manage the day to day administrative tasks such as backup. 

2. The second milestone marks the closure of the project. In this sign-off, the 
customer is acknowledging and accepting the system in production. 

3. The final milestone is met when a "Review and Optimization" conference takes 
place, to review how well the project went. The sales account manager and the 
sponsor from the customer side should attend. This meeting also provides an 

t it t l f f th h dditi l h topportunity to plan for a further phase or additional enhancements.
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A complete project plan is provided with the AIP implementation methodology. The 
project plan is in Microsoft Excel, and you can easily adapt the plan to your needs.

This plan serves as the master document for the AIP phases, and contains all the 
required tasks, milestones and best practices. 

You can use the plan to assign tasks and manage task status. 
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The same project plan is also embedded in the SAP Business One application at 
release 9.0 and above. You can access this plan from the Implementation Center 
menu.

There are three template project plans available, in all languages supported by 
SAP Business One:

• Detailed project plan. This plan allows you to manage an implementation basedDetailed project plan. This plan allows you to manage an implementation based 
on the five phases defined in SAP’s Accelerated Implementation Project (AIP) 
methodology.

• Narrowed project plan. This plan contains tasks for just the configuration 
phases of the Accelerated Implementation Project methodology.

• Pre-configured project plan. This plan contains the necessary tasks to manage 
an implementation based on the entry-level SAP Business One Starter 
PackagePackage. 

You can edit the plan templates as needed, or create your own plans based on a 
template, or you can create a new blank project plan and add your own tasks. 
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There are some advantages in using an embedded project plan. You can maintain 
the plan at the customer site, enabling multiple consultants to share the plan, 
including customer project team members. Each person on the team and can view 
their required tasks with completion dates. 

On the Plan tab, you can also attach project documents and notes to any of the 
tasks. This is a very useful way of storing project files and sharing them with the 
project team membersproject team members.
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The embedded project plans contain links to the relevant SAP Business One 
configuration screens.  

In the example shown, when you select the link arrow for the task “General 
Settings”, the General Settings window automatically opens.

As you can imagine, this can speed up the time for a consultant to make the 
config ration settings Once the setting is done the cons ltant can then select theconfiguration settings. Once the setting is done, the consultant can then select the 
task complete checkbox to indicate as a record that the configuration is done.
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When you add a new task to an existing plan, or to a new plan, you have the 
option to add links to related configuration screens. This is useful if you have an 
add-on as part of the solution – you can add tasks for installing the add-on and 
provide links to the configuration of the add-on.

To add a link to a task:

• First select the checkbox for the task• First, select the checkbox for the task.

• Next, right-mouse click and choose Add Link from the context menu.

• In the Menu Selection Form, you can select the appropriate menu item from the 
SAP Business One menu. You can select an existing SAP Business One menu 
item, or new menu items that you created using the Software Development Kit.

• After you make a selection, the orange link arrow appears to the left of the task 
namename.

© SAP AG 30 TB1200



The second part of this topic looks at the tools, templates and documents that 
support the AIP methodology.

© SAP AG 31 TB1200



The downloaded AIP materials include tools, templates, and documents organized 
according to each phase and by purpose:

• Business Process Analysis tools and templates are provided for pre-
implementation scoping and fact finding, for gathering detailed business 
process requirements, and for gathering data migration requirements. A 
Business Process Master List (BPML) tool is provided for defining complex ( ) p g p
processes and roles. A Data Migration Guide provides a step-by-step approach 
to data migration and can be used in multiple phases.

• Configuration, Infrastructure and Testing tools and templates are provided 
to record the handover of software to the customer, and to document the setup 
and configuration. A tracking spreadsheet tool is provided for object migration. 
Sample test cases are provided in a spreadsheet, along with a Test Strategy 
guideguide.

• Project Management tools and templates include a PowerPoint template for 
the initial kick-off meeting with the customer, and  a sample Service Level 
Agreement (SLA). You can use the Training Guide as a reference for planning 
training during the implementation. Also supplied is a Change Request form 
and a change/issue log for managing issues during the implementation. The 
final tool worth a mention is the Phase Sign-off form. You should use this to get 

t i ff f k d li bl h i d t k th j tcustomer sign-off for a key deliverable or phase in order to keep the project on 
track.

A selection of the tools, templates and documents are explained next.
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The kick-off meeting with the customer serves as the foundation for the project. 
The AIP template can help you plan this meeting. The template includes the 
following  agenda:

• Introductions and Project Goals. The goals should summarize your 
understanding of the customer’s goals and the success factors. 

• Project Timeline The plan should inform the customer of the timeline and key• Project Timeline. The plan should inform the customer of the timeline and key 
events, including project meetings. The plan may be revised later, once the 
detailed requirements are gathered in Phase 2. 

• Project Team Organization. The success of the project depends on participation 
from the business process owners from each area, as well as the IT 
administrator.

• Project Scope. Describe how you did the scoping or how you came up with the j p y p g y p
estimates.

• Project Team Roles and Responsibilities. Team members need to understand 
the roles and their individual responsibilities as a member of the project team.

• Project Procedures. You should cover project-related administration. For 
example, space for implementation consultants to work on site, and remote 
access. You should also cover where project documentation will be stored.
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You can also find templates to help you with the business requirements analysis:

• The Pre-Sales Analysis and the Handover from Sales can be used before the 
start of the implementation, to get a high-level picture of the customer’s 
business.

• The Blueprint Process Questionnaire and the Data Migration Assessment can 
be used during the Business Blueprint phase to gather the details of thebe used during the Business Blueprint phase to gather the details of the 
customer’s business processes.
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The Phase and Risk Analysis tool can be used in all phases of a project. The 
spreadsheet contains a worksheet for each of the five phases. The tool asks a 
series of critical questions and you can assess the risk to the project based on 
your answer to each question.

In this way, you can use the questions as a checklist for reviewing a completed 
phase, or as a checklist for anticipating risk in an upcoming phase. p , p g p g p
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The Business Process Master List (BPML) tool is recommended for larger 
companies with many users. It helps to define complex job role s and 
authorizations according to the processes in SAP Business One. Much of the 
required data is pre-loaded and you need only to:

• Define the names of the users.

• Select the roles in use or define new roles• Select the roles in use, or define new roles.

• Select the processes in use, or define new processes.

• Select the SAP Business One transactions that will be used by the customer, or 
define new transactions. 

• Fine tune the list of authorizations, if needed,

Once you have defined the elementary data, you can assign roles to the user 
Thi i t t ti ll i t th t ti dnames. This assignment automatically associates the processes, transactions and 

authorizations to each role, so all you need to do is review these assignments and 
make necessary adjustments.

For more information, refer to the BPML User Guide provided with the AIP 
materials.  
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The Data Migration Object List can be used to document the data migration 
requirements and data volumes from the legacy system, during the Business 
Blueprint phase.

The tool shows the input method options for migrating an object. For example, 
some objects can be easily entered manually, whereas high volume master data 
should be imported using the Data Transfer Workbench.p g

Lastly, you can use the tool to track and sign-off each object after migration, 
during the Project Realization phase.
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SAP provides various resources to help you as an implementation consultant. 
Going  clockwise from left to right, the resources are:

• The SAP Channel Partner Portal at http://service.sap.com/smb. Note that you 
need a user ID (the S-number*), which authorizes you to the services on the 
portal. You can download the AIP methodology materials from here, as well as 
free training courses. 

• The SAP Community Network is a series of forums sponsored by SAP where 
you can post implementation questions and have them answered by other 
partners.

• A Partner Service Advisory (PSA) organization provides you with a single 
point of contact to all SAP resources and provides guidance and advice to 
implementation partners. The Partner Services Delivery also facilitates 
enablement sessions on a variety of topics for implementation consultantsenablement sessions on a variety of topics for implementation consultants.

• Most countries have a country product specialist (Local Product Expert) who 
is an expert in the SAP Business One product and the requirements of your 
localization. There are also country-specific portal pages for many countries.

*Every employee from an SAP Business One partner should get a personal user 
ID. If your organization has signed SAP’s partner agreement, one person from 
your organization will be authorized to request a user ID for you from SAP. You 
can use a Single-Sign-On passport to log on to the portal. Note: If you do not 
know who your super-administrator is, contact your local support office (see 
http://service.sap.com/local-support) or send an e-mail to support@sap.com.
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Here are some key points to take away from this session.
• SAP’s Accelerated Implementation Program (AIP) is a proven methodology for 

an SAP Business One implementation. It is based on the practical experiences 
of SAP and many partners. 

• The AIP methodology divides an implementation into phases. These phases 
cover the period starting with the handover from the sales team to right before 
the handover to the support organization:pp g

• Project Preparation: The project plan is created for the implementation. A 
kick-off meeting is held with the customer, and the software is delivered.

• Business Blueprint: The focus is on analyzing the customers business 
processes and requirements, and mapping them to a solution. 

• Project Realization: The heart of the project where the company is 
configured to match the business blueprint. Testing also takes place.

• Final Preparation: The focus is on preparing for go-live. The go-live date is 
t th t i d d th fi l b l t f dset, the users are trained, and the final balances transferred over.

• Go-Live and Support: After go-live the customer moves into support mode.
• The project plan is the master document for the AIP methodology.  Since the 

plan is based on SAP’s experience plus the experience of many partners, you 
can ensure that no critical tasks are missed. 

• The AIP project plan is available as a template in Microsoft Excel format.  
Several plan templates are also provided in the Implementation Center within 
SAP Business One. An embedded plan can be shared by the customer team, p y ,
and you can store project attachments in the plan. 

• You can create a new plan based on one of the template plans or you can add 
a new plan in SAP Business One, with your own tasks. You can add drill-down 
links to new tasks if there is an applicable menu screen. 
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In this topic, we will look at how to easily create a new company database and 
configure common settings for an SAP Business One company, in one simple step 
using a guided wizard.
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At the end of this topic, you will be able to create a new SAP Business One 
company and configure the common settings by following an easy to use wizard.
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Let us look at a business example. 

This is your first implementation project and you want to make sure that you make 
the required configuration settings in the correct order. Due to data dependencies, 
there is a recommended order for initializing a new company. This should be done 
before master data is imported. In addition, some initialization settings cannot be 
altered after you have posted transactions.

Solution: You can easily create a new company and configure common settings, 
using a step-by-step approach provided by the Express Wizard.
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The Implementation Center provides a central location for SAP’s configuration and 
implementation tools. 

The Express Configuration Wizard is one of the tools provided in the 
Implementation Center. The tools are located under the Implementation Tasks 
menu.

To run any of the tools the general authorization Administration >SystemTo run any of the tools, the general authorization Administration >System 
Initialization> Implementation Tasks > Implementation Tasks is required.
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To prepare SAP Business One for use at a company, you must configure various 
settings, such as accounting, inventory, business partners, users, sales, and 
purchasing. Due to data dependencies, there is a suggested order for completing 
the system initialization and setup for a new company. 

The individual configuration screens are located under the Administration > 
System Initialization and Administration > Setup menus. y p

For less experienced partners, it is often easier to use the Express Configuration 
Wizard, since the wizard groups the required screens in an easy to use wizard.
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To create a new company and configure it in one step, choose the option New 
Using Wizard from the Choose Company screen. Note that you need to enter the 
site user password whenever you create a new company.
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You can also use the wizard to configure an existing company. Open the 
Implementation Tasks screen in the Implementation Center. Choose Configure 
Company Settings from the Implementation Tasks screen. 
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When you create a new company using the Express Configuration Wizard, the 
wizard first takes you to the standard company creation screen where you enter 
the name for the company and database. 

If a license is installed, the new company must be for the same localization. If this 
is a new SAP Business One installation, you can select the Trial Version 
checkbox. After the 31 day window expires, you can install the license key and y p , y y
apply it to the trial company.

You can choose to copy the user-defined fields, tables and objects from your 
existing company to the new company. This can be useful when there is a need to 
create an additional company for the customer’s business.

When you select the localization settings, this activates local tables and 
functionalities for the new company. You cannot change the localization after the 

i t dcompany is created. 
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SAP Business One is supplied with chart of account templates for the selected 
localization. If you choose the “template” option, a default chart of accounts will be 
created automatically based on the localization; and you can edit these accounts 
as desired. Alternatively you can choose the option “user-defined”. Only the top-
level drawers are provided in a user-defined chart of accounts, allowing you to 
manually add accounts to the drawers. Note: You cannot change the chart of 
accounts option after you have posted transactions in the new company. p y p p y

You can select the base language, used for the UI display. The display language 
can be changed at any time, and can be set for each user.

Lastly, you define the posting periods. At a minimum you should define the initial 
posting periods for the first fiscal year. You can define posting periods for 
subsequent fiscal years after the company is created. Note: If you intend to import 
or post transactions for the previous fiscal year, you must define the posting 
periods for the previous year before you define the periods for the current year. p p y y p y
Once you have defined the periods for the current year you cannot add posting 
periods for an earlier year.

When you create a new company, the user “manager” is created by default. You 
supply a password for this user, and you use these credentials to login to the 
company for the first time. You also need to electronically sign the End-User 
License Agreement (EULA).
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After the new company is created, the wizard guides you through the configuration 
process steps for configuring the company setup:

• Company Details

• Accounting

• Banking 

• Business Partners

• Inventory (Stock)

• Sales and Purchasing

• Users.

Instead of having to select the individual menu items from the Administration 
menu, the wizard automatically groups related configuration screens together in amenu, the wizard automatically groups related configuration screens together in a 
step.

The wizard also ensures that you follow the correct sequence for configuring a 
company, and advises you of any settings that cannot be changed after 
transactions have been posted for the company.

Note: The Express Wizard covers the most common settings needed for a new 
company. However, you may still need to access the Administration menus to 
complete the settings for a customer.
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In step one, the wizard guides you to configure the company details. The 
information here is roughly equivalent to information in the menu Administration > 
System Initialization > Company Details – General tab.
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In the accounting step, the wizard guides you through the setup for general 
accounting and perpetual inventory. 

There are several screens for accounting setup. 

The basic initialization for accounting includes the local currency, system currency, 
default currency and exchange rate currency. The equivalent configuration menu 
is Administration > System Initialization > Company Details Basic Initializationis Administration > System Initialization > Company Details – Basic Initialization 
tab.
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In the next accounting setup screen you have the option to select a different chart 
of accounts template. You cannot change the template after postings have been 
made.

You can enable the advanced G/L account determination feature in this step. You 
can also enable the use of segmented accounts if available in the localization.

The equivalent configuration menu is Administration > System Initialization >The equivalent configuration menu is Administration > System Initialization > 
Company Details – Basic Initialization tab.
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In the accounting setup step, you can additionally:

• Add accounts to the chart of accounts. The equivalent configuration menu is 
Financials > Chart of Accounts.

• Select accounts for the G/L account determination. If you selected the chart of 
accounts as “user-defined”, you need to select the default accounts. The 
equivalent menu is Administration > Setup > Financials > G/L Accountequivalent menu is Administration > Setup > Financials > G/L Account 
Determination. If you enabled advanced G/L account determination, you can 
set advanced G/L account determination rules from here. You should always 
review these default accounts with the client accountant before any 
transactions are posted. 

• Define additional posting periods, in addition to the initial posting period defined 
earlier. This is equivalent to the menu Administration > System Initialization > 
P ti P i dPosting Periods.

• Set up tax-related information. This is equivalent to the menu Administration > 
Setup > Financials > Tax.

• Enable the use of fixed assets and other functionality, depending on 
localization.

If you enabled fixed assets, you will have the option to define depreciation types 
d d t land areas and asset classes.
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In the final accounting setup screen, you can enable and set up information for 
perpetual inventory such as the default valuation method. The equivalent 
configuration screen is Administration > System Initialization > Company Details –
Basic Initialization tab.

Here you can also define warehouses and indicate the default warehouse. 

The Set G/L Accounts By selection is just the default accounting level for newThe Set G/L Accounts By selection is just the default accounting level for new 
items: warehouse, item group, or item level, and can be overwritten in the item 
master data. The G/L account determination for inventory postings will be taken 
from the level specified in the item master data. 

On this screen you can select the option to manage inventory stock levels by 
warehouse. 
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The banking step in the wizard allows you to enter the details for the house banks 
and business partner banks. The equivalent configuration menu is Administration 
> Setup > Banking. 

The Banks table holds the country codes and bank codes for the banks that the 
company deals with.

The House Banks table holds bank and branch information for the bank codesThe House Banks table holds bank and branch information for the bank codes 
defined in the Banks table.

You can select a default bank account for payments.
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The business partners step allows you to define default payment terms and 
payment methods, dunning terms, and groups for business partners. The 
equivalent configuration menus are Administration > General Settings – BP tab 
and Administration > Setup > Business Partners.
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In the inventory step, you can define:

• Units of measure and units of measure groups. 

• Item groups and inventory cycles. The equivalent configuration screens are 
found under the menu Administration > Setup > Inventory.

• New price lists and item prices in a price list (assuming items exist in the new 
) Thi i i l t t th I t P i Li tcompany). This is equivalent to the menu Inventory > Price Lists. 

• Bin locations in warehouses.
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In the sales and purchasing step, you can configure the common settings for sales 
and purchasing documents:

• General and per document type settings. This is equivalent to the configuration 
menus Administration > System Initialization > Document Settings

• Global checkboxes for Permit More than One Document Type per Series and 
Manage Freight in DocumentsManage Freight in Documents

• How decimal places are displayed in documents. This is equivalent to the menu 
Administration >  System Initialization > General Settings - Display tab.

• Document numbering series for each document type. The equivalent 
configuration menu is Administration > System Initialization > Document 
Numbering. Note: Document numbering is covered in detail in a companion 
topicp

You can set the way gross profit is calculated in documents. You can also set up 
landed costs allocations for purchasing, and stages to define the company’s sales 
process. The equivalent menus are Administration > Setup > Purchasing > 
Landed Costs, and Administration >Setup > Sales Opportunities. 

You can select fields from documents as reference fields for journal entries. The 
equivalent menu is Administration > Setup > General > Reference Field Links.
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In the users step, you can define user accounts and designate employees as 
sales employees or buyers. This is equivalent to the administration menus 
Administration > Setup > General > Users and Administration > Setup > General > 
Sales Employees/Buyers.

You can assign user licenses to user accounts - equivalent to the administration 
menu Administration > License > License Administration.

You can grant general authorizations to users - equivalent to the administration 
menu Administration > System Initialization > Authorizations.

You can create master data for the company’s employees - equivalent to the 
menu Human Resources > Employee Master Data. Employee master data is 
required in order to set up data ownership authorizations.

Note: User accounts, licenses and general authorizations are covered in detail in g
a companion topic.
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On completion of the wizard, a baseline configuration report is created. You can 
view and print this report.

When you make any subsequent configuration changes using the Express 
Wizard, a new configuration report will be created.

You can access and compare these reports at any time from the Implementation 
Center menu Administration System > System Initialization > ImplementationCenter menu Administration System > System Initialization > Implementation 
Center > Configuration Management.

Note that when you make configuration changes outside of the wizard, a 
configuration report is not created automatically; however, you can save the 
current configuration as a report from the General tab of the Configuration 
Management screen.
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The Express Wizard marks with a red exclamation mark (!) any settings and 
checkboxes that cannot be changed after a transaction has been posted for the 
company.

You should carefully plan these settings with the customer since you cannot 
change most of them after you have posted transactions in the company. 

These settings are grayed out in the wizard and cannot be changed afterThese settings are grayed out in the wizard and cannot be changed after 
transactions are posted:

 Chart of Accounts template

 Local and System Currencies

These checkboxes are grayed out and cannot be changed:

 Display Credit Balance with Negative SignDisplay Credit Balance with Negative Sign

 Use Segmentation Accounts

 Use Perpetual Inventory (Use Continuous Stock)

 Manage Item Cost per Warehouse

 Use Purchase Accounts Posting System

P it M th O D t T S i Permit More than One Document Type per Series

 Manage Freight in Documents
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To complete the configuration for a customer, you can set General Settings. These 
settings cover a wide range of defaults and initialization parameters for different areas. 
Choose Administration > System Initialization > General Settings and select the required 
tab. Note that some localizations may have additional tabs in the General Settings.

• BP – You can activate credit checking and approval procedures from this tab.

• Budget – You can activate budget management. Once this option is selected, the 
budget-related functions appear in the Financials module.

• Services – Actions specified under this tab are carried out each time the user logs on. 
These settings are specific to the current user.

• Display – You can define the display language and the ‘skin’ for the user, and how 
dates, numbers, and currencies are displayed. Some settings apply per company, for 
example, time and date formats, decimal places and character separator. 

• Font & Background – Set the text, font size and background for the current user from g , g
this tab.
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• Path – Set the default folder paths for storing images and attachments. You can also 
set the paths to the server folders for Microsoft Word and Excel templates which are 
referenced when the user exports a document to Word or Excel. These settings apply 
to all users.

• Inventory – Define defaults for serial and batch numbering,  warehouses, and MRP-
related information. These settings are updated immediately, per company, for all 
usersusers.

• Cash Flow – Define the global settings for assigning cash flow line items to cash flow 
relevant transactions.

• Cockpit  – Enable the cockpit and the display of dashboards at the company level. 
Note that the cockpit must also be enabled for each user. The dashboard requires the 
installation of the SAP Business One Integration Component.

• Cost Accounting  - Set configurations relevant to cost accounting.

• Pricing - Define settings related to zero-priced items and inactive price lists.
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The Document Settings window contains two tabs: General and Per Document.

In addition to the settings made in the Express Configuration Wizard, you can also 
apply settings to a specific type of document. For example:

 For sales orders you can enable automatic checks on the available quantities of 
items and offer alternate products if necessary. If you enable the “Allow Changes to 
Existing Orders” checkbox you cannot change this setting once documents haveExisting Orders  checkbox, you cannot change this setting once documents have 
been posted.

 For purchase orders, you can split a purchase order that relates to more than one 
warehouse. 
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These are the key points from this topic:

• You can create and configure a new company in one step using the Express 
Configuration Wizard. The wizard can reduce the time required to configure a 
new company, and makes it possible for a partner organization to adopt a 
uniform approach to configuration.

• Use the wizard to configure common settings instead of having to select the 
i di id l fi tiindividual configuration screens. 

• The wizard guides you through the correct order for configuration, automatically 
grouping related configuration screens. The wizard alerts you to irreversible 
settings.

• You can also run the Express Configuration Wizard from the Implementation 
Center to configure the settings for an existing company. 

• After you run the wizard for the first time, the system saves a baseline y y
configuration report. Each time you use the wizard to make additional 
configuration changes, a new report is created and you can compare the 
changes in the reports using the Configuration Management function.
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In this topic, we will look at how to select and copy information between SAP 
Business One company databases.
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This topic covers the use of the Quick Copy tool during an implementation project. 
On completing this topic, you will be able to select and copy records between SAP 
Business One company databases.
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A customer has three distinct trading entities which are being implemented as 
three separate company databases. All three databases require the same 
customizations, including user-defined fields and tables, customized reports, and 
standard configuration settings.

Solution: Customizations can be copied from one company to another using the 
Quick Copy tool.Q py
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Quick Copy is one of the tools provided in the Implementation Center in SAP 
Business One.

To launch Quick Copy, choose Administration > System Initialization > 
Implementation Center > Implementation Tasks. Then choose Copy Data Between 
Companies.

Note that unlike previous releases of SAP Business One the Quick Copy tool isNote that, unlike previous releases of SAP Business One, the Quick Copy tool is 
part of the core application in release 9.0 and is installed automatically with the 
SAP Business One server. 
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Quick Copy is a very useful tool during an implementation project. It allows you to 
selectively copy data records between company databases. For example, you can 
copy master data or customizations to a test database for testing and validation. 
Or you can copy configuration settings from one company entity to a different 
company entity. Note that this is not a full database copy. You still need to 
maintain full database backups for recovery purposes.

Quick Copy saves the copied data records in a file with the extension .qdf. Using 
Quick Copy, you can import this file into another company database. 

You can optionally save an XML project file containing the saved data categories. 
This file can be opened in the tool and can save time if you repeatedly need to 
export the same types of data. 
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When you open the Quick Copy screen you can see the data category hierarchy 
on the left-hand side of the screen. The categories are initially blocked for 
selection until you select the required settings on the right-hand side of the screen:

• Select the function (Copy to File for export, Copy from File for import) and file 
name.

• Select the copy method (this applies only for import)• Select the copy method (this applies only for import).

• Set options for handling errors. 

• Select the copy options (for import only).

Once you have made these settings, and choose OK, the data categories on the 
left-hand side of the screen will open up for selection.
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You select data from a category tree structure that aligns with the SAP Business 
One menu structure. Note that the structure does not change from company to 
company.

The categories cover customizations (including queries and reports), 
administration and configuration settings, financial settings, business partner 
master data,  inventory (including item master data and price lists), and human , y ( g p ),
resource master data.

You can drill-down the tree structure to view and select objects within a category 
structure.
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You can select any object in the category’s tree structure for the copy.

When you select the top level of a category, all the objects within the category’s 
tree structure are also selected for copy. You can individually deselect objects in 
the tree that are not required for copy.

When you select an object at the lowest level in a category, the system will display 
the detailed records for the object in the right hand pane This is shown in thethe detailed records for the object in the right-hand pane. This is shown in the 
graphic for the Item Master Data category. 

The records are selected by default, but you can deselect individual records not 
required for the copy.

When you later import the copy file to another company, you have the option to 
select categories or individual records from the data copy file.
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When you select a category, there might be data dependencies on other 
categories. For example, the item master data category has dependencies on 
business partner master data (vendors or resellers) as well as item groups and 
price lists. 
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The Quick Copy tool will indicate possible dependencies on other categories. 
These dependencies are derived from the database table structure, and not from 
the actual data records to be copied, and are therefore provided as warning not an 
error.

In the example shown, the Business Partner Master Data category is selected:

• A black exclamation mark ‘!’ indicates that a selected category is dependent on• A black exclamation mark !  indicates that a selected category is dependent on 
other data categories.

• A red exclamation mark ‘!’ indicates for an unselected category that other 
categories are dependent on this unselected category. In the example, the 
unselected category Vendor Type has this indicator.

When you see a category marked with parentheses ‘(!)’, this indicates that the 
dependencies are deeper in the category structure. You can expand the category p p g y p g y
to see the dependent objects within its structure. 
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After you have selected the categories, choose Export to start the copy.

During the copy process, the system displays the real dependent objects, 
dynamically derived from the data records to be copied. These dependent objects 
are automatically selected for copy with the other data.

Links are provided to view the dependent records, enabling you to decide whether 
to include them in the copyto include them in the copy. 

Be aware that if you deselect a dependent object, the copy may fail.
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After the copy, the system provides a full log record of the records copied, 
together with a link to the copied records.

In the example, shown, we can see the number of records copied for the Business 
Partner Master Data category. And we can drill-down to see the codes of the 
master data records.
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The source and target companies must have the same localization, and run on the 
same version of SAP Business One. 

If you need to copy records to a company with a different localization, the only 
category that can be successfully copied to a different localization is the 
Customization category.  Therefore you can copy user queries and categories, 
user-defined data (UDTs, UDFs, UDVs, UDOs), and print layouts and reports to a ( , , , ), p y p
company with a different localization. 
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After you have exported data to a file, the Quick Copy tool will prompt you to 
optionally save a project file. When you make frequent copies, a project file can 
save you time since the settings and data categories used in the previous copy 
operation are recorded in the project file. 

The project file can be opened from the Quick Copy menu on the top menu bar. 
Choose Quick Copy > Open Project to open a saved xml project file. Q py p j p p j

Note that you can only open the project file on the company on which it was 
created. You can also save a project file when you import on the target company.
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When you import records, you need to select the copy method, error handling 

option, and copy options. The choice of these options may depend on the data 

that already exists in the target company.

The copy method can be chosen to:

• Add new records and update records with matching keysAdd new records and update records with matching keys

• Add new records but not update records with matching keys

• Update records with matching keys without adding new records

• Erase all existing records in the target database and add new records

© SAP AG 81 TB1200



The error handling choices govern the Quick Copy response to an error while 

copying the records. You can choose to:

• Skip the affected record and continue copying valid records, or

• Stop the copy process when the number of errors reaches a specified limit

If th d t b i d t i d fi d fi ld th d fi d fi ld illIf the records to be copied contain user-defined fields, the user-defined fields will 

be automatically selected for copy, since they are a dependent category. However, 

if the dependent category is deselected, you must choose whether to copy records 

if the user-defined fields are not present in the target company. 
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In the copy options, you can set how to copy accounts and empty fields. Since 
objects such as item and warehouse data may contain assigned accounts, the 
copy option for accounts can be chosen to:

• Use Accounts in Source – If the source accounts also exist in the target, then 
the application copies the account assignments from the object in the source to 
the object in the target. However, if the source accounts do not exist in the j g ,
target, then the application encounters an error during the copy process.

• Use Default Accounts in Target – The application assigns the default accounts 
in the target to the object, and does not copy the source assignments.

The copy option for empty fields can be chosen to:

• Do Not Overwrite Target Fields and Keep Original Values – If a field in the 
source is empty, then the application skips copying this field. The application p y pp p py g pp
keeps the original value of the corresponding field in the target, which remains 
the same before and after the copy process.

• Overwrite Target Fields with Empty Values – If a field in the source is empty, 
then the application removes the value from the corresponding value in the 
target.

You also have the option to enforce a backup before the import starts. If you select 
th E f B k b f C i h kb th i t ill t d if ththe Enforce Backup before Copying checkbox, the import will not proceed if the 
target database has not been backed up within two hours.
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Here are some key points to take away from this session.

• The Quick Copy tool allows you to selectively copy data records between SAP 
Business One companies with the same localization and version. Quick Copy 
does not create a new company database. 

• The categories supported for copying include customizations, administration 
and configuration settings financial settings business partner master dataand configuration settings, financial settings, business partner master data,  
inventory, and human resource master data.

• The exported data records are saved in a file with the extension .qdf. Using 
Quick Copy, you can import this file into another company database. 

• You can optionally save an XML project file containing the export settings as 
well as the saved data selections. This can save time if you repeatedly need to 
export the same types of data. p yp

• When you select a category for copy, the Quick Copy tool automatically marks 
and selects dependent objects for copying. Links are provided to view the 
dependent records, enabling you to decide whether to include them in the copy. 

• Quick Copy is useful during an implementation project for copying 
customizations and configuration information, or master data, to a test system 
or to a different database for the same company.
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In this topic, we will cover the Solution Packager tool that enables partners and 
Software Solution Providers to create pre-packaged solutions for distribution to 
other partners.
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This topic covers the Solution Packager tool. You will be able to:

• Use the Solution Packager tool to package a solution that includes an SAP 
Business One company database

• Create a new company based on a pre-packaged solution

• Position the Solution Packager tool compared to the Quick Copy tool. g p py
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Let us look at a business example. Auto-ssp is a Software Solution Provider 
(SSP) that produces and sells a micro-vertical add-on for the automotive industry.  
To support volume business, partners must be able to install this as a pre-
packaged solution.

Solution: The Solution Packager tool provided in the Implementation Center g p p
allows Auto-ssp to package the add-on together with a preconfigured company 
database containing item master data, user-defined fields, reports, and an 
embedded project plan. 

Partners can quickly deploy the package at a customer, and follow the project plan 
to fine tune the add-on. 
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Solution Packager is an optional tool that can be selected for install during the 
SAP Business One server installation. When this tool is installed with the server, 
the executable path is automatically entered in the Path Settings in the 
Implementation Center, enabling the tool to be launched from the Implementation 
Center. To launch this tool, choose Administration > System Initialization > 
Implementation Center > Implementation Tasks, then choose Package a 
Preconfigured Solution Using Solution Packager.

Solution Packager can also be installed independently on the desktop, and can be 
started using the Start > All Programs menu.
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A solution package consists of an SAP Business One company database together 
with configurations and customizations that are generic to an industry-wide or 
vertical solution.

The concept behind Solution Packager is that Software Solution Providers (SSPs) 
can develop industry solution add-ons and bundle them with a preconfigured SAP 
Business One database. 

Value Added Resellers (VARs) can quickly deploy these packages at the 
customer, with the addition of customer-specific settings. This facilitates volume 
business and reduces implementation time for partners.

The Solution Packager provides an easy to use wizard to create the package as aThe Solution Packager provides an easy to use wizard to create the package as a 
transportable file with the suffix .pak.
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In a classic SAP Business One implementation, a company is created and 
configured individually for each new customer, usually at the customer site. 

The Solution Packager makes other deployment scenarios viable:

• In the volume scenario, a Software Solution Provider (SSP) packages a pre-
configured company database and add-on, using Solution Packager. The 
package is sold to partners The implementation by the partner is much fasterpackage is sold to partners.  The implementation by the partner is much faster 
because the partner does not have to configure the solution.

• Partners (VARs) can also get benefits by using Solution Packager to package 
horizontal solutions. A partner can package a pre-configured solution for 
sectors of customers with similar requirements and processes. The package 
can include customizations, reports, and any common add-ons. The packaging 
can be done remotely, saving on travel time and costs. The partner can quickly 
d l th k t h t it Thi i i t l f l fdeploy the package at each customer site. This scenario is extremely useful for 
creating branch companies for an existing company. 
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Some basic differences between the Quick Copy and Solution Packager tools are 
shown in this slide.

Quick Copy is designed for a partner to select and copy data objects from one 
company database to another, existing company database. 

Solution Packager is designed to package a complete solution including a 
company database A partner can directly deploy the package as a new companycompany database. A partner can directly deploy the package as a new company. 

*Note this limitation - the total size of the SAP Business One and external 
database combined cannot exceed 2 gigabytes.
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• The SSP prepares an SAP Business One base company, configured to meet 
the generic needs of customers in that industry. This might include a chart of 
accounts, G/L account determination, general settings, print layouts, financial 
reports for the industry, customizations and installed add-ons. 

• The SSP then uses the Solution Packager tool to create a bundled package. 
The SSP can even include a detailed project plan or task list for partners to p j p p
follow when they deploy the package.

• When the package is deployed at the customer site by the VAR, a new 
company database is created directly from the package. This new company 
contains the predefined configuration from the base company, as well as the 
industry specific data. The partner can configure this company to meet any 
special requirements for each customer. The partner can change the chart of 
accounts in the new company but not the localization To distribute a solutionaccounts in the new company, but not the localization. To distribute a solution 
for multiple localizations, the SSP should create a package for each 
localization. 
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• When you run the Solution Packager, you first enter information describing the 
solution, and contact information for the vendor. 

• You are prompted to select the SAP Business One company. You have the 
option to select any company database on the server as the base company for 
the package. 
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When you package the solution, in addition to the SAP Business One database, the 
wizard prompts you to include: 

• External objects such as SQL scripts and stored procedures. If you have created 
custom SQL scripts, SAP recommends that scripts are written in Unicode to avoid any 
future coding problems. Split every batch of transact-SQL statements (a script) by 
inserting a single line with the “Go” statement between each batch. The “Go” 
statement indicates the end of one batchstatement indicates the end of one batch.

• User-defined objects, tables and fields from the company database

• Alerts, user-defined values and queries from the company database

• Item groups, and associated item master data

• User accounts and authorizations. This makes it possible to define a job role with 
authorizations, that can be assigned to a user in the new company. For security 
reasons, when packaging users, the wizard does not copy the user password. Later, , p g g , py p ,
when you are creating new companies from the package, the company creator wizard 
sets the password of these users to be 1234.

• Cockpits and dashboards

• Reports and print layouts

• Project plans related to the installation of the solution, from the Implementation Center. 

• Other add-ons required as part of the solution.

• External databases required as part of the solution. The total size of the external 
database and the SAP Business One database must be less than two gigabytes; 
otherwise, the packaging may fail. You may not package an encrypted database.
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To create a new company based on a solution package, choose New From 
Package in the Choose Company screen.

Make sure that the version of the Microsoft SQL Server you select here is not 
lower than the version used for the original packaging.
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Follow the wizard steps to select the components from the package.

The first step is the select the .pak file which was built by the Solution Packager 
wizard and provided to you by the SSP. 
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Verify the solution and vendor information from the package file.
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Specify a name for the new company that will be created. 
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You can select a different chart of accounts from the one in the package. Note that 
if you select a different chart of accounts template, you should verify the G/L 
account determination from the package and make any changes for the new 
accounts.

© SAP AG 99 TB1200



At this point, the wizard follows the normal process for creating a new company, 
and you can define the posting periods.
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If the solution package contains an external database, you can create a database 
in addition to the SAP Business One database. The default database name is the 
name provided in the package, but you can change it.

If an external database was not packaged for the solution, this step displays No 
external database exists for this package. 

Note: If earlier in the Choose Company window, you specified a remote SAP 
Business One server, then in this step, the External Database Name field is 
disabled.

You need to deploy the package using the new company wizard on the SAP 
Business One server machine, so that you can create the external database.
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Now the standard process of creating the new SAP Business One company 
starts, and the tables are created. 

When user accounts are packaged, the default password for each user (except for 
the user "manager") is set to "1234". When the users are re-created in the newly 
created company, the users are locked by default for security reasons, and you 
must manually unlock them.y

Error messages may be logged in the System Messages area during the creation 
of tables in the new company. 
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Here are some key points to take away from this topic.

• Solution Packager allows a Software Solution Provider to package a vertical-
industry solution consisting of a company database with stored procedures, 
external databases, add-ons, and other customizations. A partner can deploy a 
new company directly from the package.

• SSPs can use Solution Packager to package a vertical solution for volume• SSPs can use Solution Packager to package a vertical solution for volume 
deployment by VARs.

• Partners (VARs) can also benefit by using Solution Packager to package 
horizontal solutions, such as creating branch companies for an existing 
company. The packaging can be done remotely, saving on travel time and 
costs. 

• Solution Packager is one of the implementation tools provided in the g p p
Implementation Center. To launch this tool, choose Administration > System 
Initialization > Implementation Center > Implementation Tasks.

• You can also install Solution Packager on the desktop and launch it using the 
Start > All Programs menu.
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Final Preparation: Exercises 

 

 

Unit: Implementation Tools 

Topic: Implementation Methodology 

 

 

 

1.1. Create a new project plan based on a template 

Choose Administration  System Initialization  Implementation Center  
Implementation Project. 

In the Plan tab, select the Detailed Project Plan template from the dropdown list. 

Select the icon to create a duplicate template. Enter Light & Music as the name and 
provide a description. 

Delete the task called “Project Handover” from the plan. 

Add a new task to the plan called “Learn the implementation tasks”. 

Move this task up to the start of the plan. 

1.2. Add a link to a configuration screen 

Select the row for the new task and right-mouse click to open the context menu. 

Choose Add Link. 

In the Menu Selection Form, navigate to Administration  System Initialization  
Implementation Center  Implementation Tasks. 

Test the link. The Implementation Tasks window will open. You can close this window. 

Choose Update to save your changes to the new plan. 

1.3. Record progress in the plan 

In the Plan tab, choose Level 1 to see the high level tasks (phases). 

Enter a value of 4 hours in the Planned Time column for the new task. 

Switch to the Progress tab and choose the drill-down arrow in the Actual Duration 
column for the new task.  

In the Time Record window, enter today’s date, the current time as the Start Time, and 
the current time + 2 hours as the End Time. 

If the Owner column is not visible, use Form Settings to make it visible and active. 

Select an owner. If there is no employee master data, choose New to create an 
employee record for yourself. 

Choose Update. 

The Progress column will show the actual progress based on the planned time. 

Save your changes to the plan. 
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Final Preparation: Solutions 

 

 

Unit: Implementation Tools 

Topic: Implementation Methodology 

 

 

1.1. Create a new project plan based on a template 

Choose Administration  System Initialization  Implementation Center  
Implementation Project. 

In the Plan tab, select the Detailed Project Plan template from the dropdown list. 

Choose the Duplicate Template icon to create a copy of the Detailed Project Plan.  

Enter Light & Music as the name and provide a description. 

Choose OK. 

Select the task called “Project Handover” and remove it from the plan by choosing the 
Remove Step icon (minus sign). If you choose a task that has child entries, you are 
given the option to remove the child entries as well as the task.  

Select a task row and add a new task by choosing the Add Step icon (+ sign).  

Add a task called “Learn the implementation tasks”. 

Choose the up and down arrows to move this task up to the start of the plan. 

1.2. Add a link to a configuration screen 

Select the row for the new task and right-mouse click to open the context menu. 

Choose Add Link. 

In the Menu Selection Form, navigate to Administration  System Initialization  
Implementation Center  Implementation Tasks. 

Choose OK. 

Test the link. The Implementation Tasks window will open. You can close this window. 

Choose Update to save your changes to the new plan. 

1.3. Record progress in the plan 

In the Plan tab, choose Level 1 to see the high level tasks (phases). 

Enter a value of 4 hours in the Planned Time column for the new task. 

Switch to the Progress tab and choose the drill-down arrow in the Actual Duration 
column for the new task.  

In the Time Record window, enter today’s date, the current time as the Start Time, and 
the current time + 2 hours as the End Time. 

If the Owner column is not visible, use Form Settings to make this field visible and 
active. 

Select an owner from the list. If there is no employee master data, choose New to create 
an employee record for yourself. Enter your own name as the employee name, then 
choose Add. 
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Select the employee name and choose Update. 

The Progress column will show the actual progress based on the planned time. 

Save your changes to the plan. 
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Customization Tools: Exercises 

 

 

Unit: Implementation Tools 

Topic: Express Configuration Wizard 

 

 

In this exercise, you will create a new company called Light & 
Music. In the new company, make the configuration settings 
necessary for your localization. You do not have to configure 
every setting, since there are defaults provided in the localization. 
However, you should view each setting to gain experience in 
configuration. 

 

 

1-1 Create and Configure a Company using the Express Wizard 

From the Main Menu, choose Administration  Choose Company. 

In the Choose Company window, select New, open the dropdown list, and choose New 
Using Wizard. 

Enter the site user password. 

 

1.1.1. Company Details 

Enter the following information for the new company: 

Field Information 

Company name The name of the company (Light & Music) 

Database name The name of the database (Light_Music) 

Note: Do not include spaces or special 
characters in the database name. 

License If a license has been installed, it will appear 
here. If no license is installed and this is a 
new installation, check the Trial Version 
checkbox. 

Local Settings Select the localization 

Chart of Accounts Select a chart of accounts template for the 
localization 

Base Language Select the display language 

Posting Periods Enter the Period Code and Period Name for 
the current fiscal year.  

Select the sub-period from the list. 

Choose Continue. 

Note: Make sure you enter the posting 
periods for the earliest fiscal year required. 
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Note: If you leave the Copy User-Defined Fields and Tables and Copy User-
Defined Objects checkboxes as selected, these objects will be copied from the 
current database. 

The system will create the new company. This may take a few minutes. 

Enter a password for the manager account in the new company. 

Enter information for the EULA and accept the EULA. 

Enter the company name, address and other details, as required. 

 

1.1.2. Accounting 

Review the accounting setup for the localization. 

Make the following changes: 

1. Add a new G/L account to the chart of accounts. The account is an active, 
cash account in the Assets drawer, called National Bank. 

2. Enable the Fixed Assets functionality. You will be prompted to set the 
initial settings, such as depreciation types and asset classes. 

3. Enable Intrastrat (if used in your localization). 

4. Enable segmentation accounts (if used in your localization). 

Note: Depending on the localization, other settings may appear in this window. 
Field Information
Local Currency The local currency. 
System Currency Select a parallel currency, if desired, for 

financial reporting.
Default Account 
Currency 

The default account currency for new G/L 
accounts.

Currencies Define additional currencies, if needed. 
Exchange Rate Posting Select an option to display exchange rates. 
Display Credit Balance 
with Negative Sign 

Select to display credit balances with a 
negative sign.

Allow Negative Amounts 
for Reversal Transaction 
Posting 

Select to have journal entries for reversals 
posted with negative amounts. 

Use Segmentation 
Accounts 

Account segmentation (localization 
specific).

Enable Advanced G/L 
Account Determination

Advanced G/L account determination 
rules.

Chart of Accounts Add or remove accounts in the template 
chart of accounts. 

G/L Account 
Determination 

Change the default accounts, and define 
rules if advanced determination is enabled. 

Posting Periods Define posting periods for future fiscal 
years.

Tax Define additional tax information, such as 
tax groups, withholding tax codes, sales 
tax codes, etc.

Enable Fixed Assets Enable Fixed Assets functionality. 
Enable Intrastat Enable Intrastat functionality (localization 

specific).

Note: Settings marked with a red exclamation mark (!) can only be changed before 
the first transaction is posted. 
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1.1.3. Banking 

Review the banking setup for the localization. 

Make the following changes: 

1. Add the National Bank to the Banks table. 

2. Define a House Bank for the National Bank. 

3. Set the National Bank as the default house bank. 

Field Information 

Banks Bank codes. 

House Bank Accounts House bank branch accounts. 

House Banks Default bank for the new company. 

 

1.1.4. Business Partners 

Review the business partner setup for the localization. 

Make the following changes: 

1. Define a new payment term for customers – Net 30 days. 

2. Define a new customer group – Hotels. 

Field Information 

Payment Terms Payment terms for customers and vendors. 

Note: The default payment terms for new 
business partner master data is set in the 
General Settings. 

Payment Methods Payment methods for the Payment Wizard.  

Dunning Terms Dunning terms for customers. 

Customer Groups Customer groups. 

Vendor Groups Vendor groups. 

 

1.1.5. Inventory 

Review the inventory setup for the localization. 

Make the following changes: 

1. Define a new item group – Screens. 

Field Information 

Units of Measure Units of measure. 

Units of Measure 
Groups 

Unit of measure groups. 

Item Groups Item groups. 

Inventory Cycles Cycles for inventory counting. 

Price Lists Add new price lists, and enter item prices in 
a price list. 

Warehouses Warehouses and bin locations. 
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1.1.6. Sales and Purchasing 

Review the sales and purchasing setup for the localization. 

Make the following changes: 

1. Set the default gross profit for service documents to 30%. 

 

Field Information 

Document Settings General document settings and settings per 
document type. 

Permit More than One 
Document Type per 
Series 

Certain country regulations permit 
document numbering series that contain 
more than one document type. Select this 
checkbox if these regulations are relevant 
for the company. 

Manage Freight Include a Freight field in sales and 
purchasing documents. 

Decimal Places The number of decimal places displayed for 
amounts, prices, exchange rates, quantities, 
percentages, units, and calculated values in 
queries. 

Document Numbering Document numbering and additonal 
numbering series. 

Calculate Gross Profit Activate gross profit calculation in sales 
documents. Select whether to calculate the 
gross profit percentage as the base price or 
the sales price. 

Landed Costs Landed costs for importing goods. 

Sales Stages Stages for sales opportunities. 

Reference Field Links Select which fields from documents will be 
used as reference fields in journal entries 
posted from the document (reference1, 
reference2, reference3). 

 

1.1.7. Users 

Note: The setup screens in this step will be covered in a later execise, therefore you 
can skip this step.  

Choose Finish. 

1.1.8. Configuration Report 

Select the link to open the configuration report. 

A Crystal Report will open, showing the configuration settings. 

Close the wizard. 
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1.1.9. Compare Configuration Reports 

When you make a change to the configuration using the Express Wizard, a new 
configuration report is generated. 

Open the Express Configuration Wizard again by choosing Administration  
System Initialization  Implementation Center  Implementation Tasks  
Configure Company Settings. 

 Make a change to one of the fields on the Company Details screen. 

Choose Finish to close the wizard. 

Choose Administration  System Initialization  Implementation Center  
Configuration Management. 

 You should see an additional report listed. 

Choose Ctrl + Click to select both reports and choose Compare Configurations. 

A Crystal report will open showing the changes. 
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Customization Tools: Solutions 

 

 

Unit: Implementation Tools 

Topic: Express Configuration Wizard 

 

In this exercise, you will create a new company called Light & Music. In the new company, 
make the configuration settings necessary for your localization. You do not have to configure 
every setting, since there are defaults provided in the localization. However, you should view 
each setting to gain experience in configuration. 

 

1-1 Create and Configure a Company using the Express Wizard 

From the Main Menu, choose Administration  Choose Company. 

In the Choose Company window, select New, open the dropdown list, and choose New 
Using Wizard. 

Enter the site user password. 

Choose Next. 

 
1.1.1. Company Details 

Enter the following information for the new company: 

Field Information 

Company name The name of the company (Light & Music) 

Database name The name of the database (Light_Music) 

Note: Do not include spaces or special 
characters in the database name. 

License If a license has been installed, it will appear 
here. If no license is installed and this is a 
new installation, check the Trial Version 
checkbox. 

Local Settings Select the localization 

Chart of Accounts Select a chart of accounts template for the 
localization 

Base Language Select the display language 

Posting Periods Enter the Period Code and Period Name for 
the current fiscal year.  

Select the sub-period from the list. 

Choose Continue. 

Note: Make sure you enter the posting 
periods for the earliest fiscal year required. 

Note: If you leave the Copy User-Defined Fields and Tables and Copy User-
Defined Objects checkboxes as selected, these objects will be copied from the 
current database. 

Choose Next. 
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The system will create the new company. This may take a few minutes. 

Enter a password for the manager account in the new company. 

Choose Update. 

Enter information for the EULA and select the checkbox to accept the EULA. 

Choose the I Accept button. 

Choose Next. 

Enter the company name, address and other details, as required. 

Choose Next. 

 

1.1.2. Accounting 

Review the accounting setup for the localization. 

Make the following changes: 

1. Add a new G/L account to the chart of accounts. The account is an active, 
cash account in the Assets drawer, called National Bank. 

2. Enable the Fixed Assets functionality. You will be prompted to set the 
initial settings, such as depreciation types and asset classes. 

3. Enable Intrastrat (if used in your localization). 

4. Enable segmentation accounts (if used in your localization). 

Note: Depending on the localization, other settings may appear in this window. 

Field Information 

Local Currency The local currency.  

System Currency Select a parallel currency, if desired, for 
financial reporting. 

Default Account 
Currency 

The default account currency for new G/L 
accounts. 

Currencies Define additional currencies, if needed. 

Exchange Rate Posting Select an option to display exchange rates. 

Display Credit Balance 
with Negative Sign 

Select to display credit balances with a 
negative sign. 

Allow Negative Amounts 
for Reversal Transaction 
Posting 

Select to have journal entries for reversals 
posted with negative amounts. 

Use Segmentation 
Accounts 

Account segmentation (localization 
specific). 

Enable Advanced G/L 
Account Determination 

Advanced G/L account determination 
rules. 

Chart of Accounts Add or remove accounts in the template 
chart of accounts.  

G/L Account 
Determination 

Change the default accounts, and define 
rules if advanced determination is enabled. 

Posting Periods Define posting periods for future fiscal 
years. 

Tax Define additional tax information, such as 
tax groups, withholding tax codes, sales 
tax codes, etc. 

Enable Fixed Assets Enable Fixed Assets functionality. 

Enable Intrastat Enable Intrastat functionality (localization 
specific). 
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Note: Settings marked with a red exclamation mark (!) can only be changed before 
the first transaction is posted. 

Choose Next. 

 

1.1.3. Banking 

Review the banking setup for the localization. 

Make the following changes: 

1. Add the National Bank to the Banks table. 

2. Define a House Bank for the National Bank. 

3. Set the National Bank as the default house bank. 

 

Field Information 

Banks Bank codes. 

House Bank Accounts House bank branch accounts. 

House Banks Default bank for the new company. 

 

Choose Next. 

 

1.1.4. Business Partners 

Review the business partner setup for the localization. 

Make the following changes: 

1. Define a new payment term for customers – Net 30 days. 

2. Define a new customer group – Hotels. 

 

Field Information 

Payment Terms Payment terms for customers and vendors. 

Note: The default payment terms for new 
business partner master data is set in the 
General Settings. 

Payment Methods Payment methods for the Payment Wizard.  

Dunning Terms Dunning terms for customers. 

Customer Groups Customer groups. 

Vendor Groups Vendor groups. 

 

Choose Next. 
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1.1.5. Inventory 

Review the inventory (stock) setup for the localization. 

Make the following changes: 

1. Define a new item group – Screens. 

Field Information 

Units of Measure Units of measure. 

Units of Measure 
Groups 

Unit of measure groups. 

Item Groups Item groups. 

Inventory Cycles Cycles for inventory counting. 

Price Lists Add new price lists, and enter item prices in 
a price list. 

Warehouses Warehouses and bin locations. 

Choose Next. 

1.1.6. Sales and Purchasing 

Review the sales and purchasing setup for the localization. 

Make the following changes: 

1. Set the default gross profit for service documents to 30%. 

Field Information 

Document Settings General document settings and settings per 
document type. 

Permit More than One 
Document Type per 
Series 

Certain country regulations permit 
document numbering series that contain 
more than one document type. Select this 
checkbox if these regulations are relevant 
for the company. 

Manage Freight Include a Freight field in sales and 
purchasing documents. 

Decimal Places The number of decimal places displayed for 
amounts, prices, exchange rates, quantities, 
percentages, units, and calculated values in 
queries. 

Document Numbering Document numbering and additonal 
numbering series. 

Calculate Gross Profit Activate gross profit calculation in sales 
documents. Select whether to calculate the 
gross profit percentage as the base price or 
the sales price. 

Landed Costs Landed costs for importing goods. 

Sales Stages Stages for sales opportunities. 

Reference Field Links Select which fields from documents will be 
used as reference fields in journal entries 
posted from the document (reference1, 
reference2, reference3). 

Choose Next. 
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1.1.7. Users 

Note: The setup screens in this step will be covered in a later execise, therefore 
you can skip this step.  

Choose Next. 

Choose Finish. 

 

1.1.8. Configuration Report 

Select the link to open the configuration report. 

A Crystal Report will open, showing the configuration settings. 

Close the Express Wizard. 

 

1.1.9. Compare Configuration Reports 

When you make a change to the configuration using the Express Wizard, a new 
configuration report is generated. 

Open the Express Configuration Wizard again by choosing Administration  
System Initialization  Implementation Center  Implementation Tasks  
Configure Company Settings. 

 Make a change to one of the fields on the Company Details screen. 

Choose Finish to close the wizard. 

Choose Administration  System Initialization  Implementation Center  
Configuration Management. 

 You should see an additional report. 

Choose Ctrl + Click to select both reports and choose Compare 
Configurations. 

A Crystal report will open showing the changes. 
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Customization Tools: Exercises 

 

 

Unit: Implementation Tools 

Topic: Quick Copy 

 

 

In this exercise, you will copy business partner and item master data 
records from one SAP Business One company to another company.  

Important: Before you start the exercise, you need to identify your 
source and target companies. The companies must have the same 
localization. If necessary, create a new company with the same 
localization as your source company. Note: If you are not able to create a 
new company, you can copy the Customization category to a company 
with a different localization. 

 

 

1-1  Copy Data to a File (Export) 

Log in to the source company. 

From the Main Menu, choose Administration  System Initialization  
Implementation Center  Implementation Tasks  Copy Data Between Companies. 

In the Quick Copy window, select Copy to File and choose Browse to enter a name for 
the qdf file. 

Select one of the error handling options. 

The OK button will now become active.  Choose OK. 

The Data Categories on the left-hand side are now selectable. 

Expand the Business Partners hierarchy. 

Select the checkbox for the Business Partner Master Data category. 

If you select the row, the business partner master records will display on the right. They 
will automatically be selected for copying. 

Expand the Inventory (Stock) hierarchy. 

Select the checkbox for the Item Master Data category and select the row to display the 
records selected for copying. 

Choose Export. 

A window will open showing any data dependencies. For example, there will be 
dependencies on BP Groups, Currencies, Item Groups and item warehouses. 

To view the actual dependent records, select the link arrow for one of the dependent 
rows.  

Note: The dependent records will be copied by default with the master data records. 

Choose Continue. 

The copy will start and the copy progress will show in the status bar at the bottom of the 
screen. 

The Quick Copy log will show the actual number of records exported to the qdf file. 

Close the Quick Copy windows. The system will prompt you to save a project file. This 
is optional. If you choose Yes, enter a name for an xml file that saves the settings and 
selected categories. Note that you can only reuse the xml file in the source company. 
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1-2   Copy Data from a File (Import) 

Log in to the target company. 

From the Main Menu, choose Administration  System Initialization  
Implementation Center  Implementation Tasks  Copy Data Between Companies. 

In the Quick Copy window, select Copy from File and choose Browse to select the qdf 
file you saved in step 1-1. Choose Open. 

Select one of the Copy Method options. 

Select one of the Error Handling options for responding to errors.  

Note: If the selected records contain user-defined fields, the category Customization > 
User-Defined Data > User-Defined Fields is automatically selected as a dependent 
category and the UDFs will be copied. If you do not want to copy the UDFs from the 
source company, you must select the option to ignore missing UDFs, otherwise the 
import will fail. 

Select one of the Copy Options:  

 The first option determines the response of the application when copying objects 
with assigned accounts: 

o Use Accounts in Source – If the source accounts also exist in the target, 
then the application copies the account assignments from the object in 
the source to the object in the target. However, if the source accounts do 
not exist in the target, then the application encounters an error during the 
copy process. 

o Use Default Accounts in Target – The application assigns the default 
accounts in the target to the object, and does not copy the source 
assignments. 

 The next option determines whether a blank field will overwrite a non-blank 
field when target records are being updated. 

 

Important! For this exercise, deselect the Force Backup checkbox. 

Choose OK. 

The selected data catgeories from the copy file are displayed on the left. You can select 
the Business Partners and Inventory categories to check the individual records to be 
copied. 

Choose Import. 

Check for any error messages in the system messages log. 

Note: To review the log later, open Quick Copy and choose Open Log File from the 
Quick Copy menu on the top menu bar. 

 

1-3    Validate the data 

Check the item and business partner master data records in the target company. 
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Customization Tools: Solutions 

 

 

Unit: Implementation Tools 

Topic: Quick Copy 

 

In this exercise, you will copy business partner and item master data records from one SAP 
Business One company to another company.  

Important: Before you start the exercise, you need to identify your source and target 
companies. The companies must have the same localization. If necessary, create a new 
company with the same localization as your source company. Note: If you are not able to 
create a new company, you can copy the Customization category to a company with a different 
localization.  

 

1-1   Copy Data to a File (Export) 

Log in to the source company. 

From the Main Menu, choose Administration  System Initialization  
Implementation Center  Implementation Tasks  Copy Data Between Companies. 

In the Quick Copy window, select Copy to File and choose Browse to enter a name for 
the qdf file. 

Select one of the error handling options. 

The OK button will now become active.  Choose OK. 

The Data Categories on the left-hand side are now selectable. 

Expand the Business Partners hierarchy. 

Select the checkbox for the Business Partner Master Data category. 

If you select the row, the business partner master records will display on the right. They 
will automatically be selected for copying. 

Expand the Inventory (Stock) hierarchy. 

Select the checkbox for the Item Master Data category and select the row to display the 
records selected for copying. 

Choose Export. 

A window will open showing any data dependencies. For example, there will be 
dependencies on BP Groups, Currencies, Item Groups and item warehouses. 

To view the actual dependent records, select the link arrow for one of the dependent 
rows.  

Note: The dependent records will be copied by default with the master data records. 

Choose Continue. 

The copy will start and the copy progress will show in the status bar at the bottom of the 
screen. 

The Quick Copy log will show the actual number of records exported to the qdf file. 

Close the Quick Copy windows. The system will prompt you to save a project file. This 
is optional. If you choose Yes, enter a name for an xml file that saves the settings and 
selected categories. Note that you can only reuse the xml file in the source company. 
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1-2   Copy Data from a File (Import) 

Log in to the target company. 

From the Main Menu, choose Administration  System Initialization  
Implementation Center  Implementation Tasks  Copy Data Between Companies. 

In the Quick Copy window, select Copy from File and choose Browse to select the qdf 
file you saved in step 1-1. Choose Open. 

Select one of the Copy Method options. 

Select one of the Error Handling options for responding to errors.  

Note: If the selected records contain user-defined fields, the category Customization > 
User-Defined Data > User-Defined Fields is automatically selected as a dependent 
category and the UDFs will be copied. If you do not want to copy the UDFs from the 
source company, you must select the option to ignore missing UDFs, otherwise the 
import will fail. 

Select one of the Copy Options:  

 The first option determines the response of the application when copying objects 
with assigned accounts: 

o Use Accounts in Source – If the source accounts also exist in the target, 
then the application copies the account assignments from the object in 
the source to the object in the target. However, if the source accounts do 
not exist in the target, then the application encounters an error during the 
copy process. 

o Use Default Accounts in Target – The application assigns the default 
accounts in the target to the object, and does not copy the source 
assignments. 

 The next option determines whether a blank field will overwrite a non-blank 
field when target records are being updated. 

 

Important! For this exercise, deselect the Force Backup checkbox. 

Choose OK. 

The selected data catgeories from the copy file are displayed on the left. You can select 
the Business Partners and Inventory categories to check the individual records to be 
copied. 

Choose Import. 

Check for any error messages in the system messages log. 

Note: To review the log later, open Quick Copy and choose Open Log File from the 
Quick Copy menu on the top menu bar. 

 

1-3    Validate the data 

Check the item and business partner master data records in the target company. 
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Customization Tools: Exercises 

 

 

 

 

Unit: Implementation Tools 

Topic: Solution Packager 

 
In this exercise, you will use the Solution Packager to package a 
company database and optional add-on into a file, then create a 
new company from the package file. 

Important! You need to know the database user and password 
for the server. 

 

1-1 Check for installed add-ons (optional) 

This step is optional, but if you have an add-on installed on your system, you will see 
how Solution Packager can package the add-on for distribution. 

If you do not have an add-on installed on your system, you can install one of the SAP 
add-ons as follows: 

Note: You must have access to the SAP Business One installation files. 

Choose Administration  Add-Ons Add-On Administration. 

Select a SAP add-on from the list of available add-ons and choose the Register 
Add-On button. 

In the Add-On Registration window, choose Browse to locate the AddOn 
Registration Data file (*.ard). 

Choose Open. 

Select Install as Part of Registration. 

 

1-2 Create a package file 

You can launch Solution Packager from the SAP Business One client or as a standalone 
application:  

Launch Path 

From the SAP Business 
One client 

From the Main Menu, choose Administration  
System Initialization  Implementation Center 
 Implementation Tasks  Package a 
Preconfigured Solution Using Solution 
Packager. 

Note: If Solution Packager does not open, check 
the path settings. Choose Administration  
System Initialization  Implementation Center 
 Path Settings. 

As a standalone 
application 

 

Choose Start  All Programs  SAP  SAP 
Business One  Solution Packager. 

Note: The path may be different in your system. 
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Enter information for the package. The first three fields are mandatory: 
 

Field Information 

Solution Name A short description of the package 

Industry Select an industry from the dropdown list, or 
choose Other. 

Industry-Specific De-select the checkbox for the purposes of this 
exercise 

Solution Version Enter the version 

 

Enter the name and contact information for the vendor of the solution. 

Enter the database login credentials.  

Select an SAP Business One company to package. 

Note: Make sure no one is logged into the chosen company. 

In the next steps the wizard displays the following objects from the source company. 
You can select these objects to go into the package: 

 External objects added by a Software Solution Provider, such as stored 
procedures, functions and custom SQL scripts.   

 User-Defined Objects 

 User-Defined Tables 

 User-Defined Fields 

 Alerts 

 UDV 

 Queries 

 Item data for selected item group 

 Users 

 Cockpits and dashboards 

 Reports and print layouts 

 Project templates 

 Add-ons 

 External databases added by a Software Solution Provider. 

If the system does not find any objects, the selections are grayed out. 

Select a folder to store the .pak file, then choose Package. 

Choose Finish. 
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1-3 Create a new company from the package file 

From the Main Menu, choose Administration  Choose Company.  

Select the New button and choose New from Package from the dropdown list. 

Enter the site user password. 

Select the package file. 

Verify the solution information. 

Enter a name for the new company. 

You have the option to select a chart of accounts template, or you can use Predefined 
from the package. 

Verify the posting periods and sub periods. 

The tables for the new company are created. This step may take several minutes.  

Note: If the system is unable to create a table, a message will be logged in the System 
Messages area of the new company. 

Choose Finish to exit the wizard. 

Enter a new password for the manager user. 

Sign and accept the EULA. 

You can now fine tune the configuration of the new company. 

 

 

 

 

  

 

 

 

© SAP AG 127 TB1200



 

© SAP AG 128 TB1200



Customization Tools: Solutions 

 

 

Unit: Implementation Tools 

Topic: Solution Packager 

 

In this exercise, you will use the Solution Packager to package a company database and 
optional add-on into a file, then create a new company from the package file. 

Important! You need to know the database user and password for the server. 

 

1-1 Check for installed add-ons (optional) 

This step is optional, but if you have an add-on installed on your system, you will see 
how Solution Packager can package the add-on for distribution. 

If you do not have an add-on installed on your system, you can install one of the SAP 
add-ons as follows: 

Note: You must have access to the SAP Business One installation files. 

Choose Administration  Add-Ons Add-On Administration. 

Select a SAP add-on from the list of available add-ons and choose the Register 
Add-On button. 

In the Add-On Registration window, choose Browse to locate the AddOn 
Registration Data file (*.ard). 

Choose Open. 

Select Install as Part of Registration. 

 

1-2 Create a package file 

You can launch Solution Packager from the SAP Business One client or as a standalone 
application:  

Launch Path 

From the SAP Business 
One client 

From the Main Menu, choose Administration  
System Initialization  Implementation Center 
 Implementation Tasks  Package a 
Preconfigured Solution Using Solution 
Packager. 

Note: If Solution Packager does not open, check 
the path settings. Choose Administration  
System Initialization  Implementation Center 
 Path Settings. 

As a standalone 
application 

 

Choose Start  All Programs  SAP  SAP 
Business One  Solution Packager. 

Note: The path may be different in your system. 

 

 

 
© SAP AG 129 TB1200



In the Solution Packager wizard, choose Next to start the packaging. 

Enter information for the package. The first three fields are mandatory: 
 

Field Information 

Solution Name A short description of the package 

Industry Select an industry from the dropdown list, or 
choose Other. 

Industry-Specific De-select the checkbox for the purposes of this 
exercise 

Solution Version Enter the version 

Choose Next. 

Enter the name and contact information for the vendor of the solution. 

Choose Next. 

You will be prompted to login to the database server. Enter the database login 
credentials.  

Choose OK. 

The system displays all the available databases on the server. Select an SAP Business 
One company to go into the package. 

Note: Make sure no one is logged into the chosen company. 

In the next steps the wizard displays the following objects from the source company. 
You can optionally make selections to go into the package: 

 External objects added by a Software Solution Provider, such as stored 
procedures, functions and custom SQL scripts.  Select the checkbox and select 
the objects to go into the package. 

 User-Defined Objects 

 User-Defined Tables 

 User-Defined Fields 

 Alerts 

 UDV 

 Queries 

 Item data for selected item groups 

 Users 

 Cockpits and dashboards 

 Reports and print layouts 

 Project templates 

 Add-ons 

 External databases added by a Software Solution Provider 

If the system does not find any objects, the selections are grayed out. 

Select a folder to store the .pak file, then choose Package. 

Choose Finish. 
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1-3 Create a new company from the package file 

From the Main Menu, choose Administration  Choose Company.  

Select the New button and choose New from Package from the dropdown list. 

Enter the site user password. 

Select the package file. 

Choose Next. 

Verify the solution information, then choose Next. 

Enter a name for the new company. 

Choose Next. 

You have the option to select a chart of accounts template, or you can use Predefined 
from the package. 

Verify the posting periods and sub periods, then choose Next. 

Verify the summary, then choose Next. 

The tables for the new company are created. This step may take several minutes. 

Note: If the system is unable to create a table, a message will be logged in the System 
Messages area of the new company. 

Choose Finish to exit the wizard. 

Enter a new password for the manager user. 

Sign and accept the EULA. 

You can now fine tune the configuration of the new company. 
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In this topic we will cover the software components and licensing for SAP 
Business One.

© SAP AG 135 TB1200



In this topic, you will learn about the architecture and components of SAP 
Business One and the process for installation. 

You will be able to explain when the site user password is required, and the 
purpose and functions provided by the Service Manager.

Lastly, you will be able to follow the SAP processes to request a license key and 
i t ll it i SAP B i Oinstall it in SAP Business One.
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Before you download and install the SAP Business One software for the first time, 
you need to verify the following for release 9.0:

• The system and hardware requirements

• The installation process and sequence for installing components

• The various landscape options for deploying SAP Business One

• SAP’s licensing model. 
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The first part of this topic examines the architecture and components of SAP 
Business One.
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SAP Business One uses a client-server architecture. 

The client executable is installed on each user’s workstation (also on the server 
for local administration purposes). The client is available in 32 bit and 64 bit 
versions. You can run both versions on the same machine.

The client executable consists of a graphical user interface and the business 
object classes connecting to the database The SAP Business One server storesobject classes connecting to the database. The SAP Business One server stores 
only data and does not use triggers.

The client agent is installed automatically with the client install. This is a Microsoft 
Windows service that runs in the background. It saves any parameters that you 
provide during the client installation, for possible future use. It also facilitates 
“silent” updates to the client and any installed add-ons on the client workstation.

SAP Business One also supports mobile clients using the Mobile App for iPhone pp g pp
and iPad. 

If the Microsoft Outlook Integration add-on is installed, there a server component 
and the add-on must be installed on the client as well. 
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Server components include the server tools.

The server tools run as services. The Service Manager is installed with the server 
tools and provides an interface for configuring, starting and stopping these 
services:
 The DI Server enables partners to use SAP Business One data in a browser 

without the need to install any SAP Business One component on the client or 
th li ti f th b b d li ti A t li ithe application server of the web-based application. A separate license is 
required for the DI-Server. One license is needed per machine.

 The License Manager tracks user sessions and purchased licenses, and is 
automatically installed during the SAP Business One installation. You have the 
option to install it on a different machine from the main server, in which case the 
license server is accessed using an IP address and port number.

 The System Landscape Directory database is also installed, and is used for 
managing the landscape and authenticating usersmanaging the landscape and authenticating users.

 The optional Workflow service allows users to visually design the flow of tasks 
for a work process and assign tasks to different users to complete the process.

 The optional Mailer service allows for the sending of emails and faxes from the 
SAP Business One client to external users.

The SLD database is installed with the Server Tools and is used for authentication 
of users.
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The SAP Business One server components include the database server, the 
common database (SBO-Common) and the individual company databases. Each 
SAP Business One company uses a separate database on the server. The 
common database holds system, version and upgrade information and does not 
hold any company data. The common database does not appear in the list of 
company databases. 

The Remote Support Platform (RSP) service is installed with the server 
installation, and has its own database on the server. RSP proactively manages the 
maintenance and support of the server, and is used for distribution of software 
patches. 
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Optional client side components that can be installed include the Software 
Development Kit, the Data Transfer Workbench, and the Solution Packager tools. 

The Software Development Kit (SDK) allows partners to extend SAP Business 
One using APIs and other features. The SDK consists of:

• The User Interface API. This SDK component is used by add-ons and allows 
the add on to access and edit GUI forms and menusthe add-on to access and edit GUI forms and menus.

• The Data Interface API. This SDK component is used by add-ons to access 
SAP Business One objects. Most SAP Business One objects are exposed in 
this API. 

• The SAP Business One Studio. SDK developers can use the Studio to create 
add-ons, and partners can use the Studio to design and implement workflows 
in SAP Business One.

A development environment, for example, Microsoft Visual Basic .NET, or 
Microsoft Visual Studio 6.0, is required to use the APIs and the SAP Business One 
Studio. 

The Data Transfer Workbench and Solution Packager tools can be installed on the 
desktop with or without the client. They use the DI API to communicate to the SAP 
Business One server, and this is installed automatically with these tools. If these 
t l i t ll d d i th i t ll ti th l ibl ftools are installed during the server installation, they are also accessible from 
within the Implementation Center in the SAP Business One client.

Note that the SDK includes documentation for SAP Business One objects and 
tables. This is a useful resource for partners who migrate data using the Data 
Transfer Workbench.
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The client is normally installed on each user’s workstation; however, it only needs 
to be installed once if using client presentation software such as Windows 
Terminal Services or Citrix Server.
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The next part of this topic covers the installation process for SAP Business One.
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You can download the installation files from the PartnerEdge portal, or purchase an installation 
DVD. The installation process is easy to follow, since it is driven by a wizard. The process is 
described step-by-step in the Administrator’s Guide distributed with the product.

The prerequisites before installation are:

• SAP Crystal Reports, version for SAP Business One. You can download this software from the 
PartnerEdge portal.

Mi ft SQL S i t ll d d l i d ti l il bl N t th t Mi ft SQL S• Microsoft SQL Server installed and login credentials available. Note that Microsoft SQL Server 
licenses can be optionally purchased from SAP.

• Web browser on the server machine, for access to the System Landscape Directory.

The installation order for the components is:

1. The SAP Business One Server Tools. The license server is installed in this step.

2. The SAP Business One Server. This step creates the SBO-Common database and registers the 
SAP add-ons.

3. The Remote Support Platform for SAP Business One.

4. The SAP Business One Client. Always run the client setup executable with Administrator 
privileges. When installing multiple clients, run the installation from the shared folder created on 
the SAP Business One Server.

5. Optional client components, such as add-ons, the SDK, Solution Packager and DTW.

6. Integration components for the SAP Business One Server, if required.

For information on supported hardware and software platforms, refer to 
htt // h l / b / l tfhttp://channel.sap.com/sbo/platforms.
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The site user is created during the installation of the server tools, and you will be 
prompted to create a password. The site user (b1siteuser) provides an additional 
layer of security in SAP Business One, that is higher than the super user. The site 
user is not associated with a user account.

The site user password should be carefully controlled in the client company, since 
it is required to: q

 Configure the Service Manager settings, the first time after a new installation 
(one time)

 Create new companies

 Run the upgrade wizard to upgrade to a new release or patch level

 Assign the credentials for a read-only database user within SAP Business 
OneOne

 Access the System Landscape Directory (SLD)
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After installing SAP Business One, you need to configure and start the services in 

the Service Manager:

• License Manager

• DI Server

W kfl• Workflow

• Mailer (optional)

The License Manager service must run continuously, to allow users to login. 

Therefore you should select the Start when operating system starts checkbox.

The other services can be started when required.

Once the system is up and running, you can use the Service Manager to start and 

stop the these services. Alternately, you can start and stop these services from 

Microsoft Windows.
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During the installation, the SAP provided add-ons are registered and you can now 
install them. To install an add-on, choose Administration > Add-Ons > Add-On 
Administration.

Note that some add-ons are available in 64 bit version; however, if the SAP 
Business One client is 32 bit, you can only run 32-bit add-ons.

Note that the Fixed Assets, Intrastat, and Copy Express add-ons from previous 
releases have been integrated into the core in release 9.0.
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During installation, the B1_SHR folder is created on the SAP Business One 
server, in the path specified during the server installation.

The B1_SHR directory should be accessible from all client workstations. This 
folder contains the installation files for the client software. You should install the 
client software on the client workstations from this path. 

Make sure that the client workstations have permissions to access the sharedMake sure that the client workstations have permissions to access the shared 
folders on the server.
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You can also store common files and templates in the SAP Business One server 
folders. These folders are used by the system when users perform functions such 
as exporting a document as a PDF file.

You must first define the paths for the common folders. Choose Administration 
System Initialization  General Settings and then select the Path tab. After the 

h h l ll SAP B i Opaths are set, they apply to all SAP Business One users. 

Note that you do not have to use the B1_SHR directory for these paths; you can 
use any shared folder on the server that is accessible by all users.
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The shared folders are used as follows:

• The WordDocs folder contains templates for exporting data to Microsoft Word. 
There are templates provided for each localization.

• The ExcelDocs folder is used for exporting data to Microsoft Excel. 

• In the Pictures folder you can store images for use in master data and print 
l t If d t if th f th Pi t f ld t flayouts. If you do not specify a path for the Pictures folder, you cannot perform 
certain actions, such as adding images to master data records, printing 
documents with company logos, and so on.

• The Attachments folder is used to export data to a PDF, and also for 
attachments used in internal e-mails, contacts, and so on. The attachments 
folder is also required when adding a user-defined field that will hold a Web 
address. 

• In the Extensions folder you can store secured images, include official stamps, 
which, due to legal requirements, can be saved on your computer as *.dll files 
only, and not as picture formats. 

• If a document scanner is connected to the system, it is automatically detected 
when you choose the Browse button for the Current Scanner path. The scanner 
location is then stored in this path, allowing scanned documents to be 
i t t d ith l t F l h t itintegrated with relevant screens. For example, when you enter an item, you can 
scan an image directly from the images tab for a master record. 

• The XML Files folder is used by the system when you export to XML. 
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The final part of this topic covers the licensing aspects of SAP Business One.
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A license must be assigned to a specific user in SAP Business One, in 
accordance with the contract. 

• Whenever a logged-in user accesses a form in SAP Business One, the license 
server checks if the user has the required license for that form. This check 
takes place before the general authorization validation. If a user is not 
authorized to a function provided by the license type, the user will receive an p y yp ,
error from the license server if they try to access these functions.

• The contract specifies the user license types and the localizations. When the 
partner enters the order in the SAP channel partner portal, the number and type 
of the licenses is recorded. When a user first logs on to SAP Business One, 
they are prompted to sign the End User License Agreement (EULA). To see a 
record of EULAs, choose Administration  License  End User License 
AgreementAgreement.
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There are several types of licenses for SAP Business One, at different prices for access 
to different functionality:
•The Professional license type provides unrestricted access to all SAP Business One 
functionality, and the SDK tools. If the user is a super user (checkbox in user account), 
you should assign a Professional license type.
•The Limited CRM Limited Logistics and Limited Financials license types are aimed forThe Limited CRM, Limited Logistics, and Limited Financials license types are aimed for 
employees that perform daily operational tasks. Limited licenses do not provide access 
to all functionality in SAP Business One. However, you can assign multiple limited 
license types to a user, if needed. In this case the highest authorization will apply. 
•The Starter Package license type provides access to all functionality available with the 
Starter Package. A maximum of 5 users is allowed for this license type. 
This slide shows a partial list of the functions for each license type. For a full list, see 
the license comparison chart on the PartnerEdge portal atthe license comparison chart on the PartnerEdge portal at 
http://sappartneredge.com/B1/license. 
The above license types cover the SAP Business One mobile application for the iPhone 
and iPad. 
There is another license type, the Indirect Access type, which provides access to 
licensed third party add-ons developed with the SAP Business One DI-API.  The user is 
not authorized to any of the standard SAP Business One screens, and will require a 
limited or professional license to access SAP Business One functionality The Indirectlimited or professional license to access SAP Business One functionality. The Indirect 
Access license type is included by default in all the other license types.
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The license key is country specific, meaning that users are only permitted to 
access companies of the licensed localization. Customers who will be operating 
across multiple localizations need multiple license keys – one for each 
localization. 

Multiple license keys can be loaded in the license server, and you can select the 
localization license when you assign a license to a user.y g

Note that a single, global license to cover multiple localizations is only available by 
special request. 

The license server can be installed on a separate server within the network, and 
user workstations can access the license server using the IP address and portuser workstations can access the license server using the IP address and port 
number.

For more information on the licensing architecture, reference the License Guide 
supplied with the installation software.
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You can run the newly-installed SAP Business One product version for 31 days 
without a license. To continue working with the application after 31 days, you must 
request and install a valid license key assigned by SAP. 

In addition, you must request a new license key when:

• The hardware key has changed

Th b f h h d• The number of users has changed

• Additional SAP components are added to the contract

To install a valid license key, you first obtain the Hardware Key from the server. 
The hardware key is generated from the hardware data (motherboard) of the 
server on which the license manager is installed. To obtain the hardware key for 
th th S i M d l t th Li M ithe server, open the Service Manager and select the License Manager service. 
Choose Settings to open the General Settings screen, and copy the string for the 
Hardware Key field. The Hardware Key is also available from the Help > About 
SAP Business One menu in the application.
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To request the license key, navigate to the license key request page on the 
PartnerEdge portal at http://service.sap.com/smb/sbo/licensekeys.

You need an S-user with the authorization "License key request for partner" for the 
corresponding installation number. 

The super-admin within your organization can provide you with this authorization.

To see the contracted license types, select the customer installation and system. If 
this is a new system, you can add it. 

Enter the required fields and paste the string for the hardware key. 

Select the component license types and enter the number of users for each 
license type.

Submit the license request. 

Note that, you need to request a license for every localization that the client will 
run, and if you select any third-party add-ons, the third-party partner will receive a 
list of licenses that have been given out to customers. 
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Shortly after you submit the request, your license key will be available for 
download on the SAP Channel Partner Portal, and you will also receive the 
license key text file by e-mail.

You need to import the text file into SAP Business One.

To do this, open the Service Manager and select the License Manager service.

Ch S tti i th Li MChoose Settings in the License Manager. 

Next, browse for the saved text file and select Import License File.

Alternately, you can import the license text file from the License Administration 
screen in SAP Business One. To access this screen, choose the menu 
Administration  License  License Administration.

© SAP AG 158 TB1200



After you install the license key you can view and assign licenses. Choose 
Administration  License  License Administration .

Select a user name and select the appropriate license type from the available 
licenses. 

Once assigned, the license is not specific to a company database and the same 
user can access up to two databases at the same time License localizationuser can access up to two databases at the same time. License localization 
checks apply. This is designed primarily for access to a test and a production 
server, and is not designed to circumvent licenses.

If you want to change the license assignment for a user, the user must be logged 
off from the system. Only super users can change the license assignment.

If you want to remove a user account from the system, you need to first remove 
the license assigned to the user. The license goes back into the pool of available g g p
licenses.
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The license validation service is a free tool that reports the real-life view of SAP 
Business One license usage.

You can download this tool from the SAP Community Network. There is a server 
and client components. The server component is installed on the database server 
and the client component must be installed on each client machine, as an add-on).

The LVS tool captures the accesses by the users.

An ideal time to run this tool is after the customer has been using the new system 
for several weeks. 

The report compares actual use versus users licensed by the contract. This allows 
you to fine tune the licenses.
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Here are some key points to take away from this session.

SAP Business One uses a client-server architecture. The client can be installed on 
each user’s workstation,  or accessed through Windows Terminal Server or Citrix. 
Mobile clients are also supported.

In the installation process, Crystal Reports version for SAP Business One and the 
SAP Business One Server Tools must be installed before the SAP Business One 
SServer.

The site user password is created during the software installation and is required 
to: 

 Configure the Service Manager settings for a new installation (one time)

 Create new companies

 Run the upgrade wizard

A i d ti l t th d l d t b Assign credentials to the read-only database user

 Access the System Landscape Manager 

You can run the newly-installed SAP Business One product version for 31 days 
without a license. To continue working with the application after 31 days, you must 
request and install a valid license key assigned by SAP. 

SAP uses a named user licensing model. A license must be assigned to a specific 
user name. The license key is localization specific.

After you install the license key, you assign the individual licenses installed by the 
license file to your named users.

© SAP AG 161 TB1200



© SAP AG 162 TB1200



In this topic we will cover the security functionality provided with SAP Business 
One.
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After completing this topic, you will be able to:

• Describe the security functions provided by the System Landscape Directory
• Set up single sign-on for access to SAP Business One using Windows domain 

credentials
• Change the site user password
• Change the database admin user for a company databaseChange the database admin user for a company database
• Manage and change user passwords
• Create a read-only database user
• Describe the information logged in the Access and Change logs
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When you implement SAP Business One, you should ensure that you take all 
steps to safeguard the customer’s information.

SAP Business One provides multiple features for implementing security 
measures, and you should work together with the customer to determine which 
options will best meet the customer’s security requirements.
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The first part of this topic covers the security features provided in the System 
Landscape Directory.
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When a user logs on to an SAP Business One company, the user’s credentials are 
validated by the System Landscape Directory service, and after they have been 
validated the client then connects to the company database using the database 
credentials. Therefore security is maintained since database credentials are 
hidden from the end user. 

The security landscape directory service (SLD) is responsible for authenticating y p y ( ) p g
the users’ logon credentials. Therefore SAP Business One users do not connect 
directly to the database, but receive access credentials from the SLD.
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The System Landscape Directory (SLD) provides a secure web interface for an 
administrator to manage the overall landscape of a system, including servers and 
company databases. 

We will examine some of the functions provided in the SLD.
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The SLD server is installed as part of the SAP Business One server tools. 

To access the SLD, open the License Manager service in the Service Manager. 
Open the General Settings screen then select Configure Security. The System 
Landscape Directory will open up in a Web browser. 

You can also enter the url https://localhost:30010/ControlCenter in a Web browser 
on the SAP Business One serveron the SAP Business One server.

The SLD enforces a secure connection using HTTPS protocol. During the 
installation you are given the choice of installing a purchased third-party security 
certificate (PKCS12) or self-certifying that the connection is secure. If you choose 
to self-certify, you will get a warning from the Web server, and you can ignore the 
warning to continue to the site.

© SAP AG 169 TB1200



You need to enter the site user password to proceed to access the SLD.

On the Security Settings tab of the SLD, you can change the site user password.

The site user password is required to create new companies and to upgrade 
companies. To maintain security for the landscape, the customer should change 
the site user password regularly.
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If the site user password is forgotten, you can reset it from the SLD.

You need to provide the database admin name and password, and then supply a 
new password for the site user.
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The SLD also allows the administrator to manage the authentication mode. There 
are two types of logon authentication:

• SAP Business One Managed Authentication – Each SAP Business One user 
can access a company database using their user account code and password 
that is managed from within SAP Business One.

• Windows Authentication Each SAP Business One user can access a• Windows Authentication – Each SAP Business One user can access a 
company database using their windows domain account (single sign on).  

Whichever logon method is used, internally the user identity is the same.

Single sign on allows users to bypass the standard SAP Business One login 
screen. If the user has already logged into the windows domain, they do not need 
to login again to SAP Business One.

To use single sign on, you must first enable it in the System Landscape Directory. 
Once set, this applies to all companies on all servers in the landscape.
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To enable single-sign on for a user, you must bind the user’s SAP Business One 
user account with the user’s Windows domain account. This is a one-to-one 
mapping between the user account and the Windows account. The domain user 
name (without domain) will be used as the user code. The user’s client machine 
must be in the same domain as the server.

For security reasons, the bind between the SAP Business One user account and 
the domain user cannot be changed once established.
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After the user account is bound, the user can then select a checkbox on the SAP 
Business One login window and start using the application without being prompted 
to enter their SAP Business One logon credentials.

If the user’s machine is not in the same domain, the checkbox is not selectable. 
The user can still login using their SAP Business One account by unchecking the 
checkbox in the Choose Company screen.p y

The first time a user selects the checkbox on the Choose Company screen, the 
user is prompted to provide their SAP Business One account code and password. 
Once this is provided, no further prompting occurs and subsequently the user 
does not have to login to SAP Business One. The logon screen will not appear for 
the next login, instead SAP Business One will be launched directly with the last 

d t d icompany and current domain user.

If there are multiple company databases on the server, the Choose Company 
window will only display companies in which the user account is bound with the 
domain. Therefore if a user needs to access two companies, you need to bind the 
user account in each company.

© SAP AG 174 TB1200



On the Servers and Companies tab, the SLD displays the server specified in the 
installation, and the company databases on the server. You can add new servers 
to the landscape (post installation), and remove servers from the landscape.

You can edit the server to set the type of authentication as either SQL Server 
authentication or Windows authentication Note that SAP recommends using SQLauthentication or Windows authentication. Note that SAP recommends using SQL 
Server authentication. For more information, consult the SAP Business One 
Administrator’s Guide.
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Also on the Servers and Companies tab, you can change the default database 
account (typically “sa”) that is used by the client for access to all company 
databases. This user account has system admin privileges which are not needed 
for SAP Business One access.

So for enhanced security, you can change to a database user with fewer admin 
privileges. Select and edit a company database, and, in the pop-up window, select p g p y , , p p p ,
the option Use Specified Database User instead of the default Use Database 
Admin User. A new user account is automatically generated on Microsoft SQL 
Server and the company database is mapped to this new account. The database 
user account is now displayed in the row in the SLD. You can maintain the 
password for this account using SQL Server Management Studio. 
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The next part of this topic focuses on the administration of user passwords.
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You can configure a global password policy for all users, which will dictate the 
strength of the user password and how often it needs to be changed. To change 
the password policy from the default, choose Administration  Setup General 
 Users   Security  Password Administration. Here you can set the password 
strength (low, medium, high, or custom) and any special requirements for 
characters that need to be part of the password.

When a new user is created, an initial password is set by the administrator. The 
new password  must adhere to the password strength defined in the Password 
Administration screen.

If single-sign on is in use throughout the company, the user still has the option to 
login using their SAP Business One credentials, so the password policy should be 

i t i dmaintained.
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Users can change their password at any time by choosing the menu 
Administration Setup  General Security  Change Password. 

The super user change the password  for another user by selecting the browse 
button in the user account. The super user should inform the user so they can 
login successfully using the new password. 

The super user also has the option to force a user to change their password whenThe super user also has the option to force a user to change their password when 
they next login, by selecting the Change Password at Next Logon checkbox in the 
user account.

© SAP AG 179 TB1200



A user account can be locked to prevents the user from logging on to SAP 
Business One. The super user can lock an account manually, and the account will 
be automatically locked after a specified number of unsuccessful login attempts by 
the user, if this is defined in the password policy. The default password policy does 
not lock a user account.

Only a superuser can unlock a user account. y p
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In order to prevent illegal updates to the database, you can restrict users to read-
only operations on the database. 

First you need to set up a read-only user account in the Microsoft SQL Server 
database. Map the user account to the SBO-Common and company database. 
Select the role memberships as db_datareader and db_denydatawriter.

Next in SAP Business One choose Administration > Setup > General > Read-Next, in SAP Business One, choose Administration > Setup > General > Read-
Only DB User. Enter the read-only user name and password.

Users are now restricted and will not be able to run  SQL update or delete queries 
unless they are assigned the general authorization Reports > Query Generator > 
Execute Non-select SQL Statement.

For more information, see the Administrator's Guide.

Only SAP Business One super users are able to specify read-only usersOnly SAP Business One super users are able to specify read only users.
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The final part of this topic covers the access and change logs provided in SAP 
Business One.
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An audit log is maintained that records each user logon, logoff, and password 
change.

This is especially useful for monitoring password changes and failed login 
attempts.

To view the log, choose the Tools menu then choose Access Log.

Y d bl li k t d t il f Th IP dd i i l d d iYou can double-click a row to see details for a user. The IP address is included in 
the details, allowing the administrator to track the source of an attempted login.
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The change log records changes in many objects, including sales and purchasing 
documents, and setup windows such as tax groups, withholding tax, house banks, 
freight, credit cards, general authorizations, general settings, document settings, 
employee master data, production orders, and the charts of accounts.

To determine if a window has a change log, open the document or form and 
choose Tools > Show History. This menu option will only be active if the document y p y
or form in the active window has a change log.

The change log shows a row for each change made to the document or window. 
When a document is first added, the change log shows one row. If the document 
is subsequently changed, the change log will show an additional row for each 
change.
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If you choose Show Differences, you will see a detailed comparison of each field 
with the field differences highlighted.

If you double-click the first row you will see a saved image of the document before 
the change was made. If you double-click the second row you will see a saved 
image of the document with the change, and so on.

Note that the maximum number of rows that can be recorded for a document or 
window is set in the General Settings > Services tab, in the History field. The 
default is 99 rows.
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Here are some key points to take away from this session:

•When a user logs on, user credentials are validated by the System Landscape 
Directory (SLD). After they have been validated, SAP Business One users do not 
connect directly to the database, but receive access credentials from the SLD.

• The System Landscape Directory provides a web interface for managing 
the overall landscape as well as securitythe overall landscape as well as security.

• The SLD can be accessed from the License Manager settings or from a 
Web browser using the url https://localhost:30010/ControlCenter.  You 
need to enter the site user password to login to the SLD. 

• From the SLD, you can change the site user password, enable 
single-sign on, add servers to the overall landscape, and change 
access credentials to the database.

• Access and change logs provide useful information for managing 
security.
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This topic covers user accounts and user authorizations.
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On completion of this topic, you will be able to define user accounts, and grant 
general authorizations to a user account so they can access functions and menus 
in SAP Business One.
You will also learn how to copy a set of general authorizations to multiple users, 
and how to limit access to documents using data ownership authorizations.
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DG Industries has 15 users in the sales department. These users will access the 
same functions and reports in SAP Business One.

When processing sales documents, the users need to have the same form 
settings for documents.

The sales manager also needs to access the same functions and reports but alsoThe sales manager also needs to access the same functions and reports, but also 
needs to access additional sales reports and sales analysis dashboards.

Solution: Set up one user with the basic profile for form settings, then copy the 
form settings to the other users. Set up general authorizations for one sales user, 
then copy these authorizations to the other sales users. Fine tune the general 
authorizations for the sales manager.
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The first part of this topic covers user accounts.
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To login to SAP Business One, users need an account. To create user accounts, 
choose Administration  Setup General  Users. You can also create user 
accounts from the Express Configuration Wizard. The User Code must be unique 
and can have up to 8 characters.

There are two types of user:There are two types of user:

• If you check the Superuser checkbox when you create a user account, the user 
will have full authorization to every function in SAP Business One. A super user 
can reset the passwords of other users and can set authorizations for other 
users. Obviously you should limit the number of superuser accounts. 

• If you do not check the Superuser checkbox, the user by default has no 
authorizations to any system functionality. General and Data Ownership y y y p
Authorizations must be set for each user.

Select the Mobile User checkbox to enable any user to work with a mobile device 
to access their company data. You should also enter the ID of the user's mobile 
device, which they can use to access their company information.

If a user fails to login successfully for the number of times specified in the 
Password Administration screen, their account will be locked (Locked checkbox). 
Thi i i di t d i h kb i th t O l l kThis is indicated in a checkbox in the user account. Only a superuser can unlock 
the locked user account.
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In the User Defaults screen, you can pre-define a set of default values that are 
common to a group or department, such as print preferences for documents, 
warehouses, and certain G/L accounts used in sales. You can then assign these 
defaults to one or more user accounts by selecting the code for the user defaults 
in the user account. To set up user defaults, choose Administration Setup 
General  User Defaults. 
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Often groups of users who work in the same department have similar 
requirements for Form Settings in the documents they use.

You can set the required Form Settings for one user, then copy the Form Settings 
to other users.

This can save time during the implementation.
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The next part of this topic looks at the general authorizations needed to access 
functions in the system.
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Access to the various functions in SAP Business One is controlled through a 
combination of license and general authorizations. These are set by user account.

 The license type assigned to a user determines which functions the user is 
legally contracted to use. If the user tries to access a function that is outside 
the scope of the license, the user will get an error generated from the license 
server. 

 The General Authorizations granted to a user permit the user to access to the 
SAP Business One functions required for their job. This has nothing to do with 
the license but is set based on client requirements for a user’s job role. If the 
user has access to a function through the license, and the general 
authorization to the function is not set, the user will receive an authorization 
error when they access the function.

B d f lt ll l t d ( t f ) hBy default, all newly created users (except for super users) have no 
authorizations to any SAP Business One function. General Authorizations must 
be set for each user.

A user defined as superuser has full authorization to all SAP Business One 
modules and functions and it is not possible to modify the authorizations for this 
user.
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General authorizations can restrict if a user is allowed full access, read-only 
access, or no access to a function or menu.

A user designated as a superuser automatically has Full Authorization to all 
functions, but you can limit this functionality using general authorizations.

You must assign a Professional License to each superuser.

F ll th t i th i ti f h f ti lFor all other users you must assign an authorization for each functional area:

 Full Authorization - The user can display and change data of this authorization 
object.

 Read Only - The user can only display data of this authorization object.

 No Authorization - The user has no access to this authorization object.

General authorizations basically follow the SAP Business One module and menu 
order. You can assign the same authorization to each object, or, if you expand the 
tree structure for the object you can assign different authorizations to the menus 
and windows within each area. If you do this, you see the authorization for the 
area becomes “Various Authorizations.”

Tip: To see the entire list of expanded general authorizations, choose the Expand
button. 
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General authorizations are set user-by-user; however, if the customer has groups 
of users who perform the same tasks, the fastest way to assign general 
authorizations is by role.

One way of doing this is to present the various SAP Business One functions 
(modules and menus) to a nominated representative user for each role.  This 
person then marks the functions that they use. p y

Next, create a user account for the representative user and assign the correct 
license type to this user. Test to make sure that the combination of license and 
general authorizations provides access to the required functionality for the role. 

You can then copy this set of authorizations from one user to another user, from 
the general authorizations window. Select the source user name in the 
authorizations window, then drag the source user name over the target user 
name. 

In the AIP materials you can use the Business Process Master List (BPML) tool to 
help you define customized roles according to SAP Business One functions. 
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After you have set the general authorizations you can print a report with a full list 
of authorizations for up to four selected users.

Additionally, you can export the complete list of authorizations to Microsoft Excel 
or as a PDF file. This allows you to review each authorization offline with the 
client, and make any required adjustments.

To see the effect of each general authorization refer to the how to guide How toTo see the effect of each general authorization, refer to the how-to guide How to 
Define Authorizations. 

© SAP AG 198 TB1200



Changes to authorizations are tracked in the change log. To open the change log, 
make sure the General Authorizations window is active, then choose Tools > 
Show History.
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The last part of this topic looks at document ownership and document ownership 
authorizations.
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Every document can be optionally linked to a designated sales or purchasing 
employee. And every document can have a designated owner. The owner can be 
a different user from the sales or purchasing employee, and from the contact 
person for the business partner.

So how can you designate the sales employee / buyer or the owner for a 
document?
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The sales employee / buyer that is linked to a document defaults in from the 
business partner master data. 

First you need to define the sales employees and buyers in the system. Choose 
Administration > Setup >General > Sales Employees/Buyers.

Once setup, you can now assign the responsible sales employee or buyer to 
relevant business partner master data recordsrelevant business partner master data records. 

The name of the sales employee or buyer will be automatically selected in all 
marketing documents created for the business partner. 

Of course the sales employee or buyer name can be changed in an individual 
document if required. 

A i i th l t l l / b t th ti b i tAssigning the relevant sales employee / buyer to the respective business partners, 
and later to each sales or purchasing document, enables the customer to do the 
following:

• Generate sales analysis and purchasing analysis reports by sales employee or 
buyer

• Assess the sales / purchasing volume achieved by each sales employee / 
buyerbuyer

© SAP AG 202 TB1200



The owner of a document is normally the user who creates the document; 
however, if there is a designated sales employee or buyer for the business 
partner, and the sales employee or buyer is linked to an employee master data 
record, then the sales employee or buyer becomes the default owner.

In the example, the user Sophie Klogg has created a sales order for Earthshaker 
Corporation.  Bill Levine is set as the designated sales employee for this p g p y
customer, and since Bill Levine also has a linked employee master data record, 
then Bill Levine automatically becomes the owner.
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The owner of a document is the basis for another type of authorization – Data 
Ownership Authorizations.

Using data ownership authorizations, you can permit another person access to a 
document and even to the rows in a document based upon the person’s 
relationship to the owner. This is mostly relevant for departments such as sales 
and purchasing where there might be a need to restrict access to documents from p g g
within a department. 
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Here is a simple example. We can set up employee master data records to model this 
organization, for the purposes of data ownership.

In the master data for the sales employees Fred Buyer and Mary Discount, we select 
George Profit as the manager. We also need to create a master data record for the 
manager.

Also in the master data we select the same department for all three employees, thus 
linking them using both the department and the management structure.

For data ownership authorization purposes, we can define the relationships as:

 Peer: The user can access documents owned by a colleague at the same level in 
the hierarchy. 

 Manager: The user can access documents owned by his or her direct manager Manager: The user can access documents owned by his or her direct manager.

 Subordinate: The user can access documents owned by any of his or her direct 
subordinates. 
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You can use employee master data to model the organization of a company. To 
define employee master data records, choose Human Resources > Employee 
Master Data.

In the master data, you can specify information about an employee, such the 
department, manager, and role within the organization. You can also record 
personal information for the employee, and some HR data.p p y ,

Many fields are common between the employee master data and the user 
account. When you add an employee master data record, you can optionally 
generate a user account, if one does not exist. If a user account exists, you can 
have common fields copied from the master data to the user account.
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Data ownership can be enabled or disabled system wide using the Data 
Ownership Exceptions screen. Once set, users will have restricted access to 
documents and sales opportunities, and even to document rows, based on a 
defined relationship with the document owner. 

In this window, you can also select which objects are subject to data authorization 

restrictions either fully or partially If you select No Filtering for an object thenrestrictions, either fully or partially. If you select No Filtering, for an object, then 

data ownership is not active for the object. In the case that a document or sales 

opportunity has no owner defaulted in, then any user can access it as if no data 

ownership is in place. 
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After enabling data ownership filtration, the next step is to define the permissions for each 
user, in the Data Ownership Authorizations screen.

A user can access a document as long as he or she has a defined relationship with the 
owner of the document and has been granted either Read Only or Full for the data 
ownership permission for that relationship. The full range of possible relationships is:

By reporting line:By reporting line:

 Peer: The user can access documents owned by a colleague on the same level in 
the hierarchy. 

 Manager: The user can access documents owned by his or her direct manager.

 Subordinate: The user can access documents owned by any of his or her direct 
subordinates. 

By organizational line:y g

 Department: The user can access documents owned by a member of the same 
department.

 Branch: The user can access documents owned by a member of the same branch.

 Team: The user can access documents owned by a member of the same team.

In the example, the user Fred Buyer can view (and optionally update) sales orders owner 
by his peers and colleagues in the same team.  Fred has no access to sales orders 
owned by his manager or by users in his branch. He can only view sales orders owned by 
users in the same department.
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Here are some key points to take away from this session.
• There are two types of user account. If you check the Superuser checkbox 

when you create a user account, the user will have full authorization to every 
function in SAP Business One. Super users need a Professional license. If you 
do not check the Superuser checkbox, the user by default has no 
authorizations to any function and you need to grant general authorizations to 
each user.

• The easiest way to grant general authorizations is by role, and you can copy 
the authorizations from one user to other users with similar roles.

• You can designate users as sales employees or buyers. Once setup, you can 
assign the responsible sales employee or buyer as a default for a business 
partner. 

• You can also define employee master data. This enables you to define an 
organizational structure with reporting lines. Employee master data is required 
for data ownership authorizations. These authorizations permit or deny another 
user access to a document based upon the user’s relationship to the owner of 
the document. 

• If the business partner has a designated sales employee or buyer, and the 
sales employee / buyer is linked to employee master data, then the sales 
employee or buyer is by default the owner of documents created for the 
business partner.
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This topic focuses on the setup required for numbering and printing of documents.
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On completion of this topic, you will be able to:

• Describe the options available for numbering and printing documents

• Create and assign numbering series for documents and master data

• Change menu names in the main menu

• Set default print layouts for users and business partners• Set default print layouts for users and business partners
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The sales staff at DG Industries are divided into three separate market areas, 
each with a different set of customers.

The sales documents produced by each area should be numbered differently so 
they can be tracked to each area. 

Additionally, the customers for each area are coded differently.

Solution: You can define multiple document numbering and customer master 
data numbering ranges, and assign them to specific users. .
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In the first part of this topic, we will cover document numbering.
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When you first create a company, the first document number is set to start at 1 for 
each document type, and there is a default series – the Primary series.

The document numbering function lets you define the actual document numbers 
allocated to each document type. 

Note that the client accountant should specify the requirements for document 
numbering, since legal regulations can vary depending on localization.
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To set the starting number for the default primary series, double-click the row for 
the document type. A new window opens, allowing you to enter the first and 
optionally the ending number for the series. The system will automatically allocate 
numbers incrementally from the first number and will record the next number to be 
allocated for each document type.

If only one series is required, you can use the default Primary series for all users. y q , y y
You can define a prefix or suffix for the series. The prefix or suffix is only relevant 
for printing, and is not added to the document number. 

© SAP AG 216 TB1200



When a user account is created, the user has no access to the document 
numbering series, even to the default series. Before users can create documents, 
they need authorization to the series. Users are given permission to the 
numbering series through the corresponding Group selected on the series row. In 
the Group field, you can select a number between 1 and 10. This means you can 
define up to 10 different numbering series in total. 

You need to make sure that each user who will create documents has 
authorization to the Group,  even for the Default series, otherwise the user cannot 
open the initial window for this type of document. The authorization is set in the 
General Authorizations screen. Navigate to Administration > System Initialization 
> Numbering Series and select the appropriate Series – Group No. from the list. 
As an example, the primary series shown here has Group 1 selected, so users 
need the authorization Administration > System Initialization > Numbering Series y g
> Series – Group No. 1. 

Note: Users with the general authorization Document Manual Numbering also 
have the option to select manual numbering when creating a document and can 
assign a manual document number.
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You can create multiple numbering series for each document type, with a different 
numbering range. This gives the customer the ability to designate specific ranges 
of document numbers to individual users. 

To define an additional series, first open the setup window by double-clicking the 
document row.

Next, right-mouse click on the Primary series row and select Add Row from the 
context menu. 

To create and maintain document series, you need the general authorization 
Administration > Document Numbering. 
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Enter the starting number for the series. SAP Business One populates the Next 
No. field automatically. 

Document numbers should  not overlap between series, therefore you must enter 
the Last No. field. The new series should start with the next consecutive number 
after the last number in the previous series, to ensure there are no gaps in the 
d t bdocument numbers. 

You can optionally enter a prefix or suffix for the new series, which does not 
appear in the document, but will be printed.
If you lock a series, no further documents can be created with the numbers in that 
series. To continue operations, ensure that another series is set as the default. 

Note: Certain country regulations permit document numbering series that contain 
more than one document type. All of these documents are part of the same 
numbering series. A checkbox is available in the Company Details screen to 
permit this. This setting cannot be changed after it has been selected.
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You can link a document numbering series with the posting periods for a specific 
fiscal year using a Period Indicator.  

You can use the default period indicator that applies to all posting periods, 
including new ones that will be created in the future, or you can create additional 
period indicators by choosing Administration >Setup Financials >Period 
Indicators, or by selecting Define New from the numbering series row., y g g

If you use a different period indicator for each new posting period, you can start 
document numbering at 1 for each new fiscal year.

Furthermore, if you link a numbering series to a specific fiscal year using the 
period indicator, you can restrict the posting of documents for the series to the 
fiscal year. Only document numbers for a series with the same period indicator as 
the current posting period can be posted. 

If you create a new Period Indicator and want to use this for the existing posting 
periods, you must do this before any document postings. 
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You can also change the name of a document in the main menu. To specify a new 
menu name, enter it in the row for the Primary series. 

You can change document names even if documents have already been entered 
in the system. The new name appears in the SAP Business One Main Menu and 
in the title bar of documents of this type.
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As well as setting up a numbering series for documents, you can set up a 
numbering scheme for business partner and item master data codes.

The first three rows in the document numbering window show the series for 
customer, vendor and item master data.

Note: The Manual series of master data is grayed out and cannot be edited or 
deleted A user can still select the Manual series and enter the number manually ifdeleted. A user can still select the Manual series and enter the number manually, if 
they have authorization.
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To define a new series, enter the first number to be allocated by the system as the 
code for new customer, vendor, or item master data records. When the user 
creates a new master data record, the system will assign this number to the 
master data and will increment the next number by 1. 

You can enter a suffix and/or a prefix  which will be added to the business partner 
or item code. For example, if you define a prefix as “C-”, the customer code will be p , y p ,
allocated as C-20001. For numbering series of master data, prefixes and suffixes 
help avoid overlaps with other series.

You must specify the number of digits contained in the number. For example, if the 
first number is 1, and the number of digits is 5, the number will be allocated in the 
master data as 00001.

You can set the new numbering series as default for users, and also assign the 
i t G i th f d t b i iseries to a Group, in the same way as for document numbering series. 

You can define the last number of a series to restrict its numeric range and avoid 
overlaps with another series. 
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In the next part of this topic, we will cover document printing.
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Print layouts are templates that define how a document or report will look when it 
is printed.

SAP provides a set of predefined layouts you can use as templates to create 
client-specific printed documents. This is typically done for external facing 
documents but you can also customize the layouts for internally used documentsdocuments, but you can also customize the layouts for internally used documents 
such as pick lists and bills of materials.

You can also create new layouts for customized reports that you develop.
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There can be multiple print layouts for a document. To see the available print 
layouts, open a document and choose the Layout Designer icon from the icon 
toolbar.  The layouts available for the current document type are shown. The one 
in bold is the default template that will be used when the user prints the document.

You should decide with the customer which templates will be required for each 
document. For example, an A/R invoice can be printed as a packing list as well as p , p p g
an invoice. 

Note: If you print or preview a document before you add it to the system, the 
system automatically adds the Draft watermark to the printout.
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It is quite possible that users might need to use more than one print layout 
template for a document. A user might need to use an invoice layout for each of 
their customers’ languages, or set a different invoice layout for certain groups of 
customers.  

Authorized users can set a different layout to be used as default for different users 
or business partners. A new template can be set as default for:p p

 All users

 The current user

 Specific users that you select from the list of users

 Documents for business partners for which a default template has not yet 
been assigned

D t f l t d b i t thi ll t l t Documents for selected business partners – this allows you to select one or 
more business partners.

Note: To be authorized to change the default print layout currently defined for a 
certain document or report, the general authorization General  Change Default 
Report is required. 

In SAP Business One you can also preview a document using a different print 
layout (not the default layout). This is useful when you are editing print layoutslayout (not the default layout). This is useful when you are editing print layouts 
during the implementation. Choose File  Preview Layouts...
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If during business processing an unauthorized user needs to change a default 
print layout, a prompt will display, allowing an authorized user to give permission 
for a one time change by entering their name and password. The user can only 
change the default layout for their own use, and not for other users.
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When you install SAP Business One, print layouts for documents and reports are 
loaded according to the localization.

You can view and manage these print layouts using the Report and Layout 
Manager. Choose Administration  Setup  General  Report and Layout 
Manager. 

Authorized users can also access the Report and Layout Manager using anAuthorized users can also access the Report and Layout Manager using an 
additional button – Manage Layout, that displays when they select the Layout 
Designer icon from the toolbar. 

You can browse the list, or search for a named report or layout. For a selected 
print layout, you can set a default printer from the available list of printers, and the 
number of copies. For example, this could be a specific printer used for printing 
bank checks or sensitive reports.

Note: You cannot delete system SAP Business One reports and layouts that are 
provided with the core product.
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Different companies have different printing needs and procedures. With the 
printing sequence you can customize how documents are printed to match these 
procedures. 

In the Report and Layout Manager window, select a print layout, then choose the 
Printing Seqs tab.

The sample printing sequence shown here will print the first copy of the A/RThe sample printing sequence shown here will print the first copy of the A/R 
invoice using the item print layout, followed by a packing list, followed by two 
copies of the delivery, followed by the original sales order. 

You can select the print layout template for each document in the sequence. You 
can also select the printer for each document.
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Print layouts need to be customized during an implementation project, so they 
meet the customer’s needs for external facing documents. You will need at 
minimum to insert the company’s logo and address. You might need to translate 
the print layout to provide printed documents in a customer’s native language.

These changes can take a considerable amount of time. During an 
implementation you should demonstrate the various print layouts to the customer. p y p y
When you identify a layout that best fits the customer’s needs, you can use that 
layout as the base for changes.
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When you select a document type you will see all the print 

layouts for that document type. Print layouts are provided in 

either Crystal Reports or Print Layout Designer (PLD) format. 

To edit a print layout, double-click the row for the layout, or p y y

select the row and choose the Edit button.
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If the print layout is the Crystal Reports type, the system 
automatically opens SAP Crystal Reports for SAP Business One 
designer. This allows you to edit and save the layout. 

Note: SAP Crystal Reports, version for the SAP Business One 
li i i id d i h h i ll i fil f SAP B iapplication is provided with the installation files for SAP Business 

One. It is recommended that you install SAP Crystal Reports 
before you install SAP Business One. If you do not, you may 
need to run a script to install the integration package. The 
integration script is provided in the install files. Once the 
i t ti k i i t ll d SAP B i O i hintegration package is installed, SAP Business One is shown as a 
data source in Crystal Reports and the SAP Business One tables 
match the application menu structure.

The detailed steps for editing a print layout are not covered in this p g p y
topic. For more information on editing a print layout, see the how-
to guide How to Work with Crystal Reports in SAP Business One.
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If the print layout is the Print Layout Designer type, the built-

in Print Layout Designer tool will automatically open, allowing 

you to edit and save the layout.

The detailed steps for editing a print layout are not covered in 

this topic. For more information on editing a print layout, see 

the how-to guide How to Customize Printing Layouts with the 

Print Layout Designer.Print Layout Designer.
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You can export Crystal Reports layouts that you have created to another SAP 
Business One system. This can save time during the course of a SAP Business 
One implementation, when you need to move templates from one company to 
another, or to apply a layout to different types of documents. 

To export print layouts choose Export A wizard opens allowing you to select theTo export print layouts, choose Export. A wizard opens, allowing you to select the 
layouts for export. The selected layouts are exported as a package (*.b1p or 
*.b1px file type) and can only be imported into another SAP Business One system.

To import layouts, choose Import. The wizard expects to import from a packaged 
file previously create in SAP Business One.
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When you import a package of Crystal Reports print layouts, you can specify the 
layout as a master layout for other document types. This enables you to make 
common changes, such as company logo, in one layout and use this layout for 
other documents with a similar structure. For example, a master layout that is 
created for a sales invoice can be applied to sales quotations or deliveries. 

To define a layout as a master layout , run the Report and Layout Import Wizard y y , p y p
by choosing the Import button:

• In the Report and Layout Selection window, select the Master Layout checkbox 

• In the Set Master Layout window, select the other document types to which you 
want to assign this layout. 

• Fine tune the duplicated layouts as needed. For example, you should update 
text fields that refer to the document type, and delete or add fields based on the yp
specific document type.

Note: You can duplicate a PLD layout to create a new PLD layout. The utility is 
located under the menu Administration > Utilities > Duplicate Layout Template.
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You can define system wide print preferences for documents, as well as per 
document print preferences.

An image of the company’s logo can be uploaded in the Print Preferences window. 
This will automatically appear in documents.

Y l d fi i t f d f lt Th d f lt bYou can also define many print preferences as user defaults. The defaults can be 
assigned to the user’s account. The user default will take precedence over the 
system wide preferences.
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Here are some key points to take from this topic:

• You can set the initial document number for each document type and create 
multiple ranges of document numbers, for each document type. 

• You can allocate different document numbering ranges to different users by 
granting the users the general authorization to the Group associated with the 
document numbering rangedocument numbering range.

• You can set up a numbering scheme for customer, vendor, and item master 
data codes.

• SAP provides a set of predefined print layouts for printing documents. A 
document may use one of several available print layouts, and you can set 
different default layouts to different users, depending on their needs.

• During the implementation you need to edit the print layouts to meet theDuring the implementation, you need to edit the print layouts to meet the 
customer’s need for external facing documents. The Report and Layout 
Manager is the central point for managing print layouts. You can export print 
layouts developed using Crystal Reports to another SAP Business One system. 

• When you import Crystal Reports print layouts, you can designate a master 
layout and apply it to multiple document types. You can duplicate a  layout of 
type print layout designer (PLD) as a template for another document.
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Final Preparation: Exercises 

 

 

 

Unit: Administration Tools 

Topic: Software and Licensing 

 

In this exercise, you will define the paths to the shared folders on 
the server, locate the hardware key for the server, and perform 
license administration tasks. 

 

 

1. Set the paths to shared folders 

Note: To perform this step, you need access to the shared folders on the SAP Business One 
server. 

Choose Administration  System Initialization  General Settings. 

Select the Path tab. 

1.1. Attachments 

If the path for the Attachments Folder is not set in your system, you can set it now. 
Navigate to the SAP Business One server directory that contains the ExclDocs, 
WordDocs and Attachments folders. 

Select the Attachments folder in the server directory. 

Choose Update. 

Open an existing sales order and generate a PDF copy of the document.  

The PDF file will be stored in the Attachments folder. 

1.2. Pictures 

If the path for the Pictures Folder is not set in your system, you can set it now. Choose 
the browse button and navigate to the SAP Business One shared directory that contains 
the Bitmaps folder. 

Select the Bitmaps folder in the server directory. 

Open an existing item master data record. Choose the Remarks tab and click the 
camera icon. 

Select an image from the Bitmaps folder and choose Open. 

The image will show in the item master data. 

Choose Update to save the master data. 

© SAP AG 239 TB1200



2. License Manager  

2.1. Find the hardware key 

To request a license key, you need the hardware key from the SAP Business One 
server. 

Locate the hardware key from the Help menu in your SAP Business One application. 

Where else can you find the hardware key? 

A. System Landscape Directory? 

B. License manager settings? 

C. The License Administration screen? 

2.2. Assign a License to a user 

Choose Administration  License  License Administration. 

On the Allocation tab, if you have an available license type, select a user name and 
assign the license to the user. 

Choose Update. 

2.3. View the EULAs 

Choose Administration  License   End User License Agreement. 

You can see the signed EULAs on your system. 

2.4 Stop the License Server 

In the Service Manager, stop the license manager service. 

Choose Administration  Choose Company. 

Choose Refresh. 

What are the implications of stopping the license server? 

___________________________________________ 

 

Remember to restart the license server again! 

Note: You can also start and stop the license manager service from the Services 
window on your system. 

 

© SAP AG 240 TB1200



Final Preparation: Solutions 

 

 

Unit: Administration Tools 

Topic: Software and Licensing 

 

In this exercise, you will define the paths to the shared folders on the server, locate the 
hardware key for the server, and perform license administration tasks. 

 

1. Set the paths to shared folders 

Note: To perform this step, you need access to the shared folders on the SAP Business One 
server. 

Choose Administration  System Initialization  General Settings. 

Select the Path tab. 

1.1. Attachments 

If the path for the Attachments Folder is not set in your system, you can set it now. 
Choose the browse button and navigate to the SAP Business One shared directory that 
contains the ExclDocs, WordDocs and Attachments folders. 

Select the Attachments folder in the server directory. 

Choose Update. 

Open an existing sales order and choose the PDF icon from the menu bar. 

The system will generate a PDF copy of the document and store it in the Attachments 
folder.  

1.2. Pictures 

If the path for the Pictures Folder is not set in your system, you can set it now. Choose 
the browse button and navigate to the SAP Business One directory that contains the 
Bitmaps folder. 

Select the Bitmaps folder in the server directory. 

Choose Update. 

Open an existing item master data record. Choose the Remarks tab and click the 
camera icon. 

The system will open the Bitmaps folder. Select an image from the Bitmaps folder and 
choose Open. 

The image will show in the item master data. 

Choose Update to save the master data. 
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2. License Manager  

2.1. Find the hardware key 

To request a license key, you need the hardware key from the SAP Business One 
server. 

From the top menu of SAP Business One, choose Help > About SAP Business One. 

Where else can you find the hardware key? 

A. System Landscape Directory? 

B. License manager settings? 

C. The License Administration screen? 

2.2. Assign a License to a user 

Choose Administration  License  License Administration. 

On the Allocation tab, if you have an available license type, select a user name and 
select the checkbox for a license type to assign the license to the user. 

Choose Update. 

2.3. View the EULAs 

Choose Administration  License   End User License Agreement. 

You can see the signed EULAs on your system. 

2.4 Stop the License Server 

In the Service Manager, stop the license server. 

Choose Administration  Choose Company. 

Choose Refresh. 

What are the implications of stopping the license server? 

___________________________________________ 

 

Remember to restart the license Server again! 

Note: You can also start and stop the licens manager service from the Services window 
on your system. 
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Final Preparation: Exercises 

 

 

 

Unit: Administration Tools 

Topic: Security 

 

 

1. Change the database user account for a company 

Note: To perform this step, you need access to the SAP Business One server. 

Open the System Landscape Directory in a browser on the SAP Business One server 
machine. 

Login to the System Landscape Directory. 

Choose the Servers and Companies tab. 

Select a company and generate a database user to replace the default user “sa”. 

The new database user will be displayed for the selected company. 

What is the implication of this change? 

 Users will need to supply new database credentials when accessing a company 

 Access to the database is more secure since the new database user does not have 
system admin rights 

 When you backup the company database, you will need to provide the new user and 
password 

 

 

2. Set the Password Policy in SAP Business One 

Choose Administration  Setup  General  Security  Password Administration. 

Change the security level: 

Field Values 

Security Level Select a different level, for example, High. 

Password Example Choose Generate 

Choose Update. 

What is the implication of this change? 

_______________________________________________________________________ 
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3. Change a user’s password 

Choose Adminstration  Setup  General  Users. 

Select a user account. If there are no users defined in your system, add a new user. 

Set the user password according to the new policy. 

 

4. View the access log 

Choose Tools  Access log. 

Review the access log for your system. 

Double-click a row to see the details. 

 

5. View the change history log 

Choose Adminstration  System Initilaization  Authorizations  General 
Authorizations. 

In the General Authorizations window, select a user and make a change to one of the 
authorizations for the user. 

With the authorizatons window still active and the user selected, choose Tools  Show 
History. 

Select the first row and choose Show Differences. 

Double-click a row to see the original window. 

 

Create a sales document and save it to the system. 

Re-open the sales document and change the quantity on the row. 

Choose Update. 

Choose Tools  Show History to open the change log. 

Select the first row and choose Show Differences. 
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Final Preparation: Solutions 

 

 

Unit: Administration Tools 

Topic: Security 

 

 

1. Change the database user account for a company 

Open a browser on the SAP Business One server machine and navigate to 
https://localhost:30010/ControlCenter.  

Enter the site user password and login to the System Landscape Directory. 

Choose the Servers and Companies tab. 

Select a company and choose Edit. 

In the pop-up window, select the option Use Specified Database User. 

Choose OK. 

A database user will be generated for the company, instead of the user ‘sa’. 

The new user will be displayed for the selected company. 

What is the implication of this change? 

 Users will need to supply new database credentials when accessing a company 

 Access to the company database is more secure since the new database user does 
not have system admin rights 

 When you backup the company database, you will need to provide the new user and 
password 

 

 

2. Set the Password Policy 

Choose Administration  Setup  General  Security  Password Administration. 

Change the security level: 

Field Values 

Security Level Select a different level, for example, High 

Password Example Choose Generate 

Choose Update. 

What is the implication of this change? 

_______________________________________________________________________ 
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3. Change a user’s password 

Choose Adminstration  Setup  General  Users. 

Select a user account. If there are no users defined in your system, switch to Add mode and 
add a new user. 

Choose the browse button next to the Password field and set the user password according 
to the new policy. 

 

4. View the access log 

Choose Tools  Access log. 

Review the access log for your system. 

Double-click a row to see the details. 

 

5. View the change log 

Choose Adminstration  System Initilaization  Authorizations  General 
Authorizations. 

In the General Authorizations window, select a user and make a change to one of the 
authorizations for the user. 

Choose Update. 

With the authorizatons window still active and the user selected, choose Tools  Show 
History. 

Select the first row and choose Show Differences. 

Double-click a row to see the original window. 

 

Create a sales document and save it to the system. 

Re-open the sales document and change the quantity on the row. 

Choose Update. 

Choose Tools  Show History to open the change log. 

Select the first row and choose Show Differences. 
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Exercises 

 

 

 

Unit: Administration Tools 

Topic: User Accounts and Authorizations 

 

 

1-1 Define Departments and User Accounts 

1-1-1 Define Departments 

Choose Administration  Setup  General  Users. 

If there are departments in your system for Sales and Purchasing, you can skip 
this step. If the departments do not exist, create new departments: 

Field Values Then Choose 

Department Sales Update 

Department Purchasing Update 

Choose OK. 

 

1-1-2 Define User Accounts 

Choose Administration  Setup  General  Users 

Add the following users. 

Field Name  Values 

User Code Enter a login code 

User Name Your name 

Superuser  

Department General 

Password Deselect the Change Password at Next Logon 
checkbox. 

Set a password in accordance with the password 
policy and confirm the password. 

Password _____________ 

Choose Update. 

Choose Add. 
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Field Name  Values 

User Code sarah 

User Name Sarah Miller 

Superuser  

Department Sales 

Password Deselect the Change Password at Next Logon 
checkbox. 

Enter a password in accordance with the password 
policy and confirm the password. 

Password _____________ 

Choose Update. 

Choose Add. 

 

Field Name  Values 

User Code maggie 

User Name Maggie Martins 

Superuser  

Department Sales 

Password Deselect the Change Password at Next Logon 
checkbox. 

Enter a password in accordance with the password 
policy and confirm the password. 

Password _____________ 

Choose Update. 

 

Choose Add. 

 

1-1-3 Login as a New User 

Open another copy of the SAP Business One client, and login with the user 
code you assigned to your own user account 

Enter the password as set in step 1-1-2. 

Choose OK. 

Open the Administration menu. If you try to open one of the sub-menus you 
will get an error “You cannot open the window with your current license”. Even 
though your account is a super user, you do not have a license to the functions. 

Choose File  Exit to logout from the user account. 
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2-1 Define General Authorizations 

Switch back to the SAP Business One session for the user manager. 

Define general authorizations for the new users create in step 1-1. 

Choose Administration  System Initialization  Authorizations General 
Authorizations. 

2-1-1 Define General Authorizations for Sarah (Sales Manager). 

Choose the name sarah from the list on the left. 

All authorizations are set as No Authorization for a user who is not a super user. 
Set the following authorizations for the user Sarah: 

Subject Authorization 

General Full Authorization 

Sales Opportunities  Full Authorization 

Sales A/R Full Authorization 

Business Partners Full Authorization 

Banking  Full Authorization 

Inventory Read Only 

Reports Full Authorization 

Enter 20% as the maximum discount for sales. 

Choose Update. 

Leave the authorizations window open. 

 

2-1-2 Define General Authorizations for Maggie (Sales) 

Copy the authorizations you made for the user sarah. 

Select the name sarah and drag and drop the rectangle over the name maggie. 

Choose Copy in the System Message window. 

Maggie now has the same general authorizations as Sarah. However, Maggie 
should not have access to all of the functions. Change the authorizations for the 
user Maggie:  

Subject Authorization 

Sales Opportunities No Authorization 

Reports Read Only 

Enter 10% as the maximum discount for sales. 

Choose Update. 
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3-1 Test General Authorizations  

Note: You will need to first assign a license to the new user user before you login. 

3-1-1 Assign a License to Sarah 

Choose Administration  License  License Administration. 

Select the user sarah and check the selection box to assign the license type.  

Note: Assign a license to sarah if you have one available on your system. If you 
only have one Professional license, you will need to uncheck the license 
assignment checkbox for the user manager, and assign the Professional license 
to sarah. 

3-1-2 Test the authorizations for Sarah (Sales manager) 

Open another copy of the SAP Business One client, and login as the user sarah. 

Choose Purchasing A/P and open a purchasing document. 

You will get an authorization error as Sarah has no general authorization to the 
purchasing function, even though she has a valid license. 

Note: An authorized use can permit Sarah to access the document one time, by 
providing a valid user and password. 

Choose Sales A/R. 

Open a sales order. 

Sarah can open a sales order as she has general authorization to the Sales A/R 
function. 

Logout as the user sarah from SAP Business One. 

Note: if you assigned your Professional license to sarah, remember to assign it back to 
the user manager. 

 

4-1 Define sales employees / buyers 

  Choose Administration   Setup  General  Sales Employees/Buyers. 

  Add the manager name (Jayson Butler) to the list of sales employees / buyers. 

  Choose Update. 

Choose Business Partners  Business Partner Master Data. 

Find an existing customer master data record.  

Write down the business partner name or code _______________. 

Select the name Jayson Butler in the Sales Employee field. 

Open a new sales order and select the business partner you just updated. 

The name Jayson Butler will appear in the Sales Employee or Buyer field in the 
document. 
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5-1 Data ownership authorizations 

 Data ownership authorizations are based on the document owner. To set a document 
owner, you need to create employee master data and link it to a sales employee / buyer. 

5-1-1 Define employee master data records 

  Choose Human Resources  Employee Master Data. 

Create a new employee master data record for Sarah Miller. 

Select the Sales department. 

In the User Code field, select the user sarah from the list. 

 In the Sales Employee field, select Define New. This allows you to define Sarah 
as a sales employee / buyer. Enter the name Sarah Miller. 

Add the employee master data record. 

The system prompts you to add a user account. Choose No since the account 
already exists. 

Add a second employee master data record for the user manager (Jayson 
Butler).  

In the User Code field, select the user manager from the list. 

In the Manager field, choose the name Sarah Miller. 

Choose Add. 

Choose No to the system message. 
 

5-1-2 Check the document owner 

Create a sales order for the business partner you used in step 4-1. 

You should now see the name Jayson Butler as both the Sales Employee and 
the Owner of the sales order document. 

    Save the document. 

Make a note of the document number as you will need to reference this 
document later. 

 ____________________________ 
 

5-1-3 Enable data ownership authorizations in the system 

Choose Administration > System Initialization > Authorizations > Data 
Ownership Exceptions. 

    Select the Enable Ownership Filtration checkbox. 

 

© SAP AG 251 TB1200



5-1-4 Set data ownership authorizations 

Note: After you enable data ownership authorizations in the system, no user 
other than the document owner can view a document until you set the 
authorizations.  

Choose Administration > System Initialization > Authorizations > Data 
Ownership Authorizations. 

Grant authorization to documents owned by the user Jayson Butler. 

Select the user Sarah Miller then select Full in the Subordinate column for the 
sales order document. This authorization means that Sarah Miller can view and 
update documents owned by her subordinates defined in the employee master 
data. 

 

Open another copy of the SAP Business One client, and login as the user Sarah 
Miller (sarah). Note: If no license has been assign to the user sarah, you need 
to assign one before you login. 

As the user sarah, try to access the sales order created in step 5-1-2. Note: To 
access the sales order you can open a sales order document and browse through 
records, or you can switch to Find mode and enter the document number and 
choose Find. 

You will be unable to find or view the document due to data ownership 
restrictions. 
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Solutions 

 

 

Unit: Administration Tools 

Topic: User Accounts and Authorizations 

 

1-1 Define Departments and User Accounts 

 

1-1-1 Define Departments 

If there are departments in your system for Sales and Purchasing, you can skip 
this step. 

 

To add a new department, choose Administration  Setup  General  
Users. 

In the Department field, choose Define New from the dropdown list. 

Enter the following departments: 

Field Values Then Choose 

Department Sales Update 

Department Purchasing Update 

Choose OK. 

 

1-1-2 Define User Accounts 

Choose Administration  Setup  General  Users 

Add the following users. 

Field Name  Values 

User Code Enter a login code 

User Name Your name 

Superuser  

Department General 

Password Deselect the Change Password at Next Logon 
checkbox. 

Choose the browse button to the right of the 
Password field. 

Enter a password in accordance with the password 
policy and confirm the password. 

Password _____________ 

Choose Update. 

Choose Add. 
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Field Name  Values 

User Code sarah 

User Name Sarah Miller 

Superuser  

Department Sales 

Password Deselect the Change Password at Next Logon 
checkbox. 

Choose the browse button to the right. 

Enter a password in accordance with the password 
policy and confirm the password. 

Password _____________ 

Choose Update. 

Choose Add. 

 

Field Name  Values 

User Code maggie 

User Name Maggie Martins 

Superuser  

Department Sales 

Password Deselect the Change Password at Next Logon 
checkbox. 

Choose the browse button to the right. 

Enter a password in accordance with the password 
policy and confirm the password. 

Password _____________ 

Choose Update. 

 

Choose Add. 

1-1-3 Login as a New User. 

Open another copy of the SAP Business One client, and login with the user 
code you assigned to your own user account 

Enter the password as set in step 1-1-2. 

Choose OK. 

Open the Administration menu. If you try to open one of the sub-menus you 
will get an error “You cannot open the window with your current license”. Even 
though your account is a super user, you do not have a license to the functions. 

Choose File  Exit to logout from the user account. 
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2-1 Define General Authorizations 

Switch back to the session for the user manager. 

Define general authorizations for the new users create in step 1-1. 

Choose Administration  System Initialization  Authorizations General 
Authorizations. 

2-1-1 Define General Authorizations for Sarah (Sales Manager). 

Choose the name sarah from the list on the left. 

All authorizations are set as No Authorization for a user who is not a super user. 
Set the following authorizations for the user Sarah: 

Subject Authorization 

General Full Authorization 

Sales Opportunities  Full Authorization 

Sales A/R Full Authorization 

Business Partners Full Authorization 

Banking  Full Authorization 

Inventory Read Only 

Reports Full Authorization 

Enter 20% as the maximum discount for sales. 

Choose Update. 

Leave the authorizations window open. 

 

2-1-2 Define General Authorizations for Maggie (Sales) 

Copy the authorizations you made for the user sarah. 

Select the name sarah and drag and drop the rectangle over the name maggie. 

Choose Copy in the System Message window. 

Maggie now has the same general authorizations as Sarah. However, Maggie 
should not have access to all of the functions. 

Change the authorizations for the user Maggie:  

Subject Authorization 

Sales Opportunities No Authorization 

Reports Read Only 

Enter 10% as the maximum discount for sales. 

Choose Update. 
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3-1 Test General Authorizations  

Note: You will need to first assign a license to the new user before you login. 

3-1-1 Assign a License to Sarah 

Choose Administration  License  License Administration. 

Select the user sarah and check the selection box to assign the license type.  

Note: Assign a license to sarah if you have one available on your system. If you 
only have one Professional license, you will need to uncheck the license 
assignment checkbox for the user manager, and assign the Professional license 
to sarah. 

3-1-2 Test the authorizations for Sarah (Sales manager) 

Open another copy of the SAP Business One client, and login as the user sarah. 

Choose Purchasing A/P and open a purchasing document. 

You will get an authorization error as Sarah has no general authorization to the 
purchasing function, even though she has a valid license. 

Note: An authorized use can permit Sarah to access the document one time, by 
providing a valid user and password. 

Choose Sales A/R. 

Open a sales order. 

Sarah can open a sales order as she has general authorization to the Sales A/R 
function. 

Logout as the user sarah from SAP Business One. 

Note: if you assigned your Professional license to sarah, remember to assign it back to 
the user manager. 

 

4-1 Define sales employees / buyers 

  Choose Administration   Setup  General  Sales Employees/Buyers. 

  Add the manager name (Jayson Butler) to the list of sales employees / buyers. 

Choose Update, then OK. 

 

Choose Business Partners  Business Partner Master Data. 

Find an existing customer master data record.  

Write down the business partner name or code _______________. 

Select the name Jayson Butler in the Sales Employee field. 

Choose Update. 

Open a new sales order and select the business partner you just updated. 

The name Jayson Butler will appear in the Sales Employee or Buyer field in the 
document. 
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5-1 Data ownership authorizations 

 Data ownership authorizations are based on the document owner. To set a document 
owner, you need to create employee master data and link it to a sales employee / buyer. 

5-1-1 Define employee master data records 

  Choose Human Resources  Employee Master Data. 

  Switch to Add mode. 

Create a new employee master data record for Sarah Miller. 

Select the Sales department. 

In the User Code field, select the user sarah from the list. 

 In the Sales Employee field, select Define New. This allows you to define Sarah 
as a sales employee / buyer. Enter the name Sarah Miller, then choose Update, 
then OK. 

Add the employee master data record. 

The system prompts you to add a user account. Choose No since the account 
already exists. 

Add a second employee master data record for the user manager (Jayson 
Butler).  

In the User Code field, select the user manager from the list. 

In the Manager field, choose the name Sarah Miller from the list of employees. 

Choose Add. 

Choose No to the system message. 
 

5-1-2 Check the document owner 

Create a sales order for the business partner you used in step 4-1. 

You should now see the name Jayson Butler as both the Sales Employee and 
the Owner of the sales order document. 

    Save the document. 

Make a note of the document number as you will need to reference this 
document later. 

 ____________________________ 
 

5-1-3 Enable data ownership authorizations in the system 

Choose Administration > System Initialization > Authorizations > Data 
Ownership Exceptions. 

    Select the Enable Ownership Filtration checkbox. 

Choose Update. 

Choose OK. 

 

© SAP AG 257 TB1200



5-1-4 Set data ownership authorizations 

Note: After you enable data ownership authorizations in the system, no user 
other than the document owner can view a document until you set the 
authorizations.  

Choose Administration > System Initialization > Authorizations > Data 
Ownership Authorizations. 

Grant authorization to documents owned by the user Jayson Butler. 

Select the user Sarah Miller then select Full in the Subordinate column for the 
sales order document. This authorization means that Sarah Miller can view and 
update documents owned by her subordinates defined in the employee master 
data. 

Choose Update. 

Choose OK. 

 

Open another copy of the SAP Business One client, and login as the user sarah. 
Note: If no license has been assign to the user sarah, you need to assign one 
before you login. 

As the user sarah, try to access the sales order created in step 5-1-2. Note: To 
access the sales order you can open a sales order document and browse through 
records, or you can switch to Find mode and enter the document number and 
choose Find. 

You will be unable to find or view the document due to data ownership 
restrictions. 
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Exercises 

 

 

 

Unit: Administration Tools 

Topic: Document Numbering and Printing 

 

In this exercise, you will create a new user account so that you 
can assign a new document numbering series. 

 

1-1 Document Numbering  

1-1-1 Create a new user account 

Choose Administration  Setup  General  Users and create a new user account. 

Field Name  Values 

User Code marc 

User Name Marc Seller 

Superuser  

Department Sales 

Password Deselect the Change Password at Next Logon 
checkbox. 

Set a password in accordance with the password 
policy and confirm the password. 

Password _____________ 

Choose Update. 

Choose Add. 

 

1-1-2 Define a New Document Numbering Series 

A new sales employee, Marc Seller, needs a different numbering series for sales 
documents. You will implement this by creating a new document numbering 
series.  

Choose Administration   System Initialization  Document Numbering. 

Double-click the row for the Sales Order document to open the Series – Setup 
window. 
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Add a row for the new series: 

Series - Setup Values 

Name Series2 

First No. 2000 

Note: If you have a Primary series defined in 
your system, you must enter 1999 in the 
Last No. field for the Primary series so 
that there are no gaps. 

Prefix S2- 

Note: Prefix is optional. 

Group Choose 2 from the list. 

 

Choose Update to add the new series. Leave the window open. 

Select the row for Series2 then choose the Set as Default button. 

Set the new series as default for the user Marc Seller. 

Choose OK. 

Choose Update. 

Choose OK. 

Choose Update. Note: You must update both windows for the new series to 
take effect. 

 

1-1-3 Set General Authorization to the new series 

Note: All new user accounts have by default no authorization to any numbering 
series, unless the user is a super user. Therefore authorization must be granted 
to a document numbering series. 

Choose Administration  System Initialization  Authorizations  General 
Authorizations. 

Select the user marc. 

Enter Series in the Find field. 

Select Full Authorization for the Series – Group No. 2.  

Note: Make sure that the user also has Full Authorization to the Sales A/R menu. 

Choose Update. 

 

1-1-4    Assign a license (temporary) to the new user 

In order to test the new numbering series, you must assign a license to the user Marc 
Seller. 

Choose Administration  License  License Administration. 

Select the user marc and assign a license. If you only have one license, uncheck the 
license allocation for the user manager. 
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1-1-5 Test the new series  

Open up a new copy of SAP Business One and login as Marc Seller.  

Choose Sales A/R. 

Create a sales order. 

Select a customer and item. 

You will see that the sales order document number is 2000 and the series is 
Series2. 

Choose the Print Preview icon to preview the print layout. You will see that the 
prefix is visible in the layout in front of the document number. 

 
 Log out from this copy of SAP Business One.  

Note: If you assigned your license to marc, remember to assign it back to the 
user manager. 

 

2-1 Change a Document Menu Name 

 Choose Administration   System Initialization  Document Numbering. 

  Scroll to the right of the Document Numbering – Setup window. 

Enter a new name for the Sales Order document in the Change Menu Names column. 

Choose Update. 

Create a sales order. 

You will see the new name for the sales order in the menu and in the document title. 

 

3-1 Master Data Numbering 

Choose Administration   System Initialization  Document Numbering. 

Add a new series for customer master data numbering: 

Series - Setup Values 

Name Series2 

First No. 222222 

Prefix C- 

Note: Prefix is optional. 

No. of Digits 6 

Note: This field is mandatory.  

Choose Update. 

Select the row for the new series and choose the Set as Default button. 

Select Set as default for current user. 

Choose OK. 

Choose Update.  

Choose OK. 

Choose Update.  

Note: You must update both windows for the new series to take effect. 
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Choose Business Partners  Business Partner Master Data. 

Create a new customer master data record. 

You will see the code C-222222 inserted. 

Save the new record. 

The next customer code is incremented. 

 

4-1 Print layouts 

  Open an existing sales order.  

Select a different print layout from the list and set this layout as default for the current 
user. 

Preview the new layout for the document. 

Select another print layout and set as default. 

Print preview the layout. 
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Solutions 

 

 

Unit: Administration Tools 

Topic: Document Numbering and Printing 

 

In this exercise, you will create a new user account so that you can assign a new document 
numbering series. 

 

1-1 Document Numbering  

1-1-1   Create a new user account 

Choose Administration  Setup  General  Users and create a new user 
account. 

Field Name  Values 

User Code marc 

User Name Marc Seller 

Superuser  

Department Sales 

Password Deselect the Change Password at Next Logon 
checkbox. 

Set a password in accordance with the password 
policy and confirm the password. 

Password _____________ 

Choose Update. 

Choose Add. 

 

1-1-2 Define a New Document Numbering Series 

A new sales employee, Marc Seller, needs a different numbering series for sales 
documents. You will implement this by creating a new document numbering 
series.  

Choose Administration   System Initialization Document Numbering. 

Double-click the row for the Sales Order document to open the Series – Setup 
window. 

In the Primary series row, right-mouse click and choose Add Row from the 
context menu. 
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Enter the following information: 

Series - Setup Values 

Name Series2 

First No. 2000 

Note: If you have a Primary series defined in 
your system, you must enter 1999 in the Last 
No. field for the Primary series so that there 
are no gaps 

Prefix S2- 

Note: Prefix is optional. 

Group Choose 2 from the list. 

 

Choose Update to add the new series. Leave the window open. 

Select the row for Series2 then choose the Set as Default button. 

Set the new series as default for the user Marc Seller. 

Choose OK. 

Choose Update. 

Choose OK. 

Choose Update. Note: You must update both windows for the new series to 
take effect. 

 

1-1-3 Set General Authorization to the new series 

Note: All new user accounts have by default no authorizations, unless the user is 
a super user. Therefore authorization must be granted to a document numbering 
series. 

Choose Administration  System Initialization  Authorizations  General 
Authorizations. 

Select the user marc. 

Enter Series in the Find field. 

Select Full Authorization for the Series – Group No. 2.  

Note: Make sure that the user also has Full Authorization to the Sales A/R menu. 

Choose Update. 

 

1-1-4    Assign a license (temporary) to the new user 

In order to test the new numbering series, you must assign a license to the user 
Marc Seller. 

Choose Administration  License  License Administration. 

Select the user marc and assign a license. If you only have one license, uncheck 
the license allocation for the user manager. 
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1-1-5 Test the new series  

Open up a new copy of the SAP Business One client and login as Marc Seller.  

Choose Sales A/R. 

Create a sales order. 

Select a customer and item. 

You will see that the sales order document number is 2000 and the series is 
Series2. 

Choose the Print Preview icon to preview the print layout. You will see that the 
prefix is visible in the layout in front of the document number. 

 Log out from this copy of SAP Business One.  

Note: If you assigned your license to marc, remember to assign it back to the 
user manager. 

 

2-1     Change a Document Menu Name 

  Choose Administration   System Initialization  Document Numbering. 

Scroll to the right of the Document Numbering – Setup window. 

Enter a new name for the Sales Order document in the Change Menu Names column. 

Choose Update. 

Choose OK. 

 

3-1 Master Data Numbering 

Choose Administration   System Initialization  Document Numbering. 

Double-click the row for Business Partners – Customers. 

Right-mouse click the first row and choose Add Row. 

Enter the following information: 

Series - Setup Values 

Name Series2 

First No. 222222 

Group Choose 2 from the list. 

Prefix C- 

Note: Prefix is optional. 

No. of Digits 6 

Note: This field is mandatory. 
Choose Update. 

Select the row for the new series and choose the Set as Default button. 

Select Set as default for current user. 

Choose OK. 

Choose Update.  

Choose OK. 

Choose Update.  

Note: You must update both windows for the new series to take effect. 
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Choose Business Partners  Business Partner Master Data. 

Switch to Add mode. 

You will see the new master data record with the code C-222222 inserted. 

Enter the customer name then choose Add. 

The next customer code is incremented. 

 

4-1 Print layouts 

  Open an existing sales order.  

Choose the Layout Designer icon from the icon toolbar. 

The default print layout is set as bold. 

Select a different print layout from the list and choose the Set as Default button. 

In the Default Layout window, choose Set as Default for Current User. 

Choose OK. 

Choose Update. 

From the top menu choose the Print Preview icon to preview the new layout for the 
document. 

Choose the Layout Designer icon again and select another print layout. 

Set as default for the current user. 

Print preview the layout. 
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Welcome to the topic on queries in SAP Business One.
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In this topic, you will learn to create SQL queries using the SAP Business One 
query tools – Query Wizard and Query Generator. You will also see how to restrict 
access to saved queries.
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Queries enable you to quickly display and format data from an SAP Business One 
company database. You can use queries in several ways, for example:

• with customization tools (alerts, approval procedures, and user-defined values 
added to existing fields or user-defined fields)

• to produce ad hoc reports for users

t t l t i iti l t h t t t• to generate a sample report as an initial step when you create a custom report,

• to validate the contents of a table or field during data migration. You can quickly 
display all the imported fields for a table.

You should understand that the query tools are primarily designed to produce ad 
hoc reports and for use with customization tools. If you need to produce complex, 
fully formatted reports or print layouts, you should use Crystal Reports.
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SAP Business One provides two different query tools that you can access from 
the SAP Business One client:

 Query Wizard

 Query Generator

Both tools assist you in creating queries using the structured query language 
(SQL) SQL i t d di d t f d f i d f tti d t(SQL). SQL is a standardized set of commands for accessing and formatting data 
in relational databases.

Although both tools produce the same results in the end, you should understand 
their differences. 
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The first tool, the Query Wizard, guides you step-by-step through the process of 
creating a query. You should use this tool if you do not have much experience with 
SQL commands and syntax. The system walks you through the process of 
creating a SQL query and generates the SQL statements in the background so 
you do not require precise SQL syntax knowledge. However, because this is done 
by a wizard it takes several steps to produce the query.

You should also find the Query Wizard easier to use if you do not have much 
familiarity with SAP Business One tables and how they are related to each other. 
When you select a table, the Query Wizard will show you all tables that are related 
to your chosen table, allowing you to select data from multiple tables.
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The second tool, the Query Generator, allows you to create the SQL in a single 
screen. If you have some basic SQL knowledge, you will find the Query Generator 
much faster than the Query Wizard.

The system displays the full SQL command and allows you to edit the SQL directly 
if necessary. 

You can also enter an entire SQL statement directly into the Query Generator.

Like the Query Wizard, the Query Generator will automatically supply the inner 
join when you select more than one table for a query. Although it does not show 
you the list of tables related to your chosen table, fields that are keys to related 
tables are shown in bold. You can drag and drop the bolded field to the table 
selection column and the Query Generator will open the related table, allowingselection column and the Query Generator will open the related table, allowing 
you to select fields from that table.

© SAP AG 274 TB1200



In order to run queries you need to know the names of the SAP Business One 
tables and fields.

In SAP Business One, many objects are represented by more than one database 
table. For example, the sales order document uses different tables for the header 
and document rows – the table ORDR stores the header data and the table RDR1 
stores the document rows. 

SAP Business One uses this convention for all marketing documents - the header 
table starts with “O” and the row table uses the last three letters of the header 
table name.
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You can use System Information to display the table and field names for a window 
that you are viewing in SAP Business One.

1.First you toggle on the functionality from the View menu. The short cut key is 
Control plus Shift plus I.

2.Next, open a document or window in SAP Business One. In our example here 
we have opened the Business Partner Master Data windowwe have opened the Business Partner Master Data window.

3.Now, when you move your mouse over a field (for example the Code), the 
second line of the status bar at the bottom of the screen shows the name of the 
table (OCRD) and the field name from the table (CardCode). 

You now have the table name and field name to enter in your SQL query.

Other information about the field is displayed, such as the maximum length of the 
fieldfield.
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The system information also shows, in addition to the table and field name, the 
item number and column number for the field.  

For example, in a sales order, the item number for the CardCode field is 4. The 
column number for the CardCode field is not displayed, since this is a header field 
and the column number for all header fields is 0. 

If you open other marketing documents you will see that the CardCode field isIf you open other marketing documents, you will see that the CardCode field is 
always 4.  Although the table changes for each document type, the item number 
for a field is consistent.
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When you refer to fields in the row area of a marketing document, the column 
number is displayed in addition to the item number. In the example here you can 
see that the ItemCode field in the sales order document has item number 38 and 
column number 1.

You will notice that the item and column number for a field is the same across 
similar document types, for example, the ItemCode has item number 38 and yp , p ,
column number 1 in all sales and purchasing documents. 

Why is this useful? You can use the item and column number instead of the table 
and field name in a query. This makes it possible to to use the same query for 
multiple document types. Obviously, a query that used the table and field name 
would not work across multiple document types.
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You will find that the table and field name is not displayed for some fields, mostly 
totals and prices. One example is the document total field in marketing 
documents. In a document this field is concatenated with the currency symbol, 
whereas in the database the amount and currency are stored in different columns. 
Therefore this field does not exist in the database. 

You can still run a query using these fields, you just need to look up the field name q y g , y j p
in the query tool. An easy way to do this is to create a document, then run a query 
on the table and select all fields.
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The SAP Business One query tools will help you assemble the various elements 
of the query, but you still need to have some knowledge of SQL syntax. 

A query, or the underlying SQL statement, contains one or more of the basic 
elements listed on the slide:

• Selection of fields

C diti f l ti ( h l )• Conditions for selection (where clause)

• Sort order (order by clause)

• Grouping and summarizing (group by clause)

SQL also provides functions to perform calculations on data. In the sample query 
the getdate() function is used to return the current date and time.

The sample query shown in the top right part of the screen will show information 
for open purchase orders posted in the last 7 days.

The query selects data from the purchase order table. The name of this table is 
OPOR. 

The results of the query, a simple snapshot from the database, is shown.

Note that SQL is not case sensitive, therefore the commands do not have to be Q ,
upper case. 
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The Select statement is the only mandatory part of a query. The Select command 
is normally used to fetch and display table fields. In the example, we want to 
display the document number, business partner code, business partner name and 
total amount from the Purchase Order table OPOR.

When the query runs, headings for the report columns are taken from the 
database column names, but you can change these in SQL using the “as” , y g Q g
keyword and entering the heading name in quotes. For example, to change the 
column heading for the DocTotal field, use Select DocTotal as ‘Total Amount’.

You can also specify calculation fields that display the result of an addition, 
subtraction, multiplication, or division of two fields.
If you need more than one table for a query, you normally need to create 
relationships between them. The Query Wizard and Query Generator tools make 
this easy for you by automatically creating joins For example if you select thethis easy for you by automatically creating joins. For example, if you select the 
purchase orders table (OPOR) and also select the business partners master data 
table (OCRD), the query tools will link these tables using the business partner 
code which is common to both tables. 
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The optional Where clause lets you select only records that meet specified 
criteria. For example, in our sample query, only purchase orders that are open 
(DocStatus ‘O’) will be displayed. To find out the possible values for a field such as 
DocStatus, the easiest way is to  run a query on the table and select the field 
name. You will see the possible values that are stored in the database.

In the Where clause you can include:y

• Fixed conditions as comparisons

• Calculations and functions

• AND and OR operators. In the example query, we only want to include 
purchase orders that were posted in the last 7 days; therefore we use the AND 
operator to add a second condition to match the posting date value to the 
current date – 7.

• Variables. Variables are specified as [%0], [%1], [%2], etc.  When you include a 
variable, the user will be prompted to enter a value as a parameter when the 
query runs.
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You can optionally sort the results by adding the Order By clause to the query.

The results will be sorted by default in ascending sequence using the specified 
field. In this example the rows of results (purchase orders) will be sorted by 
posting date (DocDate).

You can sort by descending sequence by adding the keyword DESC 

Y t b lti l fi ld d th fi ld b ith t f th l tYou can sort by multiple fields, and these fields can be either part of the select 
clause or other fields in any of the tables of the query.
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The optional Group By clause allows you to display the query results grouped or 
summarized by a specified field, for example, by business partner. In our example, 
the query has been rewritten to use the Group By element and is shown 
underneath the original query on the slide.

The grouped results are collected into sets using the Group By field or fields as 
the common value.

Group by is usually used in conjunction with a mathematical (aggregate) function, 
such as Count or Sum.  
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When the query runs it will count the number of open Purchase Orders, then sum 
the total amount of each PO.  The selected fields are displayed according to the 
Group by clause, therefore the results are consolidated by vendor, and the query 
shows one consolidated row for each vendor, with the count and the total amount 
of all open purchase orders for the vendor. 

Notice that we need to supply the column headings for the fields that are counted 
and summed, since these fields are not in the database. We supply these 
headings in the Select statement, for example, SUM(DocTotal) as ‘Total Amount’. 
The heading name must be encased in quotation marks.

You can group by more than one field. One word of caution though; the fields that g p y g
you use in the Select statement must appear in either the Group By clause or the 
aggregate function.
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You can save a query for later use, or for other users to run. When you save a 
query you must assign it to a category. Categories are used to organize related 
queries.

The General category is provided in the system, but you can add your own 
categories too.  In the example here we have categories for sales, marketing, and 
purchasing queries.

Queries that you save are located as User Queries. To run a saved user query, 
choose the Tools menu in SAP Business One, and then select the category and 
the query name.

© SAP AG 286 TB1200



When a new user is added to the system, the user does not have any 
authorization to run saved queries. Each user must be granted authorization to run 
a saved query. There are two parts to the authorization process:

1.When you create a new category, you select one or more report authorization 
groups for the category. 

2 To authorize a user to run the reports in the category you assign the user to the2.To authorize a user to run the reports in the category, you assign the user to the 
report authorization group. You can find this authorization in the general 
authorization hierarchy under Reports > Query Generator > Saved Queries –
Group No.

There are 15 different report authorization groups, and you must select at least 
one authorization group, or you will not be able to save the category. g p y g y
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Once a user is authorized to a report authorization group, they can then run all
queries saved in any category with that authorization group. 

Let us look at the example provided here…. 
Here you can see that authorization groups 1 and 2 are assigned to the category 
called Sales. Authorization groups 2 and 3 are assigned to the category called 
Marketing, and authorization group 4 to the category Purchasing.g, g p g y g
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Users Bill and Donna  are assigned to authorization group 1.

Users Sophie and Tim are assigned to authorization group 2.

So, Bill and Donna can run all queries saved in the Sales category through its 
association with authorization group 1. Sophie and Tim can run all queries saved 
in both the Sales and the Marketing categories through the association with 
authorization group 2authorization group 2.

If you want to make saved queries available to end users, you need to carefully 
plan the categories and the authorization groups to ensure that users get 
authorization only to the correct reports. 

Note: You can assign full or read-only authorization to a user, as desired. You can 
also use general authorizations to define which users can create new queries andalso use general authorizations to define which users can create new queries, and 
which users can modify the existing SQL syntax in a saved query.
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Here are some key points to take away from this session. Please take a minute to 
review these key points:

• SQL queries can be used with customization tools,  to produce ad hoc reports, 
as the first step to design a more complicated report,  and to validate migrated 
data by reporting the contents of tables.

• System information can help identify table and field names or item and column• System information can help identify table and field names, or item and column 
numbers. Use the View > System information command to enable the system 
information display.

• Two tools exist to help you create SQL queries – the Query Wizard and the 
Query Generator. Try both tools to see which you prefer.

• You can save queries as user queries and organize them by category.

• Users need authorization to run saved user queries First you select anUsers need authorization to run saved user queries. First you select an 
authorization group for the category in which the query was saved, then assign 
to the user the general authorization for the category’s authorization group.
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Welcome to the topic on User-Defined Fields and User-Defined Tables.

© SAP AG 291 TB1200



On completion of this topic, you will be able to add your own fields and tables to 
objects in SAP Business One. You will also learn to add user-defined values to 
these user defined fields.
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Additional fields are often added to master data and documents to implement a 
customer’s business process. Here are two business requirements that can be 
implemented with user-defined fields. 

• There is a need to track a status level for each customer – gold, silver, and 
bronze. You can add a user-defined field to the customer master data to hold 
and track the status value. 

• Additionally, the salesperson needs to record the customer’s preferred delivery 
time when processing a sales order. You can add a user-defined field to the 
sales order document, and record the delivery time in this field. 
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In the first part of this topic, we will cover user-defined fields.
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You can add new fields to most business objects, including business partner and 
item master data, and marketing documents. 

Only authorized users can add user-defined fields. The general authorization is 
located in the authorizations window by navigating to Customization Tools > User-
Defined Fields – Management. 
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User-defined fields are frequently added to marketing documents. You can add 
fields to both the header (title) and rows of marketing documents.

When you add a user-defined field to the marketing documents object, the new 
field is added to all logistics document types, including all sales and purchasing 
document types, and some inventory documents such as Goods Receipt and 
Goods Issue. 
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When you add user-defined fields (UDFs) at the header level, the new fields 
appear in a separate window positioned by default to the right of the existing 
document window. 

This window is not visible immediately. To open this window, choose View > User-
Defined Fields from the top menu bar, or use the key sequence Ctrl+Shift+U. You 
can reposition this window to the left or bottom of the existing window.p g

If the fields are not required in a specific document type, you can keep the new 
window invisible.
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When you add a field at the row level, the system adds this field as an additional 
column in the row. The field is visible and active by default. 

You can make the user-defined field invisible or inactive by using the standard 
form settings for the document row. 
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User-defined fields are added to the respective database table for the object. They 
can be quickly identified in the table, since they have the prefix “U_”. 

User-defined fields are retained during an upgrade to a new release. When you 
create a new company, you have the option to copy user-defined fields from the 
current company to the new company.

An important point about user defined fields is that when you add a new field to anAn important point about user-defined fields is that when you add a new field to an 
object, the new field is added to all instances of the object, including records 
already saved in the database.

UDFs function as normal fields and can therefore be used in queries and reports. 

You can also import data into user-defined fields using the Data Transfer 
Workbench. In the DTW template, simply add these fields at the end of the 
spreadsheet. Enter the name of the field in the header row and enter the value as p
you would for a standard field.
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It is important to remember that, when you add a user-defined field, the database 
structure is updated. Therefore you should only add new fields when no other 
users are logged in.

If you try to add a new field, the system will warn you if there are logged in users. 
You have the option to:

• Try Again you can notify the users close their work and wait until they have• Try Again – you can notify the users close their work and wait until they have 
logged out of the system

• Ignore - the system will force close all open documents for all connected users 
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You can select a Type and optionally a Structure for each user-defined field. The 
Structure is dependent on the Type and influences the format of the field. 

Be aware that you cannot change the type and structure after you have added the 
field. If you mistakenly choose the wrong type or structure, you can remove the 
field, and start again.
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Fields with Alphanumeric  type can have one of the structures shown here. A 
Regular structure can hold up to a maximum of 254 characters. A Text structure 
can accommodate 2 GB of text in header fields and 255 KB of text in row fields. 
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Fields with Numeric type can only hold integers, therefore there is no structure.
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Fields selected with the Date/Time type can have Date or Hour  as the structure. 

These fields behave in exactly the same way as other date and time fields in the 
system; for example, the calendar icon is available in a field with the date 
structure. 
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To enter fractions as well as integer numbers in the new field, use the Units and 
Totals type and select one of the structures shown here.

Decimal places will display in the new field according to the initialization settings 
on the Display tab of the General Settings.
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If you select the General type, the new field can hold links or graphics.

• Fields with the Link structure can link to a file or to a web address. You must 
first define the default path to the Attachments folder. This is done in the 
General Settings. This default path is opened when the user double-clicks the 
new field. The user can either select a file from the default folder, or enter a 
web address in place of the file name.  p

• Fields with the Image structure can accommodate pictures. You must first 
define the default path to the Pictures folder, in the General Settings.  If this 
default path is not defined, an error will occur when the image field is used. 
When the user double-clicks the image field, the default folder opens, enabling 
them to select an image file. The user can then change to a different folder to 
locate the image. 

Th t ti h i b dd b i th Ct lThe user can, at any time, change an image or web address by pressing the Ctrl 
key and double-clicking the image or web address.
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You have the option of defining a list of values for the user-defined field. 

In the example, you can see that three values have been supplied for the field –
gold, silver, and bronze. 

This list is available in the document as a dropdown list, allowing the user to select 
one of the values. 

The user cannot update the values in the list. The list values can only be updated p y p
by the authorized user from the User-Defined Fields – Management window.

Note that you can  also add a query as user-defined values  to a user-defined 
field. The query can populate the field based on the result of the query. This 
functionality is covered in the next topic.
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You can optionally set a default value for any user-defined field. 

In the example, we have selected Bronze (value 3) as the default from the list of 
valid values.

The default value set for a field will appear in all new instances of the object.
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You can make the user-defined field mandatory. The user will not be able to add a 
new record without entering data into the mandatory field.

When you set a user-defined field as mandatory, you need to initially supply a 
default value, to maintain the integrity of the database. However, if you are 
working with release 8.82 and later, you can afterwards update the user-defined 
field and remove the default value. 

If t d fi d fi ld d t d th fi ld l d h d f lt lIf you set a user-defined field mandatory, and the field already has a default value, 
you can choose whether to insert the default value into all existing instances of the 
object, or whether to only insert the default value into new instances.
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When using the Copy To/ Copy From function to generate a new document from a 
base document, the value of a user-defined field is transferred to the target 
document. This also applies to documents generated through the Document 
Generation Wizard. 

If multiple base documents are copied to a target document, and the user-defined 
field has different values in these base documents, the field value is not copied., p

© SAP AG 310 TB1200



Sometimes user-defined fields may not be relevant for every document type; for 
example, a field in a sales order may not be relevant in a purchase order. 

Users can manage the display of user-defined fields when they process 
documents using the settings window. The settings window is different to the 
standard form settings window, but works in a similar way. To open the settings 
window for user-defined fields, press Ctrl+Shift+B, or choose Tools > , p ,
Customization Tools > Settings. 
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Using the settings window, users can:

• Define new categories to group related fields and display them in a document 
type by selecting the category. The user can choose to display fields for a 
single category or can choose to display all categories.

• Make fields invisible or inactive for a document type. For example, you can 
make all the fields relevant for a sales order invisible in a purchase ordermake all the fields relevant for a sales order invisible in a purchase order 
document type.

• Change the display order of the fields by setting the numerical order. In this 
way, the most frequently used fields can be sorted to the top, for ease of use. 
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In the last part of this topic, we will cover user-defined tables.
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In addition to user-defined fields, you can add new tables to the database. User-
defined tables (UDTs) give you the ability to store additional, related sets of data. 

The user-defined table becomes part of the company database. The system 
identifies user-defined tables by the ‘@’ prefix so you can easily distinguish them 
from system tables. In our example, the table is called @TRUCKS.

Information about each new table is stored in the OUTB system tableInformation about each new table is stored in the OUTB system table. 

When you create a new company, you have the option to copy user-defined tables 
from the currently selected company to the new company.

To set up a user table, you enter a name and description. Here we have created a 
new table to hold information about a set of delivery vehicles that the company 
owns We want to record details such as the vehicle registration number modelowns. We want to record details such as the vehicle registration number, model, 
and capacity. The object type is not relevant for user tables; it is only relevant 
when creating user-defined objects using the Software Development Kit. You 
should leave the selection as No Object, since you cannot change the object type 
after you have added the user table.
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You access a new user-defined table by selecting the table from the Tools > User-
Defined Windows menu bar.

• The table is initially created with two columns, code and name. 

• You can enter data in these two columns. These fields are used as the primary 
key, so must be unique for each row that you add to the table.

At thi i t th d fi d t bl i t tt h d t f d tAt this point, the user-defined table is not attached to any form or document; 
however, you can use the table in queries, and you can import data into the table 
using the Data Transfer Workbench.
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To make a user table directly visible to users in a form or document, you can link 
the table to a user-defined field in the document or form.

Note that user tables can only be linked to UDFs with the Alphanumeric type and 
Regular structure. 

Choose Tools > Customization Tools > User-Defined Fields – Management and 
choose the Set Linked Table checkbox for the field Then select the user definedchoose the Set Linked Table checkbox for the field. Then select the user-defined 
table.

You can link the same user-defined table to multiple user-defined fields in different 
objects, at both the header and the row level. For example, you could link the 
trucks table to a user-defined field in the pick list document in addition to the 
delivery document.y
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The table displays as a list of values in the form or document, where only the first 
two columns are visible.

The user has the ability to dynamically add new rows to the table using the “Define 
New” option. The user can view and populate all columns in the table. 
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You can add columns to a user-defined table from the User-Defined Fields –
Management window.

The extra columns are first added as a user-defined field. Select the table under 
the User Tables object and choose Add.

In the example, we have added three additonal columns – Capacity, Make, and 
Model to the Delivery Vehicles tableModel, to the Delivery Vehicles table.
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You can now enter data for the new columns. Choose Tools > User-Defined 
Windows and select the table. Alternately you can open the table from the linked 
UDF in a document or form.

If the new columns are not visible in the window, you may need to adjust the width 
of the columns to bring the new fields into view.

The data in the table can be used to manually assign a delivery truck in aThe data in the table can be used to manually assign a delivery truck in a 
document, or a query can be written to assign a truck with the capacity to hold the 
delivery items.
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The default key for a user-defined table is the combination of the first two columns 
– column and name. In addition, you can select any field or combination of fields 
from the user table as a new key. This option allows the system to conduct a 
faster search using this field in queries.

You can optionally make the key unique. This enforces the unique constraint and 
prevents a new row being added with a field that has a duplicate value.p g p
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Here are some points to take away regarding user-defined fields and tables:

• You can add user-defined fields to most objects, at either the header level or 
the row level.

• User-defined fields are added to the table for the selected object, and have 
prefix “U_”.

• User-defined fields added at the header level will show in a separate window to 
the side of the document. You can use the View menu to open this window. 

• You can manage multiple user-defined fields at the header level using the 
settings window. This allows you to assign categories, set fields as invisible, 
and reorder the sequence.

• User-defined fields can have various types and structures such asUser-defined fields can have various types and structures, such as 
alphanumeric and regular. The choice of structure affects the maximum field 
length and the type of data you can enter in the field.

• You can optionally add a list of valid values to a UDF, or set a default value, or 
make the UDF mandatory

• You can create user-defined tables to the database. These tables can hold 
additional related information User defined tables can be identified with theadditional, related information. User-defined tables can be identified with the 
prefix “@”.

• To make a user table available in a document or form, link the table to a UDF in 
the document or form. 
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Welcome to the topic on User-Defined Values.
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On completion of this topic, you will be able to add user-defined values to form 
fields to automate data entry in forms and documents. You will learn how to add a 
list of values as user-defined values, and how to use a query as user-defined 
values.
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Here are two examples of requirements that can be met by adding user-defined 
values to form fields:

• In the first example, the company wants to have the delivery date, which is a 
mandatory field, automatically calculated in sales orders, so that the 
salesperson does not have to manually enter the date. In the business process 
the delivery date is not used, since sales orders are dispatched immediately for y , p y
delivery.

• In the second example, the salesperson needs the ability to instantly view a 
customer’s up-to-date account balance when processing a new sales order 
over the phone. With user-defined values, the salesperson does not have to 
manually drill-down to the master data. 
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You can add UDVs to any editable header field in documents and forms, to row 
level fields in documents and forms, and to user-defined fields added to objects 
such as documents and master data.

User-defined values can assist and automate data entry for users.

If added at the row level, user-defined values apply to each row.

U d fi d l b dd d t fi ldUser-defined values can be added to a field as:

• List of values. The user chooses from a list of predefined values for the field. 

• User query. When the query runs, the query results are stored in the field. In 
the example, a query has been added to the delivery date field.  The query will 
calculate a valid date for the delivery. Using a query is the most flexible option 
as the query can be set up to run manually or automatically:
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A magnifying glass icon indicates that user-defined values have been added to the 
field. 

Users can toggle the display of this icon on and off, using the menu View > 
Pickers Display > User-Defined Values.

In the example, we can see that user-defined values have been added to the 
Delivery Date field and to a user defined field in the document headerDelivery Date field, and to a user-defined field in the document header.
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To add user-defined values to a field, select the field in the document or form and 
press the key combination Alt+Shift+F2, or choose the menu path Tools > 
Customization Tools > User-Defined Values - Setup. 

Only authorized users can add UDVs. The authorization is located in the General 
Authorizations window by navigating to Customization Tools > User-Defined 
Values – Setup.p
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In the setup window for user-defined values, you select one of three options.

The first option, Without search in user-defined values, can be used to remove 
previously added user-defined values from the field.

There are no restrictions on removing user-defined values from a field. After you 
remove the user-defined values, documents saved in the system retain the values 
enteredentered. 
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The second option, Search in existing user-defined values, allows you to define a 
list of values for the field.

When defining the values, make sure that the value does not exceed the field 
length as defined in the database.
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To select from the list of values, the user can select the magnifying glass indicator 
or press Shift+F2 in the field.

The list of values can be maintained directly by the user, and the user can add 
new values to the list by choosing New. Note: this contrasts to a list of values 
added for a user defined field using the User Defined Fields Managementadded for a user-defined field using the User-Defined Fields – Management 
window. In this case, the user cannot add new values to the list and the list is 
maintained from the User-Defined Fields – Management window.
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The last option, Search in existing user-defined values according to saved query, 
lets you attach a query to the field. 

This option is very powerful, since the field is populated with the results of the 
query. 

The query can set a value in the field, or store the results of a calculation in the 
field or fetch another field value from the database to go in the fieldfield, or fetch another field value from the database to go in the field.

The query can prompt the user for a parameter, and use the parameter to 
calculate the results. 

In the example shown here, you can use a query to calculate the delivery date 
based on the current date. The query adds 7 days to the current date and stores 
the result as the delivery date.

When you use a query make sure the query result matches the field type in theWhen you use a query, make sure the query result matches the field type in the 
document, and does not exceed the size of the field. For example, do not return 
an alphanumeric string result into a field that is defined as numeric.
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In many situations,  the query needs to reference a field in the active window. In 
the example shown, you have added user-defined values to a field in the sales 
order. The query will fetch the customer’s account balance from the master data 
record and show the balance in the sales order field. The sales order is the active 
window because the user is working on it.

The query matches the CardCode from the active window to the CardCode in the 
master data.

Whenever you refer to a field in the active window, you must include a $ sign in 
front of the field name to reference the active window. Fields that are stored in the 
database, such as the balance field from the master data record, do not need the 
$ sign. 

© SAP AG 333 TB1200



To test a query that references the active window, keep the document as the 
active window and run the query by choosing Tools > Queries > User Queries 
then select the category and query name from the menu.
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When you select the option to use a query as user-defined values, you can decide 
if you want the query to automatically run without user involvement.

The Auto Refresh When Field Changes checkbox determines if the query runs 
automatically.

If you do not select this checkbox, the query is not automatic and only runs when 
the user clicks the magnifying glass or presses Shift+F2 in the fieldthe user clicks the magnifying glass or presses Shift+F2 in the field.
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If you select the Auto Refresh When Field Changes checkbox,  you are prompted 
to select a dependent field. The query runs automatically when the dependent 
field changes in value or the user enters a value in the dependent field.  
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Here is an example to illustrate how the auto refresh function works.

A query is added to a field in the sales order using user-defined values. The 
Customer/Vendor Code is selected as the dependent field. When the user selects 
the business partner code in a sales order, this action triggers the query to run. 

This is typically the first action when a user processes a new marketing document. 
Therefore it is a common practice to use the Customer/Vendor Code as aTherefore it is a common practice to use the Customer/Vendor Code as a 
dependent field to trigger the query to run.
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There are two rules for selecting dependent fields.

For a query added to a header field in a document, you can only select another 
header field as the dependent field. This includes all fields in the document that 
are not in the row table. 
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For a query added to a row-level field, you can select either a header or a row-
level field as the dependent field. 

To select a header field as the dependent field, select When Field Changes from 
the dropdown list.

To select another row-level field as the dependent field, select When Exiting 
Altered Column from the dropdown listAltered Column from the dropdown list.
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Note that, when you add user-defined values to a specific marketing document 
type, such as a sales order, other similar document types such as deliveries and 
invoices are unaffected. In other words, user-defined values behave differently to 
user-defined fields and are not inherited by other document types. Therefore you 
need to add user-defined values to each specific document type as required.

However, the value entered in a field with user-defined values is transferred to a ,
target document using the Copy To/ Copy From function.
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When you choose Auto Refresh When Field Changes, two further options appear. 
These options determine if the query runs only once, or if the query runs 
whenever the dependent field changes.

The default option is Display Saved User-Defined Values and is recommended 
since it maintains the initial result of the query. The query runs once when the 
dependent field changes, and will not run again even if the dependent field p g , g p
changes.

An example is a query added to the Delivery Date in a document. The query 
calculates a delivery date based on the system date. You only want the query to 
run once. If the query ran multiple times, the delivery date might be incorrectly 
updated.
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If you choose Refresh Regularly, the query will run each time the dependent field 
changes or is selected in a document. 

You should use this option with caution since it can result in the field value 
changing when not expected.

The query will run when you browse through records, or drill-down to open a 
document that contains a query When the query runs the document status willdocument that contains a query. When the query runs, the document status will 
change to Update mode, and you must save the changes if you want to record the 
new query results.

An example of using Refresh Regularly is a query that shows the up-to-date 
account balance of a business partner. You want the query to run whenever you 
browse or open the document so you can always see the latest balance. However, 
you will still be prompted to update the document if you want to save the query 

ltresults.
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Here are some points to take away regarding user-defined values. Please take a minute 
to review these key points:

• User-defined values (UDVs) automate data entry for users.

• You can add UDVs to editable header and row level fields, and to any user-defined 
field. To add UDVs, select the field, then press Alt+Shift+F2.

• A magnifying glass indicator shows if user-defined values exist for a field. You can ag y g g ass d cato s o s use de ed a ues e st o a e d ou ca
enable this from the View > Pickers Display menu.

• User-defined values can be set up as a list of values, or, more commonly, as a user 
query.

• If a list of values is used, the user opens the list by selecting the magnifying glass 
indicator or pressing Shift+F2 in the field.

• If a query is used, the results of the query are saved in the target field. To set the query 
to run automatically with no user involvement use the the auto refresh option andto run automatically with no user involvement,  use the the auto refresh option and 
select a dependent field. Two further options are available for running the query: 

• If you select Refresh Regularly, the query will run each time the dependent field 
changes or is selected, or when browsing records. This could lead to inconsistent 
results, depending on the query, or could cause a performance degradation when 
browsing through records.

• If you select Display Saved User-Defined Values, the query will run once and 
retain the result in the field This option is recommended since it maintains theretain the result in the field. This option is recommended since it maintains the 
initial value of the field, but the choice of this option depends on the business 
need and the query. 

• Queries should be written to reference the active window, where needed.
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Welcome to the Alerts topic.
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In this topic, we cover the alert mechanism provided in the SAP Business One 
application.

You will learn how to set up and run the two types of alerts – pre-defined alerts 
and user-defined alerts.
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Let us look at a business example for an alert. In the example shown here, the 
purchasing manager wants to be notified automatically as soon as an inventory 
item falls below a the minimum stock quantity. On receiving the notification, the 
manager can decide whether to reorder stock.

This example is a fairly simple requirement and can easily be set up using a 
predefined alert in the system.  p y

SAP Business One can also support more complex requirements with the addition 
of queries.
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• The alert mechanism in SAP Business One informs one or more users when a 
certain event or condition occurs. It is important to realize that alerts do not 
prevent the event from occurring. The alert notifies you after the event has 
happened.

• A creative use of alerts is as a task list or work order for a person. For example, 
you can create a list of new A/P invoices and send the list using an alert to theyou can create a list of new A/P invoices and send the list using an alert to the 
AP manager on a daily or weekly basis for final review.

• To receive an alert, a user must have a user account in SAP Business One.
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There are two ways to set up an alert. 

You can use one of the predefined alerts supplied with SAP Business One, or, you 
can create your own alert based on a query. 
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• The simplest way to use the alert mechanism is to use one of the predefined 
alerts. These cover common business situations where alerts are typically 
used. 

• To see the list of predefined alerts, choose Administration > Alerts 
Management, then type * in the Name field, and choose Find.

© SAP AG 350 TB1200



The deviation from gross profit, deviation from committment and credit limits, and 
discount alerts can be applied to sales documents. 
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The predefined alert for budget deviation can be applied to purchasing 
documents, payments, and journal entries. This alert is independent of the budget 
warning set in the General Settings.
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• The minimum stock deviation alert applies when a release document is added 
that takes the stock level below the minimum defined in the item master data. 
This alert is not issued if inventory blocking is enabled in the Document 
Settings. 

• The MRP alert provides a reminder when an MRP recommendation is due for 
release within a selectable time frame.release within a selectable time frame.
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• To use a predefined alert, select the names of the users you want to receive the 
notification, then select one or more preferred mechanisms for notifying each 
user.

• Internal alerts appear in the Messages/Alerts popup window in the SAP 
Business One client, and you can also view these alerts from the cockpit. 

• The email, SMS and fax mechanisms require the integration of these servicesThe email, SMS and fax mechanisms require the integration of these services 
with SAP Business One. 

• The mobile smart phone mechanism requires the SAP Business One 
integration component. 

• The email addresses and phone numbers must be set up in the user account.
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• For the predefined alerts, with the exception of minimum stock deviation, you 
can limit or expand the scope of the alert by setting conditions and selecting 
which document types will be checked for the alert situation. 

• The alert will trigger immediately after the document is added to the system.  
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• You can assign a priority to an alert. When the message is received in the 
recipient’s messages/alerts window or Microsoft Outlook window, high priority 
messages are flagged in red. 

• Finally, you must activate the alert for it to take effect, using the checkbox.  You 
can also use this checkbox to deactivate an alert at any time.
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• You can add your own alerts bases on a saved user query. To create a new 
alert, switch to Add mode and select the saved user query. 

• The query specifies the business conditions to trigger the alert. This enables 
alerts to be set for multiple conditions or for unique conditions specific to a 
business.

F l if t t l t th b d t h• For example, if you want to alert the budget manager whenever someone 
creates a purchase order with a total value above 5000, then your query will 
select purchase orders from the database with a value over 5000.
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• Then select the users and the notification mechanisms, as well as the 
notification priority, in the same way as for predefined alerts.
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• Unlike a predefined alert, a user-defined alert is not triggered when a document 
is added to the system. A user-defined alert is triggered when the query runs 
and if the conditions in the query are met. 

• Therefore you need to set the frequency for running the query (in minutes, 
hours, days, weeks or months). If you leave the frequency field empty, the alert 
is sent only once.y

• When the query runs, an alert notification will be sent to the users if the query 
conditions are met. If the query conditions are not met, a notification is not sent.
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 Internal alerts display in the user’s Messages / Alerts Overview window. If a 
query is used for the alert, the query results will show in this window.

 If you select the Save History checkbox, a new alert message is added to the 
alerts window each time the alert is triggered when the query runs. This can 
quickly fill up the alerts window if the same alert happens frequently. 

If d t h k S Hi t h kb h l t ill it th If you do not check Save History checkbox, each new alert will overwrite the 
previous one in the Messages / Alerts Overview window . The alert will change 
to bold to inform the user that a new alert has occurred. 
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• When you develop queries for alerts, you need to consider the frequency for 
running the query, and what results should be sent in the alert to the user. 

• In the example shown here, the alert is used to produce a work list for the 
following day based on new purchase orders entered the previous day. The 
query will report a list of purchase orders with total value over 5000 that have 
been posted during the current business day. 

• If the frequency is set to once a day, then the query should limit the results to 
documents added on that day. Here the document posting date is compared to 
the current date obtained using the getdate() function. 
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Here are some key points to take away from this session.

Please take a minute to review these key points: 

• Alerts send notifications to users when certain events have occurred in the 
system. Remember that alerts only notify you after the event has occurred, and 
do not prevent documents being added to the system.

S l d fi d t li d th t il dd• Several predefined events are supplied that you can easily use, or you can add 
user-defined alerts based on user queries. 

• Predefined alerts trigger when a document is added that meets the conditions 
specified in the alert.

• User-defined alerts trigger when the query runs, and then only if the query 
produces results. The query runs at the specified time interval, and the result of 
the query is sent as the alert to the usersthe query is sent as the alert to the users. 

• User-defined alerts can be used to notify users of complex or unique business 
situations.  You can also use user-defined alerts to create routine task lists for 
users.
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Welcome to the topic on approval procedures in SAP Business One.
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After completing this topic, you will be able describe the business process flow 
when an approval procedure is used, and set up a new approval process in SAP 
Business One.
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In the business scenario shown here, there is a requirement to approve expenses 
over a certain limit. These expenses should be approved by the accounting 
department.

You can use an approval procedure whenever the work procedure requires an 
approval before a user can generate certain documents, for example, purchase 
orders.

If the value of the expense document exceeds the limit, the approval procedure 
will block the document until it is approved.
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Let us look at the workflow for an approval procedure:

• The person who creates the document is the originator.

• When the originator adds a document to the system, the system checks if there 
are any approval conditions. 

• If the document meets the condition for an approval, the originator is notified 
th t th d t i lthat the document requires approval.

• The system saves the document as a draft, allowing the user to continue 
working on other documents. 
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The approval process is launched:

• Immediately an internal request is sent to the first approval stage. This request 
appears in the Messages/Alerts Overview window and the approver can view 
the document. If the mobile application is integrated, approvals can be done 
from a mobile phone.

• If the approver rejects the document an internal message goes back to the• If the approver rejects the document, an internal message goes back to the 
originator with a link to the rejected document. 

• The originator can generate an amended document, and if the approval 
condition is no longer met, the document can be added to the system. If the 
approval condition is still met, another approval procedure will start.
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If the document is approved at the first approval stage, the approval process 
continues:

• An approval request is sent to the next approval stage (if applicable). 

• If the document is approved at the final approval stage, an internal message 
goes back to the originator with a link to the draft document. The originator can 
now add the documentnow add the document. 

This is an example of a fairly straightforward approval procedure. In real life, 
approval procedures can be more complex, requiring multiple conditions to be 
checked, and more layers of approval.
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To set up an approval procedure, you need to:

1. Activate the approval process in the system. To do this, choose Administration
> System Initialization >General Settings. Choose the BP tab and select the 
Activate Approval Procedures checkbox.

2. Define one or more approval stages.

3 C t l t l t3. Create an approval template.

© SAP AG 369 TB1200



An approval stage is a list of users who can approve the document at the same
approval level. 

All approvers must first be defined as users in SAP Business One.

In our scenario, we have two purchasing users who can approve a purchasing 
document before it goes for final approval to the purchasing manager, but we only 
need an approval from one of themneed an approval from one of them. 

Therefore two authorizing users have been defined for the first stage, but only one 
approval is required to allow the process to move on to the next stage. Either user 
can approve it. This allows the approval process to move on in case of holidays 
and staff absences.

At the second (and final stage) we have defined one approver – the purchasing 
manager who is the final approver. Note that this can be a bottleneck if the g pp
purchasing manger is absent, therefore ideally you would include another user at 
this stage.
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An approval template models the business requirements to implement an approval 
process. The approval template combines four elements that define the process: 
originators of the documents, the names of the approvers at each stage, the 
documents subject to approval, and the document conditions that require and 
approval. Therefore you must define the approval stages first before you can 
include them in the approval template.

You can define an approval template that relates to a specific document type, or 
you can define a template that can apply to multiple document types with similar 
conditions for approval.
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On the Originators tab, select the users who create the documents that need 
approval. All originators must be first defined as users in SAP Business One.

Only users specified here are subject to an approval process.

The system prevents a user from modifying a template if they are selected as an 
originator in the template.
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In the Documents tab, you select the document types for approval. The approval 
process will apply to every document type that is selected here.

Both sales and purchasing document types can be selected in one template; 
however, when you add stages to the template the named approvers will be 
identical for all the documents. Therefore if you need different approvers for sales 
and purchasing documents, use separate approval templates so you can include p g , p pp p y
different approvers in each template.

The system will not allow you to select sales and purchasing document types with 
inventory or payment document types in the same template. You will need to 
create additional templates for these document types.
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In the Stages tab, you include one or more of the predefined stages in the 
template.

The sequence that the stages are listed in the template becomes the order for a 
multi-level approval process.

You can rearrange the sequence using the up and down arrows.
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In the Terms tab, you set the conditions for the approval. You have three options:

• You can choose to apply no terms or conditions to the selected document 
types. The selected document types will always be subject to approval.

• You can choose a predefined term. The predefined terms available in the 
template depend on the document types selected, but they cover common 
situations such as a quantity or a total that exceeds a stated amount In thissituations, such as a quantity or a total that exceeds a stated amount. In this 
example, we have specified the condition that the document total must be over 
5000.

• You can choose to add your own conditions using a user query. This allows you 
to model more complex approval processes.
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When using a predefined term, you can select an operator such as “greater than” 
or “equal”, and enter a value for comparison.

You can also select “In range” or “Not in range” as the ratio, and enter two values 
for the range, from low to high, separated by a hyphen.

Note that an approval procedure will apply if just one of the predefined terms is 
met In the example shown here that means if the total amount of the document ismet. In the example shown here, that means if the total amount of the document is 
greater than 5000, or the quantity is between 5 and 200. 
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You can use queries as the terms for an approval procedure. This allows you to 
develop customized approval scenarios.

You can use a query instead of the predefined terms, or you can combine 
predefined terms with a query. 

Be aware that the approval process will start if just one of the conditions is met. In 
other words the conditions are evaluated using OR logicother words, the conditions are evaluated using OR logic.

If you need multiple conditions to be met, use a query instead of predefined terms 
and write the query conditions linked with the AND operator.
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When you use a query in an approval procedure, the query must use the SELECT 
DISTINCT ‘TRUE’ clause, so that the result is a TRUE statement if the conditions 
of the query are met. A TRUE statement will trigger an approval procedure; a 
FALSE statement will not.

An example is shown above, where two conditions must be met for an approval -
the customer account balance is over 10,000 and the order total is higher than , g
2500. The query will select from the sales order table ORDR and the business 
partner master data OCRD.
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When you write a query for an approval procedure, you will need to reference the 
current document in the active window. The active window is the one the originator 
is working in. This is in contrast to standard queries where you select information 
from the database.

To refer to a field in the active window, you must include a $ sign in front of the 
field.

In the query shown here, a $ sign is used with the CardCode and DocTotal fields 
in the active sales document.

The $ sign is not needed for fields that are stored in the database, such as the 
balance field from the master data record. 

Note that you can only use this query for sales orders, since the table and field 
name used here are unique to the sales order table ORDR.q
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If you use a query in an approval template with multiple document types selected, 
you must write the query using the item and column number syntax. This syntax 
allows you to use the same query across multiple document types. 

To find the item and column number for a field, choose View > System Information 
and move your mouse over the field in the active document.

The item number for a field is common across all document types that have theThe item number for a field is common across all document types that have the 
same structure, such as sales and purchasing documents. In these documents, 
the item and column numbers are the same, but the table names are different. In 
the example shown here, the item number for CardCode is 4 and the item number 
for DocTotal is 29. 

To use the item number syntax, add a second $ sign in front of the item number, 
within the brackets, to indicate that the item syntax is used. The column number is
l 0 i l d i i th l f t fi ld ialways 0 in approval procedure queries, since the query can only refer to fields in 

the header of a document. 

The item number query syntax returns a string value. Therefore if you need the result in a 
different format, you need to specify the format in the last part of the syntax:

 If set to 0, the field is retrieved as a string. This is the default.

 If set to number, the field is retrieved as a number and can be used in calculations.

 If set to currency only the currency symbol is retrieved from a field that contains both an If set to currency, only the currency symbol is retrieved from a field that contains both an 
amount and the currency symbol.

 If set to date, the field is retrieved as a date field for date calculations.
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To test the syntax of a query that refers to the active window, create a document 
that meets the conditions. Keep this document in the active window and run the 
query from the Tools menu. The query will return a true or false result.
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When you specify multiple approvers at the same stage, they have equal 
authorization level. 

You need to consider the effect of multiple approvers at the same stage.

In this example, the minimum required number of approvers is 1.

One of the approvers approves the document. Later on, another approver rejects 
th d tthe same document. 

But this rejection has no effect if it happens after the first approval. Since only one 
approval is required, the document is approved and can be added to the system.
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In the second scenario, one of the approvers rejects the document. The document 
is held as pending until the other approvers respond.

If all the approvers reject the document, the originator is alerted that the document 
has been rejected. 

But if another approver approves the document, and the minimum number of 
required approvers is reached then the document is approved and therequired approvers is reached, then the document is approved and the 
originator can add the document to the system.
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Imagine you are the originator of a document that needs approval; however you 
have not had a response back from the approvers. You can see the document’s 
approval status using the Approval Status Report.

You, or the approver, can cancel the approval request for the document by 
selecting the row in the report, and choosing Cancel from the Data menu. 

The status in the report can show one of the following values:The status in the report can show one of the following values:

 Pending – The document is waiting for approval.

 Approved – The document is approved and converted from a draft to a regular 
document.

 Rejected – The document was not approved and remains a draft.

 Cancelled – An approval procedure was cancelled from the Approval Status 
R t I thi th d ft d t t b t d t lReport. In this case, the draft document cannot be converted to a regular 
document. This status is also reflected in the document itself.

If you are an approver, you can use the Approval Decision Report to see all 
documents that require your approval.

Using this report you can directly approve or reject multiple documents at the 
same time.
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Here are some key points to take away from this course. Please take a minute to 
review these key points:

• To set up an approval procedure, you first activate approval procedures in the 
General Settings, then define approval stages and create approval templates.

• To create a multi-level approval procedure, combine multiple predefined stages 
in the approval templatein the approval template.

• You can set conditions for an approval procedure:

 If you choose “always”, the procedure will start for every document type 
selected in the template.

 You can select a predefined condition, or,

 Add your own user query containing the conditions.

• When you use a query in an approval template, you must write the query to 
return a true or false result. 

• If the query only needs to reference a specific document type, you can use the 
table and field name syntax. To reference fields in the active window, include a 
$ sign in front of the square brackets.

• If the query needs to work with multiple document types with the same 
structure, use the item and column number syntax and include an additional $
sign within the square brackets.  
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Customization Tools: Exercises 

 

 

 

Unit: Customization Tools 

Topic: Queries 

 

 
Note: the solutions are shown for the Query Generator only. Try 
using the Query Wizard as well to see which tool you prefer. 

 
 

 

 

1-1 Customer List 

This report displays a list of customers and addresses from the OCRD Business Partners 
table. 

Choose Tools  Queries  Query Generator. 

Enter the table name OCRD. 

Double-click to select the following fields from the OCRD table. Tip: To see the table 
fields listed alphabetically, double-click the column header Name. 

 CardCode  

 CardName  

 Address  

 City (Bill-to city) 

 ZipCode  

 CntctPrsn 

 

Create the following condition in the Where clause: 

T0.[CardType] = ‘C’ 

 

Run the query. 

 

Double-click the BP Name column in the header row to sort the customers 
alphabetically. 

Save the query with the name Direct Shipment in a new category called Marketing. 

 

Note: To run this saved query, choose Tools  Queries  User Queries  Marketing 
 Direct Shipment. 
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1-2 Invoice list  

This report displays a list of customer invoices posted after a certain date that is entered 
as a parameter when the query is run. The report uses the OINV invoice table.  

Open a blank A/R invoice and use system information to write down the field names for 
the report: 

Name in Document Database Field Name 

Document No.  

Customer  

Name  

Posting Date  

Total DocTotal 

 

Note: The Total field does not display in system information. This is because this field 
holds the currency symbol as well as the amount. The database field name is DocTotal. 

In the Query Generator window, choose the X button to clear out the previous table 
selection. 

Enter the OINV table. 

Select the fields from the OINV table that you identified using system information. 

In the Where clause you will use the variable [%0] to prompt the user to enter a date 
when running the query: 

 Select the Document Date field to go in the Where clause 

 Choose the Conditions button 

 Double-click the Greater or Equal condition to select it for the query 

 Double-click the variable [%0] to select it for the query 

 Add a filter for invoices that are open (that is, DocStatus = ‘O’) 

The Where clause should read: 

T0. [Docdate] >= [%0] and T0.[DocStatus] = ‘O’ 

Run the query. 

Enter a posting date when prompted. 

To display the column total, choose CRTL and double-click the Document Total column 
heading. 

Save this query with the name ‘Invoice List’ in a new Category called Sales. 
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1-3 List of Open Sales Quotations 

This query will use the following tables: 

 Sales Quotation (OQUT) 

 Sales Quotation rows (QUT1) 

 Sales Employee table (OSLP) 

Select the tables OQUT, OSLP and QUT1 in the Table column. 

Select SlpCode, CardCode ,and CardName from the OQUT table. 

Select the SlpName field from the OSLP table. 

Select ItemCode, Dscription and LineTotal from the QUT1 table. 

Tip: Double-click the Name heading to sort the field names alphabetically. 

Enter the following condition in the Where clause so that only open quotations are used: 
Table OQUT, Field DocStatus, Condition equal, Field/Value ‘O’  

Click in the Sort by clause select the SlpCode field so that the results are displayed in 
sales employee order. 

Run the query. 

Save the query in the Sales category with the name ‘Open quotations’. 

 

1-4 Optional exercise: List of Open Sales Quotations (Crystal Reports) 

Repeat the previous query using Crystal Reports. 

Note: You need to have installed SAP Crystal Reports for SAP Business One and the 
integration with SAP Business One. 
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Customization Tools: Solutions 

 

 

Unit: Customization Tools 

Topic: Queries 

 

 

Note: the solutions are shown for the Query Generator only. Try using the Query Wizard as 
well to see which tool you prefer. 

 

1-1 Customer List 

This report displays a list of customers and addreses from the OCRD Business Partners 
table. 

Choose Tools  Queries  Query Generator. 

Type OCRD in the highlighted field at the top left of the window, then press Tab. 

Double-click to select the following table fields. Tip: Double-click the column header 
Name to see the table fields listed alphabetically: 

 CardCode  

 CardName  

 Address  

 City (Bill-to city) 

 ZipCode  

 CntctPrsn 

Create the following condition so that the system displays only customer master records: 

Click in the Where area on the right. 

Double-click to select the CardType field.  

Type = ‘C’ to complete the Where clause. 

The Where clause should now read: T0.[CardType] = ‘C’ 

Choose Execute. 

Double-click the BP Name column in the header row to sort the customers 
alphabetically. 

Save the query so you can run it again: 

In the Query Preview window, choose Save. 

In the Save Query window, choose Manage Categories. 

Enter Marketing in the Category Name field. 

Choose Select All. 

Choose Add. 

Choose OK. 

In the Save Query window, select the Marketing category. 

Enter Direct Shipment in the Query Name field. 

Choose Save. 

Note: To run this saved query, choose Tools  Queries  User Queries  
Marketing  Direct Shipment. 
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1-2 Invoice list  

This report displays a list of customer invoices posted after a certain date that is entered 
as a parameter when the query is run. The report uses the OINV invoice table.  

To find out the field names for the report, you can use system information: 

 Open up a blank A/R invoice document and toggle on View > System Information. 

 Hold your mouse over the following fields and write down the database field name 
that shows in the system information area: 

Name in Document Database Field Name 

Document No.  

Customer  

Name  

Posting Date  

Total DocTotal 

Note: When you hold your mouse over the Total field, the field name does not display in 
system information. This is because this field holds the currency symbol as well as the 
amount. The database field name is DocTotal. 

In the Query Generator window, choose the X button to clear out the previous table 
selection. If you closed the Query Generator window, choose Tools  Queries  
Query Generator. 

Type OINV in the Table field and press Tab. 

Select the fields from the OINV table that you identified using system information. 

In the Where clause you will use the variable [%0] to prompt the user to enter a date 
when running the query: 

Click in the Where clause and create the conditions to filter the data: 

Choose the Conditions button. A window will open to the right of the Query 
Generator window. 

Select the Document Date field 

In the Conditions window: 

 Double-click the Greater or Equal condition to select it for the query 

 Double-click the variable [%0] to select it for the query 

Type ‘and’ after the selected variable in the Where clause. 

Add a filter for invoices that are open (that is, DocStatus = ‘O’) 

The Where clause should read: 

T0. [Docdate] >= [%0] and T0.[DocStatus] = ‘O’ 

Choose Execute. 

Enter the Posting Date in the Selection Criteria window and run the query. 

The system displays the result. 

To display the column total, choose CRTL and double-click the Document Total column 
heading. 

Save this query with the name ‘Invoice List’ in a new Category called Sales. 
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1-3 List of Open Sales Quotations 

This query will use the following tables 

 Sales Quotation (OQUT) 

 Sales Quotation rows (QUT1) 

 Sales Employee table (OSLP) 

Choose Tools  Queries  Query Generator. 

Tip: If the Query Generator window is open from the last query, you can enter a new 
query from here. Choose the X button to clear out the previous table selection. 

 

Enter OQUT in the Table column and press Tab. 

Enter OSLP in the Table column and press Tab. 

Enter QUT1 in the Table column and press Tab. 

Select SlpCode, CardCode ,and CardName from the OQUT table. 

Select the SlpName field from the OSLP table. 

Select ItemCode, Dscription and LineTotal from the QUT1 table. 

Tip: Double-click the Name heading to sort the field names alphabetically. 

Enter the following condition in the Where clause so that only open quotations are used: 
Table OQUT, Field DocStatus, Condition equal, Field/Value ‘O’  

Click in the Sort by clause select the SlpCode field so that the results are displayed in 
sales employee order. 

Run the query. 

Save the query in the Sales category with the name ‘Open quotations’. 
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Customization Tools: Exercises 

 

 

 

Unit: Customization Tools 

Topic: User-Defined Fields and Tables 

 

 

1-1 Add a user-defined field with a list of values 

The customer wants to add a new field to record the status level of a customer – 
Bronze, Silver, Gold and Platinum. 

 

Choose Tools  Customization Tools  User-Defined Fields – Management. 

Add a user-defined field to the object Master Data > Business Partner > Business 
Partner. 

Enter the following data:  

Field Name or Data Type Values 

Title Level 

Description Status Level 

Type Alphanumeric 

Structure Regular 

Select Set Valid Values for Field. 

Choose New and enter the following data:  

Value Description Then Choose 

B Bronze New 

S Silver New 

G Gold New 

P Platinum New 

Choose Add. 

Choose Yes to the system message. 

Open an existing customer master data record. 

Open the side panel to show the user-defined fields. 

Open the dropdown list to see the status levels in the new field. 

Select a level and update the master data record. 

Note: If you set a default value for the new field, the default value will appear in 
new master data records but not existing master data records. 
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1-2  Add a user-defined field to the document row level 

The customer wants to add a new field to hold special instructions for picking an 
item in the warehouse. 

1-2-1 Add a user-defined field 

Add a user-defined field to the object Inventory > Pick List - Rows. 

Enter the following data:  

Field Name or Data Type Values 

Title Instructions 

Description Special Instructions 

Type Alphanumeric 

Structure Text 

 Choose Add. 

 

1-2-2 Test the user-defined field 

Create a pick list: Choose Inventory  Pick and Pack  Pick and Pack 
Manager. Select relevant sales orders for picking. 

Find the created pick list: Choose Inventory  Pick and Pack  Pick List. 

Scroll to the right of the item row to see the new field. 

You can enter freeform text in this field. 

 

1-3  Add a user-defined field for a link 

When you add a new sales opportunity, you want to store a link to the customer’s web 
site. 

Add a user-defined field called Link to the Title area of the Sales Opportunities object. 

Select General as the Type. 

Select Link as the Structure. 

Choose Add. 

Open a new sales opportunity. Choose Sales Opportunities  Sales Opportunity. 

Select a business partner. 

Open the side panel to display user-defined fields. 

Double-click the Link field. 

Provided that you have set the path to the Attachments folder in the General Settings, a 
window will open for you to select a file. Instead of selecting a file from the 
Attachments folder, type an address, such as www.sap.com, in the File Name field and 
choose Open. The url will be saved in the Link field. 

Double-click in the Link field to open the web site from the sales opportunity. 
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1-4  Add a User-Defined Table 

The company wants to record the source for each new customer. The list of sources is 
currently: Website, E-mail, Trade Publication, and Other. Sales staff should have the 
flexibility to add to this list when they process and order. 

In this exercise, you will create a user-defined table to store the list of sources. You will 
then link this user-defined table to a user-defined field in the master data and in sales 
orders, so that end users can add new rows to the table to record additional sources. 

1-4-1 Create a user-defined table 

Choose Tools  Customization Tools  User-Defined Tables – Setup. 

Create a table with the name Source.  

1-4-2 Enter data in the user-defined table 

Choose Tools  User-Defined Windows and select the table. Note: this menu 
option is not active until after you add the user-defined table. 

Enter data for the table: 

Code Name 

1 Website 

2 E-mail 

3 Trade 

4 Publication 

Note: You need to choose Update to enter each row in the table. 

 

1-4-3 Link the table to user-defined fields 

Choose Tools  Customization Tools  User-Defined Fields – Management. 
Open Master Data  Business Partner  Business Partner and add a user-
defined field called Source in the header area of the business partner master 
data. Leave the Type as Alphanumeric and the Structure as Regular. Do not set 
any valid values for this field. 

Choose Set Linked Table and select the Source table. 

 
Open the Marketing Documents category and add a user-defined field called 
Source to the Title area. Leave the Type as Alphanumeric and the Structure as 
Regular.  

Choose Set Linked Table and select the Source table. 

 

1-4-4 Access the user-defined table 

Open a master data record. 

Open the side panel to view user-defined fields. 

Select the Source field. 

You can select a value from the entries in the dropdown list or you can choose 
Define New to add a new row to the table. 

Open a sales order. 

You can see the same user-defined table in the Source field. 
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1-5  Add a user-defined table with additional columns 

In this exercise, you will create a table to manage the company’s fleet of delivery trucks.  

1-5-1 Create a new user-defined table 

Tools  Customization Tools  User-Defined Tables – Setup. 

Create a table with the name Trucks.  

1-5-2 Enter data in the user-defined table 

Choose Tools  User-Defined Windows and select the table.  

Enter data for the first two columns of the table.  The Code field ensures a 
unique key. 

Code Name (Registration No.) 

1 4236790 

2 1569013 

3 7895478 

 

1-5-3 Add additional columns to the user-defined table 

Add each column as a user-defined field. Choose Tools  Customization Tools 
 User-Defined Fields – Management. 

Scroll to the bottom of the window and expand the User Tables category. 

Select the row for the Trucks table and choose Add. 

Enter the following data:  

Field  Value 

Title Capacity 

Description Capacity 

Type Numeric 

Structure  

    Choose Add. 

Field  Value 

Title Make 

Description Make 

Type Alphanumeric 

Structure Regular 

Choose Add. 
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1-5-4 Enter data in the additional columns  

  Choose Tools  User-Defined Windows and select the Trucks table.  

Adjust the width of the columns to make the new columns visible in the 
window. 

Enter data into the new columns. For example: 

Capacity Make 

500 Mercedes 

750 Ford 

350 Nissan 

 

Note:  To make the Trucks table visible in a document such as a delivery, add a 
user-defined field to the Marketing Documents object, and link the Trucks 
table to this field. You can also use the table in reports and queries. 
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Customization Tools: Solutions 

 

 

Unit: Customization Tools 

Topic: User-Defined Fields and Tables 

 

 

1-1 Add a user-defined field with a list of values 

The customer wants to add a new field to record the status level of a customer – 
Bronze, Silver, Gold and Platinum. 

 

Choose Tools  Customization Tools  User-Defined Fields – Management. 

Select Master Data > Business Partner > Business Partner. 

Choose Add. 

Enter the following data:  

Field  Values 

Title Level 

Description Status Level 

Type Alphanumeric 

Structure Regular 

Select Set Valid Values for Field 

Choose New and enter the following data:  

Value Description Then Choose 

B Bronze New 

S Silver New 

G Gold New 

P Platinum New 

Choose Add. 

Choose Yes to the system message. 

Open an existing customer master data record. 

To see the new user-defined field, choose View  User-Defined Fields. 

Open the dropdown list to see the status levels. 

Select a level and update the master data record. 

 

Note: If you set a default value for the new field, the default value will appear in 
new master data records but not existing master data records. 
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1-2  Add a user-defined field to the document row level 

The customer wants to add a new field to hold special instructions for picking an 
item in the warehouse. 

1-2-1 Add a user-defined field 

Choose Tools  Customization Tools  User-Defined Fields – Management. 

Select Inventory  Pick List - Rows. 

Choose Add. 

Enter the following data:  

Field  Values 

Title Instructions 

Description Special Instructions 

Type Alphanumeric 

Structure Text 

  Choose Add. 

1-2-2 Test the user-defined field 

Create a pick list: Choose Inventory  Pick and Pack  Pick and Pack 
Manager. Select relevant sales orders for picking. 

Find the created pick list: Choose Inventory  Pick and Pack  Pick List. 

Scroll to the right of the item row to see the new field. 

You can enter freeform text in this field. 

 

1-3  Add a user-defined field for a link 

When you add a new sales opportunity, you want to store a link to the customer’s web 
site. 

Choose Tools  Customization Tools  User-Defined Fields – Management. 

Select Sales Opportunities  Title 

Enter the following data:  

Field  Values 

Title Link 

Description Link 

Type General 

Structure Link 

  Choose Add. 

 

Open a new sales opportunity. Choose Sales Opportunities  Sales Opportunity. 

Select a business partner. 

Open the side panel to display user-defined fields. Choose View  User-Defined 
Fields. 
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Double-click in the Link field. 

Provided that you have set the path to the Attachments folder in the General Settings, a 
window will open for you to select a file. Instead of selecting a file from the 
Attachments folder, type an address, such as www.sap.com, in the File Name field and 
choose Open. The url will be saved in the Link field. 

Double-click the Link field to open the web site from the sales opportunity. 

 

1-4  Add a User-Defined Table 

The company wants to record the source for each new customer. The list of sources is 
currently: Website, E-mail, Trade Publication, and Other. Sales staff should have the 
flexibility to add to this list when they process and order. 

In this exercise, you will create a user-defined table to store the list of sources. You will 
then link this user-defined table to a user-defined field in the master data and in sales 
orders, so that end users can add new rows to the table to record additional sources. 

1-4-1 Create a user-defined table 

Choose Tools  Customization Tools  User-Defined Tables – Setup. 

Create a table with the name Source.  

Choose Update. 

1-4-2 Enter data in the user-defined table 

Choose Tools  User-Defined Windows and select the table. Note: this menu 
option is not active until after you add the user-defined table. 

Enter data for the table: 

Code Name 

1 Website 

2 E-mail 

3 Trade 

4 Publication 

Note: You need to choose Update to enter each row in the table. 

Choose OK. 

1-4-3 Link the table to user-defined fields 

Choose Tools  Customization Tools  User-Defined Fields – Management. 

Open Master Data  Business Partner  Business Partner and add a user-
defined field called Source in the header area of the business partner master 
data. Leave the Type as Alphanumeric and the Structure as Regular. Do not set 
any valid values for this field. 

Choose Set Linked Table and select the Source table. 

Choose Add. 

 
Open the Marketing Documents category and add a second user-defined field 
called Source to the Title area. Leave the Type as Alphanumeric and the 
Structure as Regular.  

Choose Set Linked Table and select the Source table. 
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1-4-4 Access the user-defined table 

Open a master data record. 

Open the side panel to view user-defined fields. 

Select the Source field. 

You can select a value from the entries in the dropdown list or you can choose 
Define New to add a new row to the table. 

 

Open a sales order document. 

Open the side panel to view user-defined fields. 

You can access the Source table from the user-defined field in the panel. 

 

1-5  Add a user-defined table with additional columns 

In this exercise, you will create a table to manage the company’s fleet of delivery trucks.  

 

1-5-1 Create a new user-defined table 

Tools  Customization Tools  User-Defined Tables – Setup. 

Create a table with the name Trucks.  

Choose Update. 

 

1-5-2 Enter data in the user-defined table 

Choose Tools  User-Defined Windows and select the table.  

Enter data for the table. The Code field ensures a unique key. 

Code Name (Registration No.) 

1 4236790 

2 1569013 

3 7895478 
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1-5-3 Add additional columns to the user-defined table 

Add each column as a user-defined field.  Choose Tools  Customization 
Tools  User-Defined Fields – Management. 

Scroll to the bottom of the window and expand the User Tables category. 

Select the row for the Trucks table and choose Add. 

Enter the following data:  

Field  Value 

Title Capacity 

Description Capacity 

Type Numeric 

Structure  

    Choose Add. 

Field  Value 

Title Make 

Description Make 

Type Alphanumeric 

Structure Regular 

Choose Add. 

 

1-5-4 Enter data in the additional columns  

  Choose Tools  User-Defined Windows and select the Trucks table.  

Adjust the width of the columns to make the three new columns visible in the 
window. 

Enter data into the new columns. For example: 

Capacity Make 

500 Mercedes 

750 Ford 

350 Nissan 

 

Note:  To make the Trucks table visible in a document such as a delivery, add a 
user-defined field to the Marketing Documents object, and link the Trucks 
table to this field. You can also use the table in reports and queries. 

 

© SAP AG 405 TB1200



 

© SAP AG 406 TB1200



Customization Tools: Exercises 

 

 

 

Unit: Customization Tools 

Topic: User-Defined Values  

 

 

1-1 Add a fixed list of values to a field in a sales order  

You want to record some details about an item in a sales order. You will add user-
defined values to an existing field in the sales order row. When an item is selected for 
the order, the salesperson can select information from the list of values. 

Open a sales order. 

Using Form Settings, make the Free Text field visible and active on the row. 

Select the Free Text field and add user-defined values. 

Choose Search in Existing User-Defined Values. 

Enter Fragile, Heavy, Perishable, and Liquid-free as the values. 

Choose Update to save the user-defined values. 

Tip: A magnifying glass should appear in the field to indicate that this field has user-
defined values. If you do not see the magnifying glass, choose View  Pickers Display 
  User-Defined Values. 

Select an item to go in the sales order, and choose a value from the list defined in the 
Free Text field. 

 

1-2 Add a query as user-defined values to a field in a purchase order 

When you create a purchase order, you want to show only the items that are supplied by 
the vendor you have selected in the vendor field.  

You will create a query that displays only the items from the vendor you have selected. 
The query will select items from the items table OITM that have the same vendor set as 
the Preferred Vendor in the item master data. 

Note: In the OITM table, the field CardCode is used to store the preferred vendor. The 
variable $4.0.0 is the item number of the selected vendor code. 
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1-2-1 Check if there is a preferred vendor in the item master data. 

Choose Inventory Item Master Data. 

Locate an item for purchase. 

Choose the Purchasing tab. 

Choose the selection list icon in the Preferred Vendor field and select a vendor 
from the list. Do not choose the Browse button. 

Save the item master data. 

1-2-2 Create a database query. 

If you know the SQL for your query, you can type the query directly into the 
Query Generator window. To do this: 

Choose X to clear out the previous query, if necessary. 

Choose Execute to open the Query Preview window. 

In the Query Preview window, click the Pencil icon to activate Edit mode. 

You can now type the complete query into the Query Preview window: 

SELECT T0. ItemCode FROM OITM T0 WHERE T0.CardCode = 
$[$4.0.0]  

Note: The $ sign is used to reference the vendor code which is in the active 
window. 

Enter the query name Preferred Vendor in the Query Name field. 

Save the query in the General category. 

1-2-3 Create a Purchase Order with user-defined values from a query 

Choose Purchasing A/P  Purchase Order. 

Choose the vendor that you selected earlier. 

Position the cursor in the Item No. field. 

Add User-Defined Values to the Item No. field. 

Choose Search in Existing User-Defined Values according to Saved Query. 

Select the query you saved earlier. 

In the Item No. field, press Shift+F2. 

The query will run and will show only items for the preferred vendor. 
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1-3 Add a query as user-defined values to calculate the delivery date in a sales order  

When you create a sales order, you want the system to automatically set the Delivery 
Date to the value of the Posting Date + 7 days. The query will use the sales order table 
ORDR. 

1-3-1 Create a database query. 

Choose Tools  Queries  Query Generator. 

Type a new query as: 

SELECT $[ORDR.DocDate.DATE]+7  

Choose Save. 

Note: The syntax above only works for sales orders (table ORDR). To use the 
same query in another similar document, use the item number syntax: 

SELECT $[$10.0.DATE]+7  

Save the new query in the General category. 

1-3-2 Add the query as user-defined values to a Sales Order 

Choose Sales – A/R  Sales Order. 

Add user-defined values to the Delivery Date field. 

Choose Search in Existing User-Defined Values according to Saved Query. 

Open the query you just saved. 

Choose Auto Refresh When Field Changes. 

Choose Customer/Vendor Code from the dropdown list. 

Select Display Saved User-Defined Values. 

Choose Update. 

In the Sales Order, choose a customer. 

The system will automatically insert a Delivery Date that is 7 days later than the 
Posting Date. 

 

 1-4  Add a query as user-defined values using refresh regularly 

The company‘s sales staff needs to see the customer’s existing balance when they are 
on the phone taking a new sales order. The balance wil display in a user-defined field 
added to the sales order header. 

1-4-1 Add a user-defined field 

Add a user-defined field to the Title area of the Marketing Documents category. 

Enter the following data:  

Field Name or Data Type Values 

Title Balance 

Description Acct Balance 

Type Units and Totals 

Structure Amount 
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1-4-2 Create a query to get the business partner balance from the database 

Create the following query:  

SELECT T0.[Balance] FROM OCRD T0 WHERE T0.[CardCode] = 
$[$4.0.0]  

Save the query as Account Balance under any category. 

Note: The item number for the business partner code in all marketing documents 
is 4. 

Note: To test this query before you add it as user-defined values, follow these 
steps: 

i. Open a blank sales order. 

ii. Select a valid customer code. 

iii. With the sales order as the active window, run the query by choosing Tools 
  Queries   User Queries   Category Query name 

iv. The query preview window will show the customer’s balance. 

1-4-3 Add the query as user-defined values to the user-defined field 

Open a blank sales order. 

Open the user-defined fields panel. 

Add user-defined values to the new Balance field. 

Choose Search in Existing User-Defined Values according to Saved Query. 

Select the query you saved earlier. 

Select Auto Refresh When Field Changes. 

Select the Customer/Vendor Code field. 

Choose Refresh Regularly. 

Choose Update. 

1-4-4 Test the user-defined field 

In the open sales order, select a customer. 

When you select the customer code the query will run and the account balance 
will appear in the new field. 

Note: Although the new balance field will display in other types of marketing 
document, the user-defined values will not be added. You will need to add the 
query to each document type if required. Because the query will work across all 
document types, you can re-use the same query.  
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1-5  Add a query as user-defined values to set the discount % in a sales order  

Light & Music wants to give 5% discount on sales orders, provided there are no 
overdue payments from the customer, and the customer has placed an order previously 
during the last 6 months.  

1-5-1 Create a query 

The query will set the discount in a sales order to 5% if the count of open, due 
invoices is 0 and if there is at least one open sales order for the customer. 

If (Select count(DocNum) from OINV where CardCode = 
$[ORDR.CardCode] and DocStatus = 'O' and DocDueDate < getdate()) = 0  

 Begin 

If (Select count(DocNum) from ORDR where CardCode = 
$[ORDR.CardCode] and DocDate > dateadd(month, -6, getdate()))>0  

Select 5 

else 

Select 0 

 End 

else 

 Select 0 

 

Save the query. 

 

1-5-2 Add user-defined values to the discount field 

Add user-defined values to the discount field (DiscPrcnt) in the header of the 
sales order document. 

Select the query. 

Select Auto Refresh When Field Changes. 

Select the Customer/Vendor Code field.. 

Select Display Saved User-Defined Values. 

Choose Update. 

 

1-5-3 Test the query 

Create a sales order for a customer. 

Create a second sales order for the same customer. When you select the customer 
code, you will see the discount set to 5 % and automatically applied to the sales 
order. 
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Customization Tools: Solutions 

 

 

Unit: Customization Tools 

Topic: User-Defined Values  

 

 

1-1 Add a fixed list of values to a field in a sales order  

You want to record some details about an item in a sales order. You will add user-
defined values to an existing field in the sales order row. When an item is selected for 
the order, the salesperson can select information from the list of values. 

Choose Sales – A/R. 

Choose Sales Order. 

Choose the Form Settings icon from the toolbar. 

Select Table Format. 

Enter Free Text in the Find field. 

Select the Visible and Active checkboxes for the field. 

Choose OK. 

The Free Text field should appear in the item row. 

Select the Free Text field and add user-defined values by pressing Alt+Shift+F2. 

The User-Defined Values- Setup dialog box appears. 

Choose Search in Existing User-Defined Values. 

Choose Browse (. . .) 

Enter Fragile, Heavy, Perishable, and Liquid-free as the values. 

Choose Update after you enter each value in the list. 

Choose OK. 

Choose Update to save the user-defined values. 

Tip: A magnifying glass should appear in the field to indicate that this field has user-
defined values. If you do not see the magnifying glass, open the View menu from the top 
bar and then choose Pickers Display   User-Defined Values. 

Select an item to go in the sales order. 

Select the magnifying glass icon in the Free Text field. 

Choose a value from the list defined in the Free Text field. 

. 
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1-2 Add a query as user-defined values to a field in a purchase order. 

When you create a purchase order, you want to show only the items that are supplied by 
the vendor you have selected in the vendor field.  

You will create a query that displays only the items from the vendor you have selected. 
The query will select items from the items table OITM that have the same vendor set as 
the Preferred Vendor in the item master data. 

Note: In the OITM table, the field CardCode is used to store the preferred vendor. The 
variable $4.0.0 is the item number of the selected vendor code. 

 

1-2-1 Check if there is a preferred vendor in the item master data. 

Choose Inventory Item Master Data. 

Locate an item for purchase. 

Choose the Purchasing tab. 

Choose the selection list icon in the Preferred Vendor field and select a vendor 
from the list. Do not choose the Browse button. 

Save the item master data. 

1-2-2 Create a database query. 

If you know the SQL for your query, you can type the query directly into the 
Query Generator window. To do this: 

Choose X to clear out the previous query, if necessary. 

Choose Execute to open the Query Preview window. 

In the Query Preview window, click the Pencil icon to activate Edit mode. 

You can now type the complete query into the Query Preview window: 

SELECT T0. ItemCode FROM OITM T0 WHERE T0.CardCode = 
$[$4.0.0]  

Note: The $ sign is used to reference the vendor code which is in the active 
window. 

 

Choose Save. 

Enter the query name Preferred Vendor in the Query Name field. 

Select the General category. 

Choose Save. 

1-2-3 Create a Purchase Order with user-defined values from a query 

Choose Purchasing A/P  Purchase Order. 

Choose the vendor that you selected earlier. 

Position the cursor in the Item No. field. 

Press Alt+Shift+F2. 

The User-Defined Values - Setup dialog box appears. 

Choose Search in Existing User-Defined Values according to Saved Query. 

Choose Open Saved Query. 

Expand the General category and select the query you saved earlier. 

Choose OK. 

Choose Update. 

In the Item No. field, press Shift+F2. 

The query will run and will show only items for the preferred vendor. 
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1-3 Add a query as user-defined values to calculate the delivery date in a sales order.  

When you create a sales order, you want the system to automatically set the Delivery 
Date to the value of the Posting Date + 7 days. The query will use the sales order table 
ORDR. 

1-3-1 Create a database query. 

Choose Tools  Queries  Query Generator. 

Choose Execute. Ignore the error message. 

Type a new query as: 

SELECT $[ORDR.DocDate.DATE]+7  

Choose Save. 

Note: The syntax above only works for sales orders (table ORDR). To use the 
same query in another similar document, use the item number syntax: 

SELECT $[$10.0.DATE]+7  

Save the new query in the General category. 

1-3-2 Add the query as user-defined values to a Sales Order 

Choose Sales – A/R  Sales Order. 

Position the cursor in the Delivery Date field. 

Press Shift+Alt+F2. 

Choose Search in Existing User-Defined Values according to Saved Query. 

Choose Open Saved Query. 

Choose the query you just saved. 

Choose Auto Refresh When Field Changes. 

Choose Customer/Vendor Code from the dropdown list. 

Select Display Saved User-Defined Values. 

Choose Update. 

In the Sales Order, choose a customer. 

The system will automatically insert a Delivery Date that is 7 days later than the 
Posting Date. 
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1-4  Add a query as user-defined values using refresh regularly 

The company‘s sales staff needs to see the customer’s existing balance when they are 
on the phone taking a new sales order. The balance wil display in a user-defined field 
added to the sales order header. 

1-4-1 Add a user-defined field 

Choose Tools  Customization Tools  User-Defined Fields – Management. 

Open Marketing Documents. 

Choose Title. 

Choose Add. 

Enter the following data:  

Field Name or Data Type Values 

Title Balance 

Description Acct Balance 

Type Units and Totals 

Structure Amount 

Choose Add. 

 

1-4-2 Create a query to fetch the business partner balance from the database 

Using the Query Generator, create the following query:  

SELECT T0.[Balance] FROM OCRD T0 WHERE T0.[CardCode] = 
$[$4.0.0]  

Save the query as Account Balance under any category. 

Note: The item number for the business partner code in all marketing documents 
is 4. 

Note: To test this query before you add it as user-defined values, follow these 
steps: 

i. Open a blank sales order. 

ii. Select a valid customer code. 

iii. With the sales order as the active window, run the query by choosing Tools 
  Queries   User Queries   Category Query name 

iv. The query preview window will show the customer’s balance. 
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1-4-3 Add the query as user-defined values to the user-defined field 

Open a blank sales order. 

To open the window for user-defined fields, choose View  User-Defined 
Fields. 

Add user-defined values to the new Balance field by pressing Alt+Shift+F2. 

Choose Search in Existing User-Defined Values according to Saved Query. 

Select the query you saved earlier. 

Select Auto Refresh When Field Changes. 

Select the Customer/Vendor Code field. 

Choose Refresh Regularly. 

Choose Update. 

1-4-4 Test the user-defined field 

In the open sales order, select a customer. 

When you select the customer code the query will run and the account balance 
will appear in the new field. 

Note: Although the new balance field will display in other types of marketing 
document, the user-defined values will not be added to the field. You will need 
to add the query to each document type if required. Because the query will work 
across all document types, you can re-use the same query.  

 

1-5      Add a query as user-defined values to set the discount % in a sales order  

Light & Music wants to give 5% discount on sales orders, provided there are no 
overdue payments from the customer, and the customer has placed an order previously 
during the last 6 months.  

1-5-1 Create a query 

The query will set the discount in a sales order to 5% if the count of open, due 
invoices is 0 and if there is at least one open sales order for the customer. 

If (Select count(DocNum) from OINV where CardCode = 
$[ORDR.CardCode] and DocStatus = 'O' and DocDueDate < getdate()) = 0  

 Begin 

If (Select count(DocNum) from ORDR where CardCode = 
$[ORDR.CardCode] and DocDate > dateadd(month, -6, getdate()))>0  

Select 5 

else 

Select 0 

 End 

else 

Select 0 

 

Save the query. 
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1-5-2 Add user-defined values to the discount field 

Add user-defined values to the discount field in the header area of the sales order 
document. 

Open a sales order document. 

Position the cursor in the Discount field in the sales order header. 

Press Alt+Shift+F2. 

The User-Defined Values - Setup dialog box appears. 

Choose Search in Existing User-Defined Values according to Saved Query. 

Choose Open Saved Query. 

Select the query. 

Select Auto Refresh When Field Changes. 

Select the Customer/Vendor Code field. 

Select Display Saved User-Defined Values. 

Choose Update. 

 

1-5-3 Test the query 

Create a sales order for a customer. 

Create a second sales order for the same customer. When you select the customer 
code, you will see the discount set to 5 % and automatically applied to the sales 
order. 
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Customization Tools: Exercises 

 

 

 

Unit: Customization Tools 

Topic: Alerts Management 

 

 

1-1 Set an Alert when the Gross Profit in a Sales document falls below 30% 

The company owner wants to be notified when a sales order is issued with the gross 
profit falling below 30%. This uses one of the preconfigured alerts supplied with the 
system. 

Select the predefined alert Deviation from % of Gross Profit alert. In the Conditions tab, 
type 30 as the Profit Percentage. 

Apply to Sales Orders using the Documents tab. 

Select the Int. checkbox for the user manager. 

Select the Active checkbox. 

Choose Update. 

Create a sales order and change the Unit Price so that the Gross Profit falls below 30%. 
You can check the gross profit by opening the Gross Profit window from the sales 
order. Base the Gross Profit on the Item Cost. 

Save the sales order.  

The alerts window will open and display the alert. If the alert window does not open, 
choose Window  Messages/Alert Overview. 

Note: Choose Administration   General Settings and select the Services tab. The 
Update Messages field value determines how often the application checks the window 
for updates 
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1-2 Set an Alert for Quotations with a Document Total Greater than 15000 

A manager wants to review sales quotations issued for the day that exceed 15000. Since 
the process does not need to be blocked, this can be met using an alert based on a query. 
The query will be set to run once a day, and will show the eligible sales quotations for 
that day. 

1-2-1 Create a Query for the Alert 

Choose Tools  Queries  Query Generator. 

Enter tables OQUT and OSLP in the Table column. 

Select DocNum, CardName, and DocTotal from the OQUT table (T0). 

Select SlpName from the OSLP table (T1). 

Enter the following Where clause to display only quotations with a document 
total greater than 15000 issued on today’s date: 

 
T0.[DocTotal] > 15000 and T0.[DocDate] = (CONVERT (date, 
GETDATE())) 

 

Save the query with the name ‘Quotations > 15000’ in a new category called 
Alerts. 

1-2-2 Define the alert 

Add a user-defined alert called Quotations > 15000. 

Set the Active indicator. 

Select the query ‘Quotations > 15000’. 

Enter the frequency: For the purposes of this demo, set the frequency to every 2 
minutes instead of every 1 day. 

Set the Int. indicator for the user manager. 

Choose Add. 

1-2-3 Test the alert 

Create a sales quotation for a document total greater than 15000. The posting 
date should be today’s date. 

You will be able to add the document. 

Create a second sales quotation with a total greater than 15000 and with a 
posting date that is different from today’s date. 

You will receive an alert notification after 2 minutes. You should get an alert for 
the first quotation, but not for the second quotation. 

Note: If you do not receive an alert in 2 minutes, set the Update Messages field 
value in the Services tab of the General Settings to 0.  
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Customization Tools: Solutions 

 

 

Unit: Customization Tools 

Topic: Alerts Management 

 

 

1-1 Set an Alert when the Gross Profit in a Sales document falls below 30% 

The company owner wants to be notified when a sales order is issued with the gross 
profit falling below 30%. This uses one of the preconfigured alerts supplied with the 
system. 

Choose Administration  Alerts Management. 

The window opens in Find mode. Type * in the Name field and choose Find. 

Select the Deviation from % of Gross Profit alert. In the Conditions tab, type 30 as the 
Profit Percentage. 

Apply to Sales Orders using the Documents tab. 

Select the Int. checkbox for the user manager. 

Select the Active checkbox. 

Choose Update. 

Create a sales order and change the Unit Price so that the Gross Profit falls below 30%. 
You can check the gross profit by opening the Gross Profit window from the sales 
order. Base the Gross Profit on the Item Cost. 

Save the sales order.  

The alerts window will open and display the alert. If the alert window does not open, 
choose Window  Messages/Alert Overview. 

Note: Choose Administration   General Settings and select the Services tab. The 
Update Messages field value determines how often the application checks the window 
for updates 
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1-2 Set an Alert for Quotations with a Document Total Greater than 15000 

A manager wants to review sales quotations issued for the day that exceed 15000. Since 
the process does not need to be blocked, this can be met using an alert based on a query. 
The query will be set to run once a day, and will show the eligible sales quotations for 
that day. 

1-2-1 Create a Query for the Alert 

Choose Tools  Queries  Query Generator. 

Enter tables OQUT and OSLP in the Table column. 

Select DocNum, CardName, and DocTotal from the OQUT table (T0). 

Select SlpName from the OSLP table (T1). 

Enter the following Where clause to display only quotations with a document 
total greater than 15000 issued on today’s date: 

 
T0.[DocTotal] > 15000 and T0.[DocDate] = (CONVERT (date, 
GETDATE())) 

  

Save the query with the name ‘Quotations > 15000’ in a new category called 
Alerts. 

1-2-2 Define the alert 

Choose Administration  Alerts Management. 

Switch to Add mode. 

Enter Quotations > 15000 in the Name field. 

Set the Active indicator. 

Choose Open Saved Query. 

Select the query ‘Quotations > 15000’ in the Alerts category. 

Choose OK. 

Enter the frequency: For the purposes of this demo, set the frequency to every 2 
minutes instead of every 1 day. 

Set the Int. indicator for the user manager. 

Choose Add. 

1-2-3 Test the alert 

Create a sales quotation for a document total greater than 15000. The posting 
date should be today’s date. 

You will be able to add the document. 

Create a second sales quotation with a total greater than 15000 and with a 
posting date that is different from today’s date. 

You will receive an alert notification after 2 minutes. You should get an alert for 
the first quotation, but not for the second quotation. 

Note: If you do not receive an alert in 2 minutes, set the Update Messages field 
value in the Services tab of the General Settings to 0.  
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Customization Tools: Exercises 

 

 

 

Unit: Customization Tools 

Topic: Approval Procedures 

 

 

1-1 Activate approval procedures in the system 

Choose Administration  System Initialization  General Settings. 

Enable the approval procedures functionality in the system.  

 

1-2 Define an approval procedure using a predefined condition. 

If the discount offered in a sales document is more than 25%, the system should block 
the document until it is approved by the accounting department. 

1-2-1 Create an approval stage for manager approval. 

Choose Administration  Approval Procedures  Approval Stages. 

Field Name or Data Type Values 

Stage Name Manager 

Stage Description Manager Approvers 

No. of Approvals Required 1 

No. of Rejections Required 1 

Authorizer 1 Select the user “manager” 

Authorizer 2 Select the Accounting department then 
choose a user from the list. 
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1-2-2 Create an approval template. 

Choose Administration  Approval Procedures  Approval Templates. 

Field Name or Data Type Values 

Name Discount 25 

Description Discount over 25% 

Originator tab Select the Sales department from the 
dropdown list. Select all users in the 
Sales department.  

Note: To select all users at the same 
time, select the first row then hold the 
Shift key and select the last row. All 
rows will be selected. 

Documents tab Select all Sales – A/R documents. 

Stages tab Select the approval stage you defined 
earlier – Manager. 

 

Choose the predefined term for Discount %. 

Field Name or Data Type Values 

Ratio Greater than 

Value 25 

 

Make sure that the Active checkbox is set in the approval template. 

 

1-2-3 Test the approval process. 

Login as one of the originators (sales users) and create any sales document. Set 
the Discount field as 26%. 

Note: If you are unable to login as one of the sales users due to license 
availability, you can add the user manager to the approval template as an 
originator.  

When you Add the document, the approval window will display. Enter a 
suitable message in the Remarks field for the approval.  

Note: The sales document is now saved as a draft. You can view this document 
in the Document Drafts report. 

1-2-4 Approve the document 

An alert will appear in the approver’s Messages/Alerts Overview window.  
Select the link to view the approval request. Approve the request. You can 
optionally enter remarks for the originator. 

You can also approve the request in the Approval Decision Report. Choose 
Administration  Approval Procedures  Approval Decision Report.  
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1-2-5 Process the approved sales document 

The approved sales document will display in the originator’s Messages/Alerts 
Overview window. The document has the status Draft [Approved] and you can 
now Add it to the system. 

 

The originator can also access the approved document from the Approval Status 
Report. Choose Administration  Approval Procedures  Approval Status 
Report.  

 

1-3 Define an approval procedure based on a query. 

All service type purchase orders over 25000 must be approved first by the purchasing 
manager and then by the company owner. You will create a new approval template. 
You can use the approval stage you created in step 1-2-1. 

1-3-1 Create the query 

Paste the following query into the Query Generator  
The following query use the item and column number syntax: 

Note: This query uses the item number syntax to work with multiple 
document types and the $ syntax to reference the active window: 

The following query will work only with the purchase order document: 
T 

SELECT 'true' WHERE $[$3.0.0] = 'S' AND $[$29.0.number] > 25000 

Save the query in any category. 

To test the query, open a blank purchase order document, choose a vendor and 
select the Service type. Select an expense G/L account and set the total to more 
than 25000. Keep the purchase order in the active window and choose Tools  
Queries  User Queries  Category and select the query name. The value 
‘true’ should show in the results if the query conditions are met. 

 

1-3-2 Create an approval template. 

Choose Administration  Approval Procedures  Approval Templates. 

Field Name or Data Type Values 

Name Service PO 

Description Service PO 

Originator tab Select a user from the Purchasing 
department. 

You can also select the user 
“manager”. 

Documents tab Select the Purchase Order checkbox. 

Stages tab Select the approval stage you created in 
step 1-2-1. 

Add the query you just created on the Terms tab. 
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1-3-3 Test the approval process 

Make sure you are logged in as an originator. Create a service PO with a total 
greater than 25000. 

Enter a suitable message in the Remarks field for the approval.  

1-3-4 Approve the purchase order 

You can approve the purchase order from the Messages/Alerts Overview 
window or from the Approval Decision report. 

 

1-3-4 Test the document rejection process 

If you have time, create another purchase order that meets the approval criteria. 
This time, select Not Approved in the Approval Decision report. See what 
happens when the purchase order is rejected! 
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Customization Tools: Solutions 

 

 

Unit: Customization Tools 

Topic: Approval Procedures 

 

 

1-1 Activate approval procedures in the system 

Choose Administration  System Initialization  General Settings. 

Choose the BP tab. 

The checkbox Activate Approval Procedures should be selected. Select the checkbox to 
enable the approval procedures functionality in the system.  

Choose OK. 

 

1-2 Define an approval procedure using a predefined condition. 

If the discount offered in a sales document is more than 25%, the system should block 
the document until it is approved by the accounting department. 

1-2-1 Create an approval stage for manager approval. 

Choose Administration  Approval Procedures  Approval Stages. 

Field Name or Data Type Values 

Stage Name Manager 

Stage Description Manager Approvers 

No. of Approvals Required 1 

No. of Rejections Required 1 

Authorizer 1 Select the user “manager” 

Authorizer 2 Select the Accounting department then 
choose a user from the list. 

Choose Add. 
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1-2-2 Create an approval template. 

Choose Administration  Approval Procedures  Approval Templates. 

Field Name or Data Type Values 

Name Discount 25 

Description Discount over 25% 

Originator tab Select the Sales department from the 
dropdown list. Select all users in the 
Sales department.  

Note: To select all users at the same 
time, select the first row then hold the 
Shift key and select the last row. All 
rows will be selected. 

Documents tab Select all Sales – A/R documents. 

Stages tab Select the approval stage you defined 
earlier – Manager. 

Choose the Terms tab. 

Select the When The Following Applies. 

Choose the predefined term for Discount %. 

Field Name or Data Type Values 

Ratio Greater than 

Value 25 

 

Make sure that the Active checkbox is set in the approval template. 

Choose Add. 

 

1-2-3 Test the approval process. 

Login as one of the originators (sales users) and create any sales document. Set 
the Discount field as 26%. 

Note: If you are unable to login as one of the sales users due to license 
availability, you can add the user manager to the approval template as an 
originator.  

When you Add the document, the approval window will display. Enter a 
suitable message in the Remarks field for the approval. Choose OK. 

Note: The sales document is now saved as a draft. You can view this document 
in the Document Drafts report. 
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1-2-4 Approve the document 

An alert will appear in the approver’s Messages/Alerts Overview window.  
Select the link to view the approval request. Select Approved as the answer and 
choose Update. You can optionally enter remarks for the originator. 

You can also view the approval request in the Approval Decision Report. 
Choose Administration  Approval Procedures  Approval Decision Report. 
Select Approved and choose Update. 

1-2-5 Process the approved sales document 

The approved sales document will display in the originator’s Messages/Alerts 
Overview window. Select the link to the document. The document has the status 
Draft [Approved] and you can now Add it to the system. 

 

The originator can also access the approved document from the Approval Status 
Report. Choose Administration  Approval Procedures  Approval Status 
Report.  

 

1-3 Define an approval procedure based on a query. 

All service type purchase orders over 25000 must be approved first by the purchasing 
manager and then by the company owner. You will create a new approval template. 
You can use the approval stage you created in step 1-2-1. 

1-3-1 Create the query 

Open the Query Generator and select Execute to open the Query Preview 
window. Select the Pencil icon to switch to Edit mode, and paste or create the 
following query: 
The following query use the item and column number syntax: 
The following query use the item and column number syntax: 

Note: This query uses the $ syntax to reference the active window and the 
item and column number to work with multiple marketing document types: 

The following query will work only with the purchase order document: 
T 

SELECT 'true' WHERE $[$3.0.0] = 'S' AND $[$29.0.number] > 25000 

Save the query in any category. 

To test the query, open a blank purchase order document, choose a vendor and 
select the Service type. Select an expense G/L account and set the total to more 
than 25000. Keep the purchase order in the active window and choose Tools  
Queries  User Queries  Category and select the query name. The value 
‘true’ should show in the results if the query conditions are met. 
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1-3-2 Create an approval template. 

Choose Administration  Approval Procedures  Approval Templates. 

Field Name or Data Type Values 

Name Service PO 

Description Service PO 

Originator tab Select a user from the Purchasing 
department. 

You can also select the user 
“manager”. 

Documents tab Select the Purchase Order checkbox. 

Stages tab Select the approval stage you created in 
step 1-2-1. 

Choose the Terms tab. 

Select the When The Following Applies radio button. 
In the lower part of the window, double-click in the first row to open the Query 
Manager. 

Choose the query you just created. 

Choose Add. 

 

1-3-3 Test the approval process 

Make sure you are logged in as an originator. Create a service PO with a total 
greater than 25000. 

Enter a suitable message in the Remarks field for the approval.  

Choose OK. 

1-3-4 Approve the purchase order 

You can approve the purchase order from the Messages/Alerts Overview 
window or from the Approval Decision report. 

 

1-3-4 Test the document rejection process 

If you have time, create another purchase order that meets the approval criteria. 
This time, select Not Approved in the Approval Decision report. See what 
happens when the purchase order is rejected! 
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Welcome to the topic on the Import from Excel utility.
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In this topic, you will see how to import business partner master data, item master 
data, and price lists using the Import from Excel utility.
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In the business scenario shown here, your distributors send you a spreadsheet 
with new and updated customer master data. You want to import this data on a 
regular basis to provide warranty support.

Many companies need to periodically import bulk master data, especially when 
dealing with distributors and other third parties. Often this data is in the form of a 
Microsoft Excel spreadsheet.p

The Import from Excel utility provides a simple way to import data from a 
spreadsheet.
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You can use this utility to import and update business partner master data, item 
master data, and prices in a price list. 

Since the utility imports data from Microsoft Excel, it gives you the opportunity to 
maintain and prepare the data in Excel before you import it.

Note: a similar utility is available to import fixed asset master data. To access this 
utility you must have enabled fixed assets at the system levelutility, you must have enabled fixed assets at the system level.
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The Import from Excel utility is based on the Data Interface (DI); however, only a 
limited set of fields can be imported for each of the objects. Furthermore, you 
cannot import data into user-defined fields added to these objects. 
Therefore, if the import utility does not meet your data import needs, you should 
use the Data Transfer Workbench instead.
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1. First create a spreadsheet with the data for each field.

2. Save the spreadsheet as a .txt (Tab delimited) file. 

3. In the utility, select the object type for import – BP or Items. To import prices, 
choose the Items object type.

4. Next, map the columns from the spreadsheet by selecting object fields from a 
d d li t i th tilit Wh l t fi ld th t fi ld l h idropdown list in the utility. When you select a field, that field no longer shows in 
the dropdown list. This prevents a field being selected more than once.

5. Choose OK to run the import.

Be aware that there is no test or simulation run provided by the utility. Therefore 
you should run the import on a test system first and verify the imported data.
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To understand the field names in the utility, consult the Database Tables 
Reference, which is distributed with the SAP Business One software. If you have 
installed the SDK, you can find it in the SDK help center. If you have installed 
DTW, you can find it from the help menu of DTW.

In the slide, the OITM table is shown for the Items object.

As well as the names of the fields for the object the Database Tables ReferenceAs well as the names of the fields for the object, the Database Tables Reference 
shows the default values and any constraints.
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There are some general rules for creating the spreadsheet.

• The spreadsheet should not contain a heading row, since the utility expects the data to 
start in the first row.

• You can enter the fields in any column order, since the mapping is done in the utility.

• Generally it is a good idea to format the spreadsheet cells as text type. This prevents 
Microsoft Excel from truncating a field value.

• There is no need to enter a field if the default value meets your needs, for example, the 
currency code, or the group code. The Database Tables Reference shows if there are 
default values for a field. Since your system may have additional default values in the 
setup for master data and items, for example, payment terms for business partners, 
you also need to be aware of these settings. The easiest way to see these default 
values is to create a master data record, using just the code. The default values will be 
inserted automatically into the new record.y

• You should comply with any field constraints, such as the maximum length for a field, 
or the required values for a field.

Before you run the import utility, you must save the spreadsheet as a text (Tab delimited) 
file. 

You must close the tab delimited file before you run the utility. Failure to close the file will 
res lt in an errorresult in an error.
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In the utility, you have an option to save the field mappings as a template for future 
use. The template is stored internally with a code and name that your provide.
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• You can import many of the header fields in the business partner master data and data 
on the General tab.

• You can also import one billing and one shipping address into the Addresses tab. If 
you need more than one billing and one shipping address, use the Data Transfer 
Workbench to import the data instead.

• You can import the name of the default contact person; however, you cannot import 
detailed contact information in the Contact Persons tab.

In the spreadsheet, some fields need to be entered in accordance with the DI interface. 
For example:

• The BP Type field is C, S, or L. C denotes a customer, S denotes a vendor or supplier, 
and L denotes a  lead. The default is customer, and if you leave this field empty the 
utility will create a customer record.y

• The BP Currency is the currency code as specified in the Currencies table in SAP 
Business One. You only need to enter the currency if it differs from the local currency. 

• The Group Code is actually the name of the group. If you do not enter a group name, 
the business partner is automatically assigned to the first group in the system. If you 
enter a group name that does not exist in the Groups table, a new group will be created 
automatically.
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• You can import fields into the item master data header and the General tab. 

• Additionally, you can import many fields on the Purchasing, Sales, Inventory 
and Planning tabs,  including the price, valuation and planning method, the 
length, width, height, weight and volume, and units of measure. 

Note that the warehouse cannot be entered in the spreadsheet and will always 
default from the General Settings or from the item level default warehousedefault from the General Settings or from the item level default warehouse. 

The Item Group is the name of the group, not the group code. If the group name 
does not exist, a group will be automatically created using the supplied name.

Many of the fields have special values required by the DI interface. Your best 
approach is to select the item table OITM in the Database Tables Reference for 
the field constraints For example the Set G/L Account by field requires the valuesthe field constraints. For example the Set G/L Account by field requires the values 
W, C, or L to indicate the level of the G/L account determination – warehouse, 
item group, or item level. If this field is not entered, the default setting from the 
system is used.
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• The utility provides an option to update the expense and revenue G/L accounts 
for an existing item if G/L account determination is set at the item level.

• If you specify a customs group for the item, the customs group must be defined 
in the system before the import. If the customs group is not defined, you will be 
unable to import the data.

• If you import the price for an item you must enter in addition the price list code• If you import the price for an item, you must enter in addition the price list code 
and the currency in the spreadsheet. 
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• The Import from Excel utility makes it easy to import or update item prices in 
one or more price lists. 

• The price list must be created in the system before you can import the prices. 

• To import item prices using the utility, you select the item code  and price list 
code fields, and, when you select the price list code, the utility automatically 
shows the fields required for the objectshows the fields required for the object. 

• You can import the price in the primary currency as well as in up to two 
additional currencies, if needed. The currencies must be set up in the 
currencies table.

When you import prices into an existing price list, select the Update Existing 
Records checkbox.

© SAP AG 445 TB1200



Here are some key points to take away from this session. Please take a minute to 
review these key points:

• The import from Excel utility is an easy way to import basic master data for 
business partners, items, and item prices in multiple price lists.

• Not every field in the business partner or item master objects can be imported.

Th d t i i t d f d h t ll i t i l t d• The data is imported from a spreadsheet, allowing you to manipulate and 
transform external data using the standard Microsoft Excel functions.

• Some fields require specific values, for example, Set G/L Account by and 
Valuation Method. The Database Tables Reference can help you identify both 
the default values for fields, as well as field lengths and constraints on the data 
in a field. You can find the Database Tables Reference in the SDK help files or if 
you install DTW.y

• Remember to save the spreadsheet as a text (tab delimited) file and 
close the file before running the import. 

• Columns headings should also be removed as they will produce an error 
when you run the utility.

• To prevent data truncation in the spreadsheet, it is a good practice to 
format the cells as text typeformat the cells as text type.
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Welcome to the topic on importing a chart of accounts using the Data Transfer 
Workbench.
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In this topic, you will see how to import a chart of accounts using the Data 
Transfer Workbench. 
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In this business scenario, your customer has given you a spreadsheet with the list 
of general ledger accounts from the legacy system.

You need to import these accounts into a new SAP Business One company. You 
can do this using the Data Transfer Workbench.
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Data Transfer Workbench (DTW) is a tool provided with SAP Business One to 
import data into SAP Business One objects from a Microsoft Excel spreadsheet. 
DTW uses the DI API to access the database.

DTW can also import data from external databases using an ODBC connection.

I thi t i th f i i ti d t f d h tIn this topic, the focus is on importing data from a spreadsheet.
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When you install DTW, a folder is created with Microsoft Excel templates for the 
objects that can be imported. There is also a folder that shows samples of the 
template data.

You need to use the templates provided.

Th t l t i d t f ll th SAP B i O ThThe templates are organized to follow the SAP Business One menus. The 
template names start with the four character database table name, so, for 
instance, the chart of accounts template  is called OACT – ChartOfAccounts.
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• You can use DTW to import a full chart of accounts into a new company. If you 
are importing a chart of accounts into a new company, you should select the 
option for a User-Defined chart of accounts when you create the company 
database. A user-defined chart of accounts just contains the top-level drawers.

• You can also import additional accounts for an existing chart of accounts. 

Before you proceed with the import you need to identify the structure for yourBefore you proceed with the import, you need to identify the structure for your 
chart of accounts, such as the account levels and hierarchy, and account details, 
such as the account type, account currency, and whether an account is 
confidential or is a control account. 
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The DTW template for importing a chart of accounts is found in the Financials > 
Chart of Accounts folder.

The first two rows in a DTW template are reserved and you should not remove 
these rows.

• Row 1 contains the DI API field names. You can only import fields that are 
exposed to the DI APIexposed to the DI API.

• Row 2 contains the database field names that can be identified in SAP 
Business One using System Information.

• You start entering data in row 3.
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To assist you, a tooltip will open when you move the mouse over the column 
headings in row 1.

If the field is an enum type, the valid values are shown. As an example, the valid 
values for the cash account field are tYES and tNO. To indicate an account is a 
cash account, you enter the value tYES in the field.

If the field is a string the maximum length is shown in the tooltip Here we can seeIf the field is a string, the maximum length is shown in the tooltip. Here we can see 
the maximum length of the currency field is three.
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Many fields in SAP Business One have default values, for example, the account 
currency. 

When preparing data for import, you do not need to enter the value if the default 
value meets your needs.

Default values are not shown in the tooltips; however, you can find the default 
values for a table in the Database Tables Reference From within DTW choosevalues for a table in the Database Tables Reference. From within DTW choose 
Help > Database Tables Reference.

Some default values are shown here. 

 An account will be imported as a non-cash account by default, therefore you 
need to indicate if the account is a monetary account.

 An account will be imported as an active account, therefore you need to 
indicate if it is a title accountindicate if it is a title account.

 The default account type is “other”, therefore you need to indicate sales or 
expenditure account types.

 And if the account is a control account, make sure you indicate this in the 
spreadsheet using the Lock Manual Transaction field. 
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In the DTW template, column A contains the account code. 

If you are importing a standard chart of accounts, enter the account number 
here.
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If you are importing a segmented chart of accounts:

• If the account is a title account, enter the account name in column A. 

• If the account is an active account, you can enter any value in column A, since 
the value in this column is ignored. Enter the actual account number in the
FormatCode column. The FormatCode field is only entered for a segmented 
chart of accounts Enter the full account number of the active account as achart of accounts. Enter the full account number of the active account as a 
string, with the segments.

Note that, for a segmented chart of accounts, you must define the segment 
codes in the system before you import the accounts. 
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The father key field is important, since this determines the level in the hierarchy 
for an imported account.

You can import both title and active accounts using DTW. 

For each title or active account, you need to reference the higher level drawer or 
title account in the account hierarchy in the FatherNum column. The new account 
will be inserted at a level below this accountwill be inserted at a level below this account.

If the father account is a level one drawer, enter the 15 digit number assigned by 
the system. To find out the system-assigned number for a drawer, run a query on 
the OACT table.  In the DTW template, make sure this cell is formatted as text so 
it can hold a 15 digit number. 
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After you have entered your data into the template, save the template as a tab, 
comma, or semi-colon delimited file type. These file types are accepted by DTW.

Start the Data Transfer Workbench and select the type of data (setup data, aster 
data or transactional data). The chart of accounts is master data.

Navigate to the business object and browse for the saved template file.

Ch k th d t t fi ld i If th d fi ld thiCheck the source and target field mappings. If there are unmapped fields this 
could indicate a problem with your spreadsheet data.

You can optionally run a simulation. This is recommended. Alternately, import the 
data into a copy of the production database first.

Import the data and verify it in SAP Business One.

To see troubleshooting information for importing accounts, reference SAP Note 
865191 DTW T bl h ti G id865191 - DTW Troubleshooting Guide.
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Here are some key points to take away from this course. Please take a minute to 
review these key points:

• The Data Transfer Workbench (DTW) makes it possible to import an entire 
chart of accounts from a legacy system. You first need to create a new 
company database with a user-defined chart of accounts.

• You can also use DTW to add accounts to an existing chart of accounts• You can also use DTW to add accounts to an existing chart of accounts, 
including a chart of accounts based on the default localization template.

• Use the OACT template provided with the DTW. 

• Be aware of default field values, and field lengths and constraints. Consult the 
Database Tables Reference to determine the default values for fields, as well 
as field lengths and constraints on the data in a field. You can find the Database 
Tables Reference in the help files for the Data Transfer Workbench application.p pp

• For each account you import, you need to enter the higher-level drawer or title 
account in the chart of accounts hierarchy (the father key). For an account at 
level two, this will be the number assigned to the drawer. For a segmented 
chart of accounts, you need to enter the active account number in the 
FormatCode column.

• Remember to save the spreadsheet as a tab, comma, or semi-colon 
f f fdelimited file. These are the file formats that DTW supports.

• Run a simulation first in DTW, or import the data into a test database so 
you can validate the results.
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Welcome to the topic on importing business partner master data using the Data 
Transfer Workbench.
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In this course, you will see how to import business partner master data, using the 
Data Transfer Workbench. 
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In this business scenario, you need to import business partner records from a 
legacy system into  a new company database.

The records have been extracted into a spreadsheet.

The master data has some additional fields that have been added to the master 
data object as user-defined fields.

U i th D t T f W kb h i t d t i t b i tUsing the Data Transfer Workbench, you can import data into business partner 
objects and user-defined fields.
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The business partner object as displayed on screen uses multiple tables. In the 
Data Transfer Workbench, multiple templates are provided for the import of data 
into the tables. Some of the tables are shown here, but you should check the 
template folder to see all available templates.

Each template is named for the table that it updates. The parent template updates 
the OCRD table, allowing you to import fields in the header and on the General , g y p
and Payment Terms tabs of the object.

You can use the child templates to import data into other tables for the object, for 
example, the OCPR table for importing contact persons. 
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In the parent template OCRD you specify core information for the business 
partner, such as the code and name. 

• The card type field identifies if the business partner is a customer, supplier, or 
lead. The default card type is for a customer, therefore you can leave this field 
empty if you are importing customer records. 

• The group code assigns the business partner to a customer or vendor group If• The group code assigns the business partner to a customer or vendor group. If 
you leave the group code blank in the template, the group will default to the first 
customer or vendor group in the system, for example 100 for customers or 101 
for vendors/suppliers. If you enter a group code, use the code from the related 
table OCRG (the Customer or Vendor groups table).

• The business partner currency will default to the local currency. If you enter a 
currency, use the 3 digit international currency symbol as defined in the 

i t bl i th tcurrencies table in the system.

• The payment terms will default in from the General Settings.

• If the business partner group has an associated price list, that price list will be 
the default. If there is no price list associated with the group, the price list will be 
taken from the default payment terms.
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To import contact information on the Contact Persons tab of the master data, use 
the child template OCPR, and enter each contact on a separate row. You can 
import multiple contacts for a business partner.

The child template references the parent template row using the card code field.
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You can specify one billing and a shipping address in the parent template OCRD. 
These addresses become the default addresses.

To import multiple addresses for a business partner, use the child template CRD1.

In the CRD1 template, enter each address on a separate row and use the 
AddressName field to label each address. 
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You can use the child templates to update individual contacts or addresses in an 
existing master data record. 

In the child template, you identify the contact or address be updated by entering 
the LineNum field. The LineNum field is entered as an integer: 0 for the first row, 1 
for the second row, and so on.  Generally the rows match the order of the original 
import; however, you should verify the row for a contact or address by running a p ; , y y y g
query on the OCPR or CRD1 table.

You can add a new contact or address row to an existing business partner record 
by setting the LineNum value appropriately so that it does not update an existing 
row.

You do not need to include the parent template OCRD when you update individual 
rows. Remember to choose the option to “Update Existing Data” in DTW.
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User-defined fields are often added to master data records to hold information 
specific to the company’s business processes.

To import data into a user-defined field, simply add the name of the field to the end 
of the template, as shown here, and enter the data in the column.

You must use the DTW to import data into user-defined fields; you cannot import 
into user-defined fields using the Import from Excel utilityinto user-defined fields using the Import from Excel utility.
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Here are some key points to take away from this course. Please take a minute to 
review these key points:

• Using the Data Transfer Workbench, you can import and update data in 
the business partners object. 

• The business partner object uses several database tables, therefore 
multiple DTW templates are provided. The main template is OCRD and p p p p
is required when importing a new business partner. In this template you 
can specify a billing and shipping address, as well as a default bank for 
the business partner.

• Using the child templates, you can import multiple contact employees, 
billing and shipping addresses, and bank account details for business 
partners. You can import these child templates together with the parent 
template or you can import the child templates separately If you importtemplate, or you can import the child templates separately. If you import 
the child templates separately, choose the option to “Update Existing 
Data”, since the master data record already exists.

• You can also import data into user-defined fields that you have added to 
the business partners object, by adding the fields to the end of the 
template.

• To update the information in a row, such as a contact’s phone number, 
h th ti t “U d t E i ti D t ” d t th Li N fi ldchoose the option to “Update Existing Data” and enter the LineNum field 

in the child template to identify the row.
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Welcome to the topic on importing item master data using the Data Transfer 
Workbench.
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In this course, you will see how to import item master data including prices in price 
lists. You will also see how to import initial item quantities using goods receipts 
documents.
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In this business scenario, the customer is implementing SAP Business One and 
needs to migrate item master data and prices from the legacy system. 

Before the customer goes live, you need to enter the initial quantities and costs as 
opening balances in the new system. 

Many of the items are managed with batches. 

It t d t ith i i d b t h ( i l) b b i t dItem master data, with pricing and batch (or serial) numbers, can be migrated 
using the Data Transfer Workbench. You can also import initial quantities for the 
items.
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The first part of this topic covers the import of item master data.
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The main template for item master data imports fields into the OITM table. This 
includes the header and the General, Purchasing, Sales, Inventory and Planning 
Data tabs of the item master data object.

You can enter the inventory unit of measure in the OITM template, as well as the 
sales and purchasing units of measure.

The child templates for the object are the ITM1 Items Prices and the OITWThe child templates for the object are the ITM1 – Items_Prices and the OITW –
ItemWarehouseInfo tables. These tables hold the item’s price in multiple price lists 
(table ITM1), and various information relating to the warehouse for the item (table 
OITW).

Other templates are provided in the DTW templates folder for maintaining a list of 
preferred vendors for the item (table ITM2). Note that the vendors in this list must 
have a business partner master data record.

You can also enter cycle count information for items using the ITW1 table 
template.
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The main table OITM contains over one hundred fields. Many of the fields have 
default values from the system or according to the system configuration, for 
example, the G/L Method defaults in from the General Settings. 

Other fields have specific valid values that must be entered in the spreadsheet. 
You can see the valid values by opening the tooltip for the field in the first row.
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To see which fields have system level defaults for a table, consult the Database 
Tables Reference, which is distributed with the SAP Business One software. You 
can open the Database Tables Reference from the Help menu in DTW. Navigate 
to the object and the table for the object.

If there is a default system value for a field, it will show here.
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Using the ITM1 template, you can import an item’s price into one or more price 
lists.

You can import the prices with the item master data, or import the price lists in a 
separate run.

To import a price, enter the item code, price list number, price and optionally the 
currencycurrency.

The price list number can be found by running a query on the OPLN table.

Note: The price list template does not currently include the new price list fields for 
additional currencies.
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If you need to update prices in an existing price list, you need to enter the 
LineNum field in the ITM1 template. This is an integer version of the price list 
number, starting at zero. 

In this case, you need to choose the option in DTW to update existing data, since 
you will be updating the item object.  

If you update a price list that is based on another price list the manual checkboxIf you update a price list that is based on another price list, the manual checkbox 
will be set and the price will not be updated if the base price subsequently 
changes.

Note that you can also import and update price lists using the Import from Excel 
utility in SAP Business One. You can find information on this utility in a companion 
course.
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If item stock will be managed by warehouse, you can enter the minimum and 
maximum stock levels for each warehouse using the OITW - ItemWarehouseInfo 
template. The information entered in this template is also displayed on the 
Inventory Data tab in the item master data. 
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User-defined fields are often added to master data records to hold information 
specific to the company’s business processes.

To import data into a user-defined field, simply add the name of the field to the end 
of the template, as shown here, and enter the data in the column.
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Before you import item master data, you need to create the item groups and 
warehouses in the system. 

You can create item groups and warehouses manually, or use the DTW templates 
OITB – ItemGroups and OWHS – Warehouses. These templates are found under 
the Administration > Setup > Inventory folder.  

Price lists must be created before you can import an item’s price You can createPrice lists must be created before you can import an item s price. You can create 
price lists manually in the system, or create new price lists using the DTW 
template OPLN – PriceLists.

Other item-related information, such as manufacturers, and the master data for 
preferred vendors, must be set up first so that you can reference them in the 
OITM template.
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The second part of this topic covers the initial quantities for items.
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After the item master data has been imported during an implementation project, 
you need to enter opening balances before go-live.

Opening balances record the physical in-stock quantities and the item cost. The 
item cost is used for inventory valuation.

Batch and serial number information can be entered with the item quantities.

O i B l d i d t il i th t iOpening Balances are covered in more detail in another topic.
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One of the ways to enter item quantities is the goods receipt document. This is a 
goods receipt not related to a purchase order. After you import a goods receipt, 
the in-stock quantity is updated in the warehouse. 

In addition, if perpetual inventory is in use, a journal entry is posted to record the 
stock value.

You can create the goods receipt manually or you can import them in bulk usingYou can create the goods receipt manually, or you can import them in bulk using 
DTW.

In DTW, the main template for importing a Goods Receipt document is OIGN -
Documents. There are child templates for importing the document rows, and for 
importing batches and serial numbers for the items being received into stock.

An advantage of using a goods receipt document to import opening balances is 
that you have a document as the source for the opening balances.y p g

Note that the DTW template OITW  - Stocktaking can be used after a stock count 
to adjust stock quantities. However, the OITW - Stocktaking template does not 
update the in-stock quantity, only the counted quantity, and therefore if you use 
this template for initial quantities, you need to post the in-stock quantity separately 
using the opening balances transaction in the SAP Business One application. 
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In the OIGN template, enter the header information for the goods receipt 
document.

Each row represents a goods receipt document.

If you want the system to allocate document numbers, you can enter any number 
as the DocNum in column A.

If t t t l d t b t th l f th H dW ittIf you want to enter manual document numbers, set the value of the HandWritten
field in column C to tYES and enter the manual document number as the 
DocNum.

It is a good practice to enter reference information so you can identify the 
documents and journal entries as opening balances.

Note that document dates must be entered using the format YYYYMMDD.
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Use the IGN1 template to import the document rows for the goods receipt.

Each row in the IGN1 template is linked back to the respective parent row using 
the ParentKey field in column A. 

Each row contains the quantities for an item in a warehouse.

The Price field is used to calculate inventory value. In a perpetual inventory 
t d t f ll id th l t d hsystem, you need to carefully consider the value entered here:

• For moving average price, whenever you receive items, the item cost will be 
recalculated using the moving average calculation. Therefore you need to 
make sure the price matches the average cost price in the legacy system. 

• For FIFO pricing, you should import multiple documents with different 
quantities at different cost prices, to represent the FIFO layers in the legacy 
systemsystem. 

• For standard cost items, the item cost can be entered with the master data in 
the OITM template.
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To import serial numbers, use the SRNT template. This is found in the same 
template folder as the goods receipt template.

Because the serial number is unique to an item, you enter each serial number on 
a separate row in the SRNT template.

Each serial number is linked back to a row in the document lines template IGN1, 
using the DocLineNum fieldusing the DocLineNum field. 

In the example shown, the first row in the goods receipt document has a quantity 
of two items. The two serial numbers are entered in the SRNT template with a 
base line number of zero to indicate the first row in the document. 

The ParentKey field links back to the header document.
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To import batch numbers, use the BTNT template. This is found in the same 
template folder as the goods receipt template.

Enter the quantity for each batch on a separate row. Use the DocLineNum field to 
link the batch to a row in the document.

In this example, the first two rows in the BTNT template belong to the first row in 
the document This row has a quantity of 48 items In the BTNT template thisthe document. This row has a quantity of 48 items. In the BTNT template, this 
quantity is split into two batches, with 24 items in each batch.
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Here are some key points to take away from this course. Please take a minute to 
review these key points:

 You can import item master data and item prices using the Data Transfer 
Workbench.

 Item groups, warehouses, and price lists must be created before you can 
i t th itimport the items.

 The main template for item master data is OITM. There are related tables 
for price lists, preferred vendors, and warehouse item information.

 To import data into user-defined fields, add the fields and their values to 
the end of the template.

 As you prepare for go-live, you can import as opening balances the initialAs you prepare for go live, you can import as opening balances the initial 
quantities and item costs for items using the DTW Goods Receipt 
template. 

 Templates are also provided to import serial numbers and batches for the 
items as they are received into stock. 

 Use the OITW – ItemWarehouseInfo template to import warehouse 
information such as minimum and maximum stock levels for an item ifinformation, such as minimum and maximum stock levels, for an item if 
inventory is managed by warehouse.
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Welcome to the topic on Opening Balances.
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In this topic, you will learn the various options for entering beginning balances 
for business partners, inventory, and G/L accounts. You will also learn how to 
enter the item quantities held in stock, with the costs.
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Just before go-live, you have a short timeframe where you must enter the G/L 
account balances from the legacy system, including the balances for business 
partner accounts. You also need to enter the item quantities and costs. At the 
end of this effort, the financial reports in the new SAP Business One system 
match the legacy reports. 
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The period immediately before go-live is called cutover. This period can be as 
short as a few hours, or can last a few days, such as over a weekend. 

However, you should conduct the planning for the cutover much earlier on in 
the implementation project, in phase 3 - Project Realization.

There are many things to consider. Will there be a period of running the SAP 
B i O t i ll l t th l t ? C th li t kBusiness One system in parallel to the legacy system? Can the go-live take 
place at the start of a fiscal year? Can open transactions in the legacy systems 
be closed before the cutover? 

During the cutover period, the final opening balances are entered in the new 
SAP Business One system.

At go-live, financial information in the SAP Business One system must match 
the legacy system balance sheet accountsthe legacy system balance sheet accounts. 
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The cutover period is a critical period and there are many elements to consider. 
Each customer will have slightly different requirements; but in general you 
should follow a recommended order for entering the opening balances. 

In this topic, we cover the procedure for opening balances at a high level. For a 
step-by-step guide to opening balances, refer to the Data Migration Guide from 
the AIP methodology.
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First, you need to complete the migration of master data. Master data is usually 
migrated in the Project Realization phase of the implementation project; 
however, there may be a need to migrate new master data created in the 
legacy system after the main migration ends.
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The customer should freeze operations on the legacy system, and perform a 
stock count, so that item quantities and costs can be entered into SAP 
Business One. 

If the system uses perpetual inventory, the inventory G/L account will be 
updated.
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Open transactions from the legacy system should be imported next. 

Open sales quotations, sales orders not linked to deliveries, purchase 
quotations, and purchase orders not linked to goods receipts, do not affect 
accounting or inventory levels, so can be imported as well as production 
orders. 

*Note: SAP recommends that open documents that affect inventory, such as 
deliveries, are not migrated. Instead the customer should try to invoice or close 
these documents on the legacy system.  If it is not possible, the customer 
should retain these documents and process them on the legacy system until 
they are closed. 

In the frozen legacy system business partner accounts should be reconciledIn the frozen legacy system, business partner accounts should be reconciled 
so that only open invoice balances and prepayments that are not based on an 
invoice need to be transferred. Where possible, the customer should pay 
outstanding vendor balances, and enter payments received from customers, to 
minimize the number of business partner balances. 

**Note: SAP recommends that A/R and A/P invoices are imported as service 
type invoices. If an item type invoice is migrated, and there are no preceding 
documents, the invoice will assume the role of the delivery or goods receipt and 
will impact inventory quantity levels. If perpetual inventory is in use, there will 
also be an automatic posting to the inventory account. 
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Lastly, enter the final opening balances for business partners, G/L accounts 
and bank transactions.

***Note: If all open A/R and A/P documents have been imported in step 3, the 
final balances for business partners should already be correct and should not 
be duplicated.p

The customer should attempt to reconcile bank accounts before these 
accounts are transferred.  If the account can be fully reconciled, you can 
transfer the balance. If there are unreconciled transactions in the account, you 
need to post these transactions individually in SAP Business One.

A trial balance report should be produced from the legacy system so that G/LA trial balance report should be produced from the legacy system so that G/L 
account balances can be entered into SAP Business One. 

If the go-live takes place during the fiscal year, the P&L account balances are 
also entered from the legacy system.
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Two methods are recommended for importing business partner account 
balances. 

• One option is to import the original A/R and A/P invoices for each business 
partner using the Data Transfer Workbench. SAP recommends using the 
service type document so there is no impact on inventory quantities or 
accounts. 

• The second option is to use the Business Partners Opening Balance
transaction in the SAP Business One application. You can enter the balance 
for multiple business partners in one screen. 

If there are multiple transactions in a business partner account, you need to 
decide with the customer whether to import the balance total as one flat 
amount, or whether to import each individual transaction for the business 
partner account.
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You should understand the implications of each method so you can advise the 
customer.

• If you import the account balances as service type invoices, as a result you 
have a document as a source for the original invoice, that can be matched 
when a payment is received. You should import the original posting dates 
from the legacy system to maintain correct aging. Any down payments and 

t t t d t th b i t t bpayments on account posted to the business partner account can be 
imported using DTW templates, or entered as opening balances as 
described below. You can keep the original document numbers from the 
legacy invoices.

• If you use the Business Partners Opening Balance transaction, a journal 
entry is posted to the business partner account. The journal entry has the 
origin code OB so it can be identified as an opening balance transaction. 
There is no document as a source but when processing a payment theThere is no document as a source, but when processing a payment, the 
user can match the payment to the journal entry in the account. It is easier 
if you enter each transaction for a business partner separately rather than 
in one consolidated amount. Additionally, you can enter the legacy due date 
for each transaction, to maintain correct aging. You can also enter balances 
for down payments and prepayments that were posted to the business 
partner account. 

Regardless of the method used, you should make sure that you have defined 
posting periods in SAP Business One so that postings can be made with the 
original dates from the legacy system. You should make sure these periods are 
not locked.
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After you have imported or entered the business partner transactions, the linked 
A/R and A/P control accounts are updated simultaneously, so these account 
values should match to the legacy system. If there are discrepancies, you need 
to investigate and make any corrections in SAP Business One using manual 
journal entries. 

As a result of importing invoices, the revenues and expenses accounts will be 
d d i h P fi d L i Th ill b d d ifupdated in the Profit and Loss section. These accounts will not be updated if you 

use the opening balances transaction.
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If you decide to import the invoices using DTW, you can find the DTW 
templates in the Sales or Purchasing folders:

• OINV – Documents

• INV1 – Document_Lines

• OPCH – Documents• OPCH – Documents

• PCH1 – Document_Lines

You can import the original legacy document number, if desired, by using 
manual document numbering.
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If you decide to use the opening balances transaction in SAP Business One, 
choose Administration → System Initialization → Opening Balances → 
Business Partners Opening Balance. 

In the opening balances screen, you should select an opening balances 
account as the offsetting account for the journal entry. This avoids a posting to 
the revenue or expenses account.

To support aging in the new system, you should specify the relevant due date 
for the balance. This might necessitate entering multiple balances for a 
business partner, with a different due date.

You can also use the opening balances transaction for recording any open 
business partner balances outside of the open invoices total (for example 
prepayments). 

Note: If the Display Credit Balance with Negative Sign checkbox is enabled, 
enter a minus sign for credit balances.
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Item quantities and costs must be entered before open transactions that 
release inventory can be imported. There are two things to consider: the 
physical in stock quantity for the item, and the item cost. 

The client should conduct a physical inventory or stock count before the item 
quantities are transferred.

Th it t i d f l l ti f i t l ti if t lThe item cost is used for calculation of inventory valuation if perpetual 
inventory is used:

• For moving average price, the item cost for an item will be recalculated each 
time a receipt document is imported, therefore you need to match the item 
cost closely to the legacy system. 

• For FIFO pricing, you can enter the item cost multiple times with different 
quantities at different cost prices to represent the FIFO layers in the legacyquantities at different cost prices, to represent the FIFO layers in the legacy 
system.

• For standard price, you can enter the standard prices in the item master 
data. Use the item’s last purchase price from the legacy system. 

After you have entered the item costs you should reconcile the value with the 
legacy system. You may have to create manual journal entries to correct any 
differences, especially if moving average is the management method.
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There are several methods recommended for importing item quantities and 
costs, including:

• The inventory opening balances transaction in SAP Business One. This 
allows you to enter the quantity and the item cost for each item, from a 
single screen. 

D t T f W kb h i th i t d i t t l t OIGN• Data Transfer Workbench using the inventory goods receipt template OIGN 
– Documents. The import of a goods receipt using DTW is covered in a 
companion topic.

• If there is a low number of items, you can enter them manually using a 
Goods Receipt document. 

You can enter batch or serial numbers for the items using any of the methods.

Note: If perpetual inventory is in use the inventory account is updated in valueNote: If perpetual inventory is in use, the inventory account is updated in value.
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• If you decide to use the Inventory Opening Balance transaction, you enter the 
item quantity at opening, and the unit price. You can select the price source as 
the item cost or as a price list. This gives you an opportunity to take the unit 
prices from a predefined price list.

• If you are working with perpetual inventory, the opening balances transaction 
posts a journal entry. The journal entry has origin code OB. The journal entry 
debits the inventory account defined in the G/L account determination anddebits the inventory account defined in the G/L account determination, and 
credits an offsetting account that you specify. SAP recommends you create an 
opening balances G/L account and use this as the offsetting account to ensure 
there is no effect on other general ledger accounts. The offsetting account can 
be selected on each item row.

• If perpetual inventory is used, make sure you enter the item cost appropriately, 
according to the valuation method for the item. If moving average valuation is 
used, a recommendation is to create a price list with the latest moving average 
price for each item from the legacy system. In the opening balance 
transaction, select this price list as the source for the item cost.
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If the item is set to be managed with batch or serial numbers, you can right-
mouse click the item row and select serial or batch from the context menu to 
enter the applicable serial numbers or batch information.
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The remaining final opening balances for the general ledger accounts need to 
be recorded last, just before the cutover. 

• If the go-live occurs at the start of a fiscal year, you can enter the G/L 
account balances from the trial balance report from the legacy system. 

• If the go-live occurs during the fiscal year, you need to transfer the P&L 
b l i dditi If d t t f P&L b l th li t h ldbalances in addition. If you need to transfer P&L balances, the client should 
run the P&L report for each period since the start of the financial year. This 
will allow you to enter the balances for each period. When entering P&L 
balances, you need to subtract the value of the expense and revenues 
accounts if you imported A/R and A/P invoices.

• Conduct the Period-End Closing process in the current go live period, in 
order to transfer the P&L balances. To run the Period-End Closing utility, 
choose Administration > Utilities > Period-End Closing.
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SAP recommends the following options for importing the final G/L account 
balances from the legacy trial balance report:

• Manual journal entry.  You can enter multiple accounts in one journal entry. 
Use the opening balance account as the offsetting account. You should enter 
reference fields to indicate the journal entry is an opening balance.

• The G/L Accounts Opening Balance transaction in SAP Business One You• The G/L Accounts Opening Balance transaction in SAP Business One. You 
can enter the balance for each G/L account in a single screen. A journal 
entry is posted by the transaction with the origin code OB, so this can be 
easily tracked and reported as an opening balance.

Make sure you do not enter a balance twice, for example the A/R and A/P 
control account balances, or the inventory account balance if perpetual 
inventory is in use.
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Th i b l t ti i SAP B i O ll t t thThe opening balances transaction in SAP Business One allows you to enter the 
final balance for each G/L account from a single screen. Select an opening 
balance account as the offsetting account. 

Although a separate journal entry is posted for each account, the posting date is 
the same. Therefore you need to decide whether to enter the balances spread 
over a fiscal year, for example, you can divide the balances by posting period, 
and post for each period with the posting date set to the end of the month. p p p g

When entering opening balances, you must enter the minus sign for credit 
balances if the Display Credit Balance with Negative Sign checkbox is set in 
Administration → System Initialization → Company Details.
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SAP recommends that you separate cleared (reconciled) and open 
(unreconciled) cash and bank transactions. This will make it easier to reconcile 
these accounts later in SAP Business One:

• You can enter fully reconciled transactions using the G/L Accounts Opening 
Balance transaction. Alternatively, you can import the transactions as journal 
entries using the Data Transfer Workbench. In both cases, the offsetting g , g
account should be the opening balance account.

• Open transactions contain un-cleared checks, bank transfers and other 
transactions that have been recorded in the books but not yet reconciled 
with the bank statement. You can import these transactions using the Data 
Transfer Workbench as individual journal entries or as one large journal 
entry with multiple rows. In both cases, record one line per open transaction. y p , p p
This will make it easier to reconcile these transactions later. The offsetting 
account should be the opening balance account.

If Bank Statement Processing (BSP) is to be implemented, when creating the 
first bank statement for the bank account the field ‘Starting Balance’ can be set 
manually Thereafter for all subsequent bank statements the starting balancemanually.  Thereafter, for all subsequent bank statements, the starting balance 
field must be equal to the ending balance of the previous bank statement.
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Regardless of how you perform the migration of open items and balances, you 
need to reconcile the accounts between SAP Business One and the legacy 
system. Print and retain a hard copy of all reconciliation reports from SAP 
Business One and the legacy system to prove the migration correctness:

• To reconcile inventory quantities and values, run the Stock Audit 
Report. Match the item quantities in SAP Business One with the quantities 
in the legacy system. Make sure the stock account balances in SAP 
Business One match the stock account balances in the legacy system.

• To reconcile business partner balances, run the Customer Receivables and 
Vendor Liabilities Aging  reports with a posting date range until the start of 
the current fiscal year. You must ensure that the business partner opening 
balances migrated to SAP Business One align with the legacy system.

• To reconcile G/L account balances, run the Balance Sheet as per the first 
day of the current fiscal year. You must ensure that the G/L opening 
balances migrated to SAP Business One align with the legacy system. 

• If you migrated other open items such as sales orders and purchase orders, 
you need to match the total balance migrated to SAP Business One with the 
legacy system. Run the Open Items List report in SAP Business One and 
compare the total with the total balance of the corresponding item in the 
legacy system.
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Here are some key points to take away from this topic.

• The goal of entering opening balances is to match the balance sheet and the 
Profit & Loss reports of the legacy system and the SAP Business One 
system.

• There are multiple ways to enter opening balances. You must plan the 
process carefully with the customer. p y

• SAP recommends that you migrate legacy master data and transactions in a 
certain order:

1. Master data, such as the chart of accounts, business partners, items and price 
lists

2. Item quantities and costs, based on an inventory stock take
3. Open transactions such as sales and purchase orders, A/R and A/P invoices, 

production orders, bills of materials, etc.
Fi l i b l f b i i G/L d l l4. Final opening balances for business partners, items, G/L accounts and lastly, 
bank transactions

• During the cutover period, the legacy system is frozen and stock is counted. 
In the legacy system, the client should close as many open existing 
transactions as possible, and business partner accounts should be 
reconciled so that only open invoice balances and prepayments that are not 
based on an invoice need to be transferred. Item quantities and costs must 
be entered before open transactions that release inventory can be imported. 

• For more details on a structured approach to entering opening balances, 
refer to the Data Migration Guide from the AIP methodology.
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Project Realization: Exercises 

 

 

 

Unit: Data Migration Tools 

Topic: Import from Excel utility  

 

 

In this exercise, you will import new items and price lists using 
the Import from Excel utility.  

 

 

 

1. Items 

1.1. Prepare a data spreadsheet 

Create a Microsoft Excel spreadsheet with a row for each of the three items in the 
table below. Enter the item information in columns A to I of the spreadsheet. Where 
a special value is required, it is indicated in parenthesis(). 

 Note: Do not enter the headings in the spreadsheet. 

  Row 1 Row 2 Row 3 

A Item No. MS33 MS55 MS00 

B Item Description Multi-Screen 
3x3 

Multi-Screen 
5x5 

Monitor 

C Item Group Screens 

Note:This group 
will be 
automatically 
created during 
the import 

Screens 

 

Items 

D Mfr Catalogue No.   8882222 

E Manufacturer   Samson 

F Set G/L account by Item Group 

(C) 

Item Group 

(C) 

Warehouse 

(W) 

G Valuation Method Standard Cost 

(S) 

Standard Cost 

(S) 

Moving 
Average (A) 

H Procurement method Make 

 (M) 

Make  

(M) 

Buy 

 (B) 

I Serial number 
management 

Y Y N 

Save the spreadsheet as a Text (Tab delimited) file (*.txt).  

Important: Close the text file. The import utility will fail if the spreadsheet file is 
open. 
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1.2. Run the Import from Excel utility 

Choose Administration  Data Import/Export  Import Data  Import from 
Excel. 

Select Items. 

Map each column in the spreadsheet by selecting a field from the dropdown list. 

Note: When you map a field, the field no longer displays in the dropdown list. 

Column Field 

A Item No. 

B Item Description 

C Item Group  

Note: This is the name of the group. 

D Mfr Catalogue No. 

E Manufacturer 

F Set G/L Account by 

G Valuation Method 

H Procurement Method 

I Serial No. Management 

 

After you have mapped all the fields, you can optionally choose the Save As button 
to save the mapping as a template for a future import. 

Choose OK. 

Locate the saved text file and choose Open. 

The import now runs. A message at the bottom of the screen indicates the success 
of the import. 

1.3. Verify the imported items 

Choose Inventory  Item Master Data and open the newly imported items. Check 
the master data to see which fields were entered using default values from the 
system. 
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2. Price Lists 

2.1. Import item prices into multiple price lists 

The new items are to be priced in the primary currency and in one additional 
currency in the price lists. The item prices are as follows: 

Item  Base Sales Price  Purchase Price 

 

Multi-Screen 
3x3 

9000 (Primary Currency) 

10000 (Additional Currency 1) 

Not applicable 

Multi-Screen 
5x5 

18000 (Primary Currency) 

20000 (Additional Currency 1) 

Not applicable 

Monitor 500 (Primary Currency) 

600 (Additional Currency 1) 

250 (Primary Currency) 

2.2. Prepare a data spreadsheet 

Create a spreadsheet with three rows, one for each item: 

Column Field 

A Item No. 

B Price list number. In your system, identify the number of the 
base sales price list, for example, price list 1.To see the price list 
numbers in your system, run a query on the OPLN table. 

C Price in Primary Currency.  Enter the price without the currency 
symbol. 

D Primary Currency. Enter the 3 digit currency code from the 
Currencies table.  

E Unit Price – Additional Currency 1 

F Additional Currency 1 

G Unit Price – Additional Currency 2 

H Additional Currency 2 

I UoM Group 

Manual. This is the default code for the UoM Group. 

 

Save the spreadsheet as a Text (Tab delimited) file (*.txt). 

Important: Close the text file.  
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2.3. Run the Import from Excel Utility 
 
In the Import from Excel window, choose the Clear button to remove the selections 
you made for the item import. 
 
In column A, select the Item No. field from the dropdown list. 
 
In column B, select the Price List Code.  When you make this selection, the system 
will automatically display the remaining fields required to import a price list, 
including the UoM code. 
Note: The order of these fields cannot be changed. If you are importing the item 
prices with the item master data, you need to keep the reserved price list columns 
empty. 
 
Make sure the fields match to the order of the spreadsheet columns. 
  
Select the Update Existing Records checkbox, so that you can update the item 
records. 

Choose OK. 

Locate the saved text file and choose Open. 

The import now runs. A message at the bottom of the screen indicates the status of 
the import. 
 

2.4. Verify the price lists 
 
Verify the imported price lists. Choose Inventory    Price Lists    Prices Lists.  
 
Double-click the base price list to see the list of item prices, and locate the new item 
prices. 
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Project Realization: Solutions 

 

 

Unit: Data Migration Tools 

Topic: Import from Excel utility  

 

In this exercise, you will import new items and price lists using the Import from Excel 
utility.  

 

1. Items 

1.1. Prepare a data spreadsheet 

Create a Microsoft Excel spreadsheet with a row for each of the three items in the 
table below. Enter the item information in columns A to I of the spreadsheet. Where 
a special value is required, it is indicated in parenthesis(). 

 Note: Do not enter the headings in the spreadsheet. 

  Row 1 Row 2 Row 3 

A Item No. MS33 MS55 MS00 

B Item Description Multi-Screen 3x3 Multi-Screen 
5x5 

Monitor 

C Item Group Screens 

Note:This group 
will be 
automatically 
created during the 
import 

Screens 

 

Items 

D Mfr Catalogue No.   8882222 

E Manufacturer   Samson 

F Set G/L account by Item Group 

(C) 

Item Group 

(C) 

Warehouse 

(W) 

G Valuation Method Standard Cost 

(S) 

Standard 
Cost 

(S) 

Moving 
Average (A) 

H Procurement 
method 

Make 

 (M) 

Make  

(M) 

Buy 

 (B) 

I Serial number 
management 

Y Y N 

 

  Save the spreadsheet as a Text (Tab delimited) file (*.txt).  

Important: Close the text file. The import utility will fail if the spreadsheet file is 
open. 
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1.2. Run the Import from Excel utility 

Choose Administration  Data Import/Export  Import Data  Import from 
Excel. 

Select Items as the data type for the import. 

Map each column in the spreadsheet by selecting a field from the dropdown list. 

Note: When you map a field, the field no longer displays in the dropdown list. 

Column Field 

A Item No. 

B Item Description 

C Item Group  

Note: This is the name of the group. 

D Mfr Catalogue No. 

E Manufacturer 

F Set G/L Account by 

G Valuation Method 

H Procurement Method 

I Serial No. Management 

 

After you have mapped all the fields, you can optionally choose the Save As button 
to save the mapping as a template for a future import. 

Choose OK. 

Locate the saved text file and choose Open. 

The import now runs. A message at the bottom of the screen indicates the success 
of the import. 

1.3. Verify the imported items 

Choose Inventory  Item Master Data and open the newly imported items. Check 
the master data to see which fields were entered using default values from the 
system. 
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2. Price Lists 

2.1. Import item prices into multiple price lists 

The new items are to be priced in the primary currency and in one additional 
currency in the price lists. The item prices are as follows: 

Item  Base Sales Price  Purchase Price 

 

Multi-Screen 
3x3 

9000 (Primary Currency) 

10000 (Additional Currency 1) 

Not applicable 

Multi-Screen 
5x5 

18000 (Primary Currency) 

20000 (Additional Currency 1) 

Not applicable 

Monitor 500 (Primary Currency) 

600 (Additional Currency 1) 

250 (Primary Currency) 

 

2.2. Prepare a data spreadsheet 

Create a spreadsheet with the item prices: 

Column Field 

A Item No. 

B Price list number. In your system, identify the number of the 
base sales price list, for example, price list 1.To see the price list 
numbers in your system, run a query on the OPLN table. 

C Price in Primary Currency.  Enter the price without the currency 
symbol. 

D Primary Currency. Enter the 3 digit currency code from the 
Currencies table.  

E Unit Price – Additional Currency 1 

F Additional Currency 1 

G Unit Price – Additional Currency 2 

H Additional Currency 2 

I UoM Group 

Manual. This is the default code for the UoM Group. 

 

Save the spreadsheet as a Text (Tab delimited) file (*.txt). 

Important: Close the text file.  
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2.3. Run the Import from Excel Utility 
 
In the Import from Excel window, choose the Clear button to remove the selections 
you made for the item import. 
 
In column A, select the Item No. field from the dropdown list. 
 
In column B, select the Price List Code.  When you make this selection, the system 
will automatically display the remaining fields required to import a price list, 
including the UoM code. 
Note: The order of these fields cannot be changed. If you are importing the item 
prices with the item master data, you need to keep the reserved price list columns 
empty. 
 
Make sure the fields match to the order of the spreadsheet columns. 
  
Select the Update Existing Records checkbox, so that you can  update the item 
records. 

Choose OK. 

Locate the saved text file and choose Open. 

The import now runs. A message at the bottom of the screen indicates the status of 
the import. 
 

2.4. Verify the price lists 
 
Verify the imported price lists. Choose Inventory    Price Lists    Prices Lists.  
 
Double-click the base price list to see the list of item prices, and locate the new item 
prices. 
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Project Realization: Exercises 

 

 

 

Unit: Data Migration Tools 

Topic: DTW – Chart of Accounts  

 

In this exercise, you will import some new accounts to various 
drawers in the chart of accounts. You will import title accounts 
and active accounts under the title account. 

 

 

 

1. Import accounts using DTW 

Instructions are shown for importing accounts into a standard chart of accounts and into a 
segmented chart of accounts. 

Here are the accounts to be imported to each drawer: 

Drawer Description Note: 

Assets Internet Accounts  Title account 

National Bank 1  

 

Active account – use your local 
currency 

National Bank 2 

 

Active account – use a foreign 
currency 

Expenses/Operating 
Costs 

Warehouse Costs Title account 

Rent – Warehouse 01 

 

Active account 

 

Rent – Warehouse 02 Active account 
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1.1 Prepare the DTW spreadsheet  

From the DTW templates folder, choose Financials  Chart of Accounts and 
open the OACT - ChartOfAccounts.xlt template. 

In the template, enter a row for each new title or account: 

Column Field Description 

AcctCode Enter an account code for the new 
account or title. Check the chart of 
accounts in your system to view similar 
account numbers or title names. 

AcctName The name of the account or title 

CashAccount Set to tYES only for active bank accounts 
(monetary accounts). 

Note: the default is tNO. 

ActiveAccount Set to tNO only for the title accounts. 

Note: the default is tYES. 

FatherAccountKey Enter the account name or number of the 
higher level account, for example: 

 To add a title account at Level 4, use 
a Level 3 title account in the chart of 
accounts. 

 To add an active account at Level 5, 
enter the name of the title account 
added in this exercise 

AccountType Enter the correct category for active 
accounts: 

At_Revenues 

At_Expenses 

At_Other 

AcctCurrency Enter the currency code for active 
accounts, if different from the local 
currency. 

Note: To check the currency codes in 
your system, choose Administration  
Setup  Financial  Currencies. 

FormatCode 

(Segmented chart of accounts 
only) 

If you are working with a segmented 
chart of accounts, enter the actual account 
number for new active accounts. 

Note: Make sure that the account number 
follows the format defined in the Account 
Segmentation setup. Do not include 
account separator symbols in the account 
code. 

Save the template as a comma or semi-colon delimited file (.csv). 
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2.1 Import the new accounts 

Launch the Data Transfer Workbench (DTW) from the Implementation Center or 
from your desktop. 

In DTW, choose Import  Master Data  Add New Data 

Make sure the correct file type is selected. 

Choose Financials  Chart of Accounts. 

Choose the Browse button to locate the saved csv file. 

Run a simulation to check for any errors in your template. 

If the simulation is successful, import the data.  

 

3.1        Check the new accounts in the chart of accounts 

In SAP Business One, choose Financials  Chart of Accounts. 

Check the new title and active accounts in the Assets drawer and the 
Expenses/Operating Costs drawer. 

 

4.1   Troubleshooting errors 

If you encounter an error, always check the log. 

In the DTW wizard, you can visually check the source and target data: 

 The Source tab shows the data from the spreadsheet in a tabular format 

 The Target tab shows the data in a row format 
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Project Realization: Solutions 

 

 

Unit: Data Migration Tools 

Topic: DTW – Chart of Accounts  

 

In this exercise, you will import some new accounts to various drawers in the chart of 
accounts. You will import title accounts and active accounts under the title account. 

 

1. Import accounts using DTW 

Instructions are shown for importing accounts into a standard chart of accounts and into a 
segmented chart of accounts. 

Here are the accounts to be imported to each drawer: 

Drawer Description Note: 

Assets Internet Accounts  Title account 

National Bank 1  

 

Active account – use your 
local currency 

National Bank 2 

 

Active account – use a 
foreign currency 

Expenses/Operating 
Costs 

Warehouse Costs Title account 

Rent – Warehouse 01 

 

Active account 

 

Rent – Warehouse 02 Active account 
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1-1 Prepare the DTW spreadsheet  

From the DTW templates folder, choose Financials  Chart of Accounts and 
open the OACT - ChartOfAccounts.xlt template. 

In the template, enter a row for each new title or account: 

Column Field Description 

AcctCode Enter an account code for the new account or 
title. Check the chart of accounts in your 
system to view similar account numbers or 
title names. 

AcctName The name of the account or title 

CashAccount Set to tYES only for active bank accounts 
(monetary accounts). 

Note: the default is tNO. 

ActiveAccount Set to tNO only for the title accounts. 

Note: the default is tYES. 

FatherAccountKey Enter the account name or number of the 
higher level account, for example: 

 To add a title account at Level 4, use a 
Level 3 title account in the chart of 
accounts. 

 To add an active account at Level 5, enter 
the name of the title account added in this 
exercise 

AccountType Enter the correct category for active 
accounts: 

At_Revenues 

At_Expenses 

At_Other 

AcctCurrency Enter the currency code for active accounts, 
if different from the local currency. 

Note: To check the currency codes in your 
system, choose Administration  Setup  
Financial  Currencies. 

FormatCode 

(Segmented chart of accounts 
only) 

If you are working with a segmented chart of 
accounts, enter the actual account number for 
new active accounts. 

Note: Make sure that the account number 
follows the format defined in the Account 
Segmentation setup. Do not include account 
separator symbols in the account code. 

 

Save the template as a comma or semi-colon delimited file (.csv). 
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1-2 Import the new accounts 

Launch the Data Transfer Workbench (DTW) from the Implementation Center or 
from your desktop. 

Login and select a company database. 

In DTW, choose Import  Master Data  Add New Data 

In the DTW wizard, choose the Financials  Chart of Accounts object. 

Make sure the File Type is selected as comma delimited or semi-colon delimited. 

Choose the Browse button to locate the .csv file.  

Run a simulation to check for any errors in your template. 

If the simulation is successful, import the data.  

 

1-3        Check the new accounts in the chart of accounts 

In SAP Business One, choose Financials  Chart of Accounts. 

Check the new title and active accounts in the Assets drawer and the 
Expenses/Operating Costs drawer. 

  

1-4   Troubleshooting errors 

If you encounter an error, always check the log. 

In the DTW wizard, you can visually check the source and target data: 

 The Source tab shows the data from the spreadsheet in a tabular format 

 The Target tab shows the data in a row format 
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Project Realization: Exercises 

 

 

 

Unit: Data Migration Tools 

Topic: DTW – Business Partners  

 

In this exercise you will import master data for business partners, 
using the Data Transfer Workbench. You will also import data 
into user-defined fields added to the business partners object. 

Note: You can import business partner master data using the 
Import from Excel utility; however, not every field can be 
imported using the Import from Excel utility, and you cannot 
import into user-defined fields. 

 

1. Setup requirements for the master data 

1.1. Create business partner groups 

Note:  You need to create the business partner groups before you import the master 
data. 

Choose Administration Setup  Business Partners  Customer Groups. 

Add two new customer groups: 

 Stadiums  

 Hotels 

Run a query on the OCRG table to see the group codes in your system. You will need 
to import these codes with the master data. 

Make a note of the group codes: 

Suppliers  

Stadiums   

Hotels  

 

1.2. Add user defined fields to the business partners object 

Choose Tools  Customization Tools  User-Defined Fields – Management. 

Select Master Data > Business Partner > Business Partner. 

Enter the following data:  

Field Name or Data Type Values 

Title Stmt 

Description Statement Required? 

Type Alphanumeric 

Structure Regular 

 You will import a value into the new 
field; however, you can optionally set 
a list of values now: None, Monthly, 
Quarterly, Every 6 months, 
Annually 
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Add a second UDF. 

Enter the following data:  

Field Name or Data Type Values 

Title Format 

Description Statement Format 

Type Alphanumeric 

Structure Regular 

 You can optionally set a list of 
values: Email, Fax, Mail 
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2. Prepare the DTW spreadsheets 

From the DTW templates folder, choose Business Partners  Business Partner Master 
Data. 

You will use more than one template to import the data: 

 OCRD – BusinessPartners for the header 

 OCPR – ContactEmployees for the contact information 

The business partners to be imported are: 

 Sound Systems 
Ltd. 

Global 
Electronics 
Corp 

London 
Coliseum  

MAX Hotel 
Group 

BP Group Suppliers 

 

Suppliers 

 

Stadiums and 
Exhibitions 

Hotels 

Type Supplier Supplier Customer  Customer 

Currency Local currency 

 

Foreign currency 

 

Local currency 

 

Foreign currency 

 

Contact 
name 

Terry Adams Robert Chang 1. Mary 
Burton 

2. Simon 
Howell 

3. Mr James 
Smith 

4. Ms Jean 
Green 

Contact 
phone 
number 

0207 600400 1 415 634 0002 012 345 6792 1860 345 6791 

Bill-to 
address 

123 Commercial 
St, 

Southend 

ES1 2AB 

Essex 

England 

Building 1 

900 Mission Rd 

San Francisco 

CA 94110 

USA 

 

6 Upmarket St 

W1 200, 

London 

UK 

46 Broad St 

Dublin 

Ireland 

Ship-to 
addres 

123 Commercial 
St, 

Southend 

ES1 2AB 

Essex 

Building 2 

900 Mission Rd 

San Francisco 

CA 94110 

 

1 Park Plaza 

W1 200, 

London 

2 EastGate 

Dublin  

Ireland 

Payment 
Method 

Bank Transfer Bank Transfer Bank Transfer Bank Transfer 

Statement 
Required? 

Monthly None None Quarterly 

Statement 
Format 

Email Fax Mail Email 
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2.1. Prepare the header template 

Open OCRD - BusinessPartners.xlt. 

Enter each business partner on a separate row in the template: 

Field Description 

CardCode Enter a valid code 

CardName The business partner name 

CardType  cCustomer, cSupplier, or Clid (customer, 
vendor, lead) 

Note: the default is customer 

GroupCode From the OCRG table 

Address The bill-to street 

City The bill-to city or town 

County The bill-to county 

Zipcode The bill-to postcode 

MailAddress The ship-to street 

MailCity The ship-to city or town 

MailCounty The ship-to county 

MailZipCode The ship-to postcode 

Phone1 Main telephone 

FederalTaxID The tax id, if applicable for your localization 

PriceListNum Price list for business partner 

Currency From the currencies table OCRN. Note: the 
default is the local currency. 

DefaultAccount The bank account number for the business 
partner 

DefaultBankCode The bank code for the business partner. 

Website The web site for the business partner 

U_Stmnt At the end of the template, add  a column for the 
user-defined field. Enter the field name 
U_Stmnt on the first row, then enter the 
required value from the table in step 2. 

U_Format At the end of the template, add  a column for the 
user-defined field. Enter the field name 
U_Format on the first row, then enter the 
required value from the table in step 2 

 Enter any other fields required for your 
localization. 

 

Save the template as a .csv file. 
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2.2. Prepare the contact information spreadsheet 

Open OCPR – ContactEmployees.xlt. 

Enter a row for each contact name. If there are multiple contacts for a business partner, 
enter each one on a separate row, using the same ParentKey: 

Field Description 

ParentKey CardCode of the relevant parent template 

LineNum Leave this column empty. 

Note: When updating contact information you 
must enter the LineNum as 0, 1, 2, etc. 

Name The first and last name of the contact. 

Phone 1 Phone number of contact. 

Title Title (if any) 

E_Mail E-mail address 

 Enter any other fields required for your 
localization. 

 

Save the file as .csv type. 
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3 Master data import 

In the Data Transfer Workbench, choose Import  Master Data  Add New Data. 

 

In DTW, Choose Business Partners  Business Partner Master Data. 

Link the OCRD – BusinessPartners.csv file to the parent node. 

Link the OCPR – ContactEmployees.csv file to the ContactEmployees node. 

 

Choose Run Simulation. 

If any error messages are shown, check the log file. 

Tip: if you cannot resolve an error, try importing just the header file. If that is 
successful in the simulation, add the other files one by one. 

After you have corrected your files, choose the Back button to re-run the import 
simulation. 

If the simulation is successful, go to the next step and choose Import. 

When all the records have been successfully imported, open the business partner master 
data to verify the imported records in SAP Business One. 

© SAP AG 536 TB1200



Project Realization: Solutions 

 

 

Unit: Data Migration Tools 

Topic: DTW – Business Partners  

 

In this exercise you will import master data for business partners, using the Data Transfer 
Workbench. You will also import data into user-defined fields added to the business partners 
object. 

Note: You can import business partner master data using the Import from Excel utility; 
however, not every field can be imported using the Import from Excel utility, and you cannot 
import into user-defined fields. 

 
1. Setup requirements for the master data 

1.1. Create business partner groups 

Note:  You need to create the business partner groups before you import the master 
data. 

Choose Administration Setup  Business Partners  Customer Groups. 

Add two new customer groups: 

 Stadiums  

 Hotels 

Run a query on the OCRG table to see the group codes in your system. You will need 
to import these codes with the master data. 

Make a note of the group codes: 

Suppliers  

Stadiums   

Hotels  

 

1.2. Add user defined fields to the business partners object 

Choose Tools  Customization Tools  User-Defined Fields – Management. 

Select Master Data > Business Partner > Business Partner. 

Choose Add. 

Enter the following data:  

Field Name or Data Type Values 

Title Stmt 

Description Statement Required? 

Type Alphanumeric 

Structure Regular 

 You will import a value into the new 
field; however, you can optionally set 
a list of values now: None, Monthly, 
Quarterly, Every 6 months, 
Annually 

Choose Update. 
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Add a second UDF. 

Enter the following data:  

Field Name or Data Type Values 

Title Format 

Description Statement Format 

Type Alphanumeric 

Structure Regular 

 You can optionally set a list of 
values: Email, Fax, Mail 

Choose Update. 
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2. Prepare the DTW spreadsheets 

From the DTW templates folder, choose Business Partners  Business Partner Master 
Data. 

You will use more than one template to import the data: 

 OCRD – BusinessPartners for the header 

 OCPR – ContactEmployees for the contact information 

The business partners to be imported are: 
 Sound Systems 

Ltd. 
Global 
Electronics 
Corp 

London 
Coliseum  

MAX Hotel 
Group 

BP Group Suppliers 

 

Suppliers 

 

Stadiums and 
Exhibitions 

Hotels 

Type Supplier Supplier Customer  Customer 

Currency Local currency 

 

Foreign currency 

 

Local currency 

 

Foreign currency 

 

Contact 
name 

Terry Adams Robert Chang 1. Mary 
Burton 

2. Simon 
Howell 

3. Mr James 
Smith 

4. Ms Jean 
Green 

Contact 
phone 
number 

0207 600400 1 415 634 0002 012 345 6792 1860 345 6791 

Bill-to 
address 

123 Commercial 
St, 

Southend 

ES1 2AB 

Essex 

England 

Building 1 

900 Mission Rd 

San Francisco 

CA 94110 

USA 

 

6 Upmarket St 

W1 200, 

London 

UK 

46 Broad St 

Dublin 

Ireland 

Ship-to 
addres 

123 Commercial 
St, 

Southend 

ES1 2AB 

Essex 

Building 2 

900 Mission Rd 

San Francisco 

CA 94110 

 

1 Park Plaza 

W1 200, 

London 

2 EastGate 

Dublin  

Ireland 

Payment 
Method 

Bank Transfer Bank Transfer Bank Transfer Bank Transfer 

Statement 
Required? 

Monthly None None Quarterly 

Statement 
Format 

Email Fax Mail Email 
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2.1. Prepare the header template 

Open OCRD - BusinessPartners.xlt. 

Enter each business partner on a separate row in the template: 

Field Description 

CardCode Enter a valid code 

CardName The business partner name 

CardType  cCustomer, cSupplier, or Clid (customer, 
vendor, lead) 

Note: the default is customer 

GroupCode From the OCRG table 

Address The bill-to street 

City The bill-to city or town 

County The bill-to county 

Zipcode The bill-to postcode 

MailAddress The ship-to street 

MailCity The ship-to city or town 

MailCounty The ship-to county 

MailZipCode The ship-to postcode 

Phone1 Main telephone 

FederalTaxID The tax id, if applicable for your localization 

PriceListNum Price list for business partner 

Currency From the currencies table OCRN. Note: the 
default is the local currency. 

DefaultAccount The bank account number for the business 
partner 

DefaultBankCode The bank code for the business partner. 

Website The web site for the business partner 

U_Stmnt At the end of the template, add  a column for the 
user-defined field. Enter the field name 
U_Stmnt on the first row, then enter the 
required value from the table in step 2. 

U_Format At the end of the template, add  a column for the 
user-defined field. Enter the field name 
U_Format on the first row, then enter the 
required value from the table in step 2 

 Enter any other fields required for your 
localization. 

Save the template as a .csv file. 

 

© SAP AG 540 TB1200



2.2. Contact Details 

Open OCPR – ContactEmployees.xlt. 

Enter a row for each contact name. If there are multiple contacts for a business partner, 
enter each one on a separate row row, using the same ParentKey: 

Field Description 

ParentKey CardCode of the relevant parent template 

LineNum Leave this column empty. 

Note: When updating contact information you 
must enter the LineNum as 0, 1, 2, etc. 

Name The first and last name of the contact. 

Phone 1 Phone number of contact. 

Title Title (if any) 

E_Mail E-mail address 

 Enter any other fields required for your 
localization. 

 

Save the file as .csv type. 
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3. Master data import 

Launch the Data Transfer Workbench (DTW) from the Implementation Center or from 
your desktop. 

Login and select a company database. 

In DTW, choose Import  Master Data  Add New Data. 

Choose Business Partners  Business Partner Master Data. 

Link the OCRD – BusinessPartners.csv file to the parent node. 

Link the OCPR – ContactEmployees.csv file to the ContactEmployees node. 

 

Choose Run Simulation. 

If any error messages are shown, check the log file. 

Tip: if you cannot resolve an error, try importing just the header file. If that is 
successful in the simulation, add the other files one by one. 

After you have corrected your files, choose the Back button to re-run the import 
simulation. 

If the simulation is successful, go to the next step and choose Import. 

When all the records have been successfully imported, open the business partner master 
data to verify the imported records in SAP Business One. 
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Project Realization: Exercises 

 

 

 

Unit: Data Migration Tools 

Topic: DTW – Item Master Data  

 

In this exercise you will import master data for items, using the 
Data Transfer Workbench. Note: You can also import item 
master data using the Import from Excel utility; however, not 
every field can be imported using the Import from Excel utility, 
including user-defined fields. 

 

1. Create item groups 

Note: You need to first create the item groups for the new items. 

Choose Administration Setup  Inventory  Item Groups. 

Add the new groups: 

 Item Group Name: Lights 

 Item Group Name: Light bulbs 

Choose Add. 

 

Run a query on the OITB table to see the new group codes in your system. You will need 
to import these codes with the master data. 

Make a note of the new group codes: 

Lights  

Light bulbs  

 

© SAP AG 543 TB1200



2. DTW spreadsheets 

From the DTW templates folder, choose Inventory  Item Master Data. 

2.1. Main template 

Open OITM - Items.xlt. 

The items to be imported are all purchased items, available for sale. All items are 
managed using batch number management. 

Enter a row for each item: 

 Laser Light Flood Light Light Bulb - 
Laser  

Light Bulb - 
Flood 

ItemCode LL05 FL05 LBL1 LBF1 

ItemName Laser Light Flood Light Light Bulb - 
Laser  

Light Bulb - 
Flood 

Manufacturer Global 
Light Corp 

Global Light 
Corp 

  

ItemsGroupCode Code for the 
group 
Lights 

Code for the 
group Lights 

Code for the 
group Light 
bulbs 

Code for the 
group Light 
bulbs 

GLMethod glm_ItemCl
ass  

glm_ItemClass glm_ItemClas
s 

glm_ItemClas
s 

CostAccountingM
ethod 

bis_Moving
Average 

bis_MovingAver
age 

bis_MovingAv
erage 

bis_MovingAv
erage 

ManageBatchNu
mbers 

tYES tYES tYES tYES 

Base price 50 100 5 10 

Enter any other 
fields as required 
for your 
localization. 

    

Save the template as a .csv file. 
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2.2. Item Prices 

Open ITM1 - Items_Prices.xlt. 

Enter required fields for the item prices: 

 Laser Light Flood Light Light Bulb - 
Laser  

Light Bulb - 
Flood 

ParentKey LL05 FL05 LBL1 LBF1 

LineNum Leave 
empty 

Leave empty Leave empty Leave empty 

PriceList Base price 
list number 

Base price list 
number 

Base price list 
number 

Base price list 
number 

Price 50 100 5 10 

Currency Local 
currency 

Local currency Local 
currency 

Local 
currency 

 

Note: You can optionally enter an item’s price in multiple price lists. To do this, create 
a separate row in the spreadsheet. 

 

Save the template as a .csv file. 

 

3. Import data 

3.1. Run import 

In DTW, choose Import  Master Data  Add New Data. 

Choose Inventory > Item Master Data.  

Link the .csv files you just created for items and prices to the Items object and the 
Items_Prices object. 

Choose Run Simulation. 

 

3.2. Check for errors 

If any error messages are shown, check the log file. 

After you have corrected your files, choose the Back button to re-run the import 
simulation. 

If the simulation is successful, go to the next step and choose Import. 

When all the records have been successfully imported, open the item master data 
records for the new items. Check the pricing. 
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4. Optional exercise 

Enter item quantities for the previous items using the Goods Receipts template. 

 

From the DTW templates folder, choose Inventory  Inventory Transactions  Goods 
Receipt. 

Open OIGN- Documents.xlt. 

Import a Goods Receipt document:  

Field Description 

DocNum 1 

DocDate Posting date - yyyymmdd 

DocDueDate Due date - yyyymmdd 

Save the template as a .csv file. 

 

Open IGN1- Document_Lines.xlt. 

Enter the rows in the Goods Receipt document: 

Field Row 1 Row 2 Row 3 Row 4 

ParentKey 1 1 1 1 

LineNum Leave blank    

ItemCode LL05 FL05 LBL1 LBF1 

Quantity 12 30 500 500 

Price 25 50 2 5 

Warehouse 1 1 1 1 

AccountCode You can specify an inventory account for the journal posting. 
If you leave this blank, the default inventory account will be 
used. 

Save the template as a .csv file. 

 

In DTW, choose Import  Transactional Data  Add New Data. 

Choose Inventory > Inventory Transactions > Goods Receipt.  

Link the .csv files you just created to the Documents and the Document_Lines objects. 

Import the data. 

 

Check the journal entry posted by the imported Goods Receipt. 

 

Check the item quantities in the item master data. 
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Project Realization: Solutions 

 

 

Unit: Data Migration Tools 

Topic: DTW – Item Master Data  

 

In this exercise you will import master data for items, using the Data Transfer Workbench. 
Note: You can also import item master data using the Import from Excel utility; however, not 
every field can be imported using the Import from Excel utility, for example,  user-defined 
fields. 

 

1. Create item groups 

Note: You need to first create the item groups for the new items. 

Choose Administration Setup  Inventory  Item Groups. 

Add the new groups: 

 Item Group Name: Lights 

 Item Group Name: Lightbulbs 

Choose Add. 

 

Run a query on the OITB table to see the new group codes in your system. You will need 
to import these codes with the master data. 

Make a note of the new group codes: 

Lights  

Light bulbs  
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2. DTW spreadsheets 

From the DTW templates folder, choose Inventory  Item Master Data. 

2.1. Main template 

Open OITM - Items.xlt. 

The items to be imported are all purchased items, available for sale. All items are 
managed using batch number management. 

Enter a row for each item: 

 Laser Light Flood Light Light Bulb - 
Laser  

Light Bulb - 
Flood 

ItemCode LL05 FL05 LBL1 LBF1 

ItemName Laser Light Flood Light Light Bulb - 
Laser  

Light Bulb - 
Flood 

Manufacturer Global 
Light Corp 

Global Light 
Corp 

  

ItemsGroupCode Code for the 
group 
Lights 

Code for the 
group Lights 

Code for the 
group Light 
bulbs 

Code for the 
group Light 
bulbs 

GLMethod glm_ItemCl
ass  

glm_ItemClass glm_ItemClas
s 

glm_ItemClas
s 

CostAccountingM
ethod 

bis_Moving
Average 

bis_MovingAver
age 

bis_MovingAv
erage 

bis_MovingAv
erage 

ManageBatchNu
mbers 

tYES tYES tYES tYES 

Base price 50 100 5 10 

Enter any other 
fields as required 
for your 
localization. 

    

Save the template as a .csv file. 
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2.2. Item Prices 

Open ITM1 - Items_Prices.xlt. 

Enter required fields for the item prices: 

 Laser Light Flood Light Light Bulb - 
Laser  

Light Bulb - 
Flood 

ParentKey LL05 FL05 LBL1 LBF1 

LineNum Leave 
empty 

Leave empty Leave empty Leave empty 

PriceList Base price 
list number 

Base price list 
number 

Base price list 
number 

Base price list 
number 

Price 50 100 5 10 

Currency Local 
currency 

Local currency Local 
currency 

Local 
currency 

 

Note: You can optionally enter an item’s price in multiple price lists. To do this, create 
a separate row in the spreadsheet. 

 

Save the template as a .csv file. 

 

3. Import the data 

3.1. Run import 

In DTW, choose Import  Master Data  Add New Data. 

Choose Inventory > Item Master Data.  

Link the .csv files you just created for items and prices to the Items object and the 
Items_Prices object. 

Choose Run Simulation.  

 

3.2. Check for errors 

If any error messages are shown, check the log file. 

After you have corrected your files, choose the Back button to re-run the simulation. 

If the simulation is successful, go to the next step and choose Import. 

When all the records have been successfully imported, open the item master data 
records for the new items. Check the pricing. 
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4. Optional exercise 

Enter item quantities for the previous items using the Goods Receipts template. 

 

From the DTW templates folder, choose Inventory  Inventory Transactions  Goods 
Receipt. 

Open OIGN- Documents.xlt. 

Import a Goods Receipt document:  

Field Description 

DocNum 1 

DocDate Posting date - yyyymmdd 

DocDueDate Due date - yyyymmdd 

Save the template as a .csv file. 

 

Open IGN1- Document_Lines.xlt. 

Enter the rows in the Goods Receipt document: 

Field Row 1 Row 2 Row 3 Row 4 

ParentKey 1 1 1 1 

LineNum Leave blank    

ItemCode LL05 FL05 LBL1 LBF1 

Quantity 12 30 500 500 

Price 25 50 2 5 

Warehouse 1 1 1 1 

AccountCode You can specify an inventory account for the journal posting. 
If you leave this blank, the default inventory account will be 
used. 

Save the template as a .csv file. 

 

In DTW, choose Import  Transactional Data  Add New Data. 

Choose Inventory > Inventory Transactions > Goods Receipt.  

Link the .csv files you just created to the Documents and the Document_Lines objects. 

Import the data. 

 

Open a Goods Receipt document by choosing Inventory  Inventory Transactions  
Goods Receipt. 

Browse to the last record. 

Choose the link arrow in the Goods Receipt document to open the posted journal entry. 

Check the accounts in the journal entry. 

 

Choose Inventory  Item Master Data. 

Open one of the items and check the item quantities in the item master data. 
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Final Preparation: Exercises 

 

 

 

Unit: Data Migration Tools 

Topic: Opening Balances 

 

Note: the assumption for this exercise is that the client is starting 
with the SAP Business One system at the start of a new fiscal 
year. Therfore, P&L balances do not need to be carried forward. 

 

 

The Balance Sheet from the client’s legacy system shows the following: 

Balance Sheet 

Date: today 

Assets: 

National Bank 200,000

Petty cash 5,000

Inventory 60,000

Office buildings (warehouse) 350,000

Office and warehouse 
equipment 

150,000

A/R 79,000

VAT receivable 4,000

Total assets:  848,000 

   

Liabilities: 

A/P 35,000

VAT payable 8,000

Bank loan 150,000

Total liabilities:  193,000 
   

Equity / Capital and Reserves:

Retained earnings 155,000

Share capital  500,000

Total equity:  655,000 
   

Total Liabilities & Equity:  848,000 
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1. Create an Opening Balance Offset Account 

Add a new G/L account called Opening Balance Offset to the Equity / Capital and 
Reserves drawer of the chart of accounts. 

In the G/L account determination, set this account as the default Opening Balance 
Account in the General tab. 

 

2. Business Partner Opening Balances 

Note: This exercise assumes that the following business partners have been created in 
the database in the DTW – Business Partners exercise. If the business partners do not 
exist, you should create them first. 

 

Choose Administration  System Initialization  Opening Balances  Business 
Partners Opening Balance. 

Make sure the opening balances account is selected from the G/L account 
determination. 

Select the 1st day of the current month as the posting date. 

Enter reference information in the Ref.1 field. 

Enter the balances for the business partners: 

Due Date Business Partner Balance 

One week ago London Coliseum 64,000 

One week ago MAX Hotel Group 15,000 

Two weeks ago Sound Systems Ltd. -25,000 

Two weeks ago Global Electronics 
Corp 

-10,000 

Note: To enter a credit balance, you must use the minus ‘-‘ sign. 

Open one of the journal entries posted by the opening balance transaction. 

Open the business partner master data for one of the business partners. Run the aging 
report to check that the due date is correct. 

Open the chart of accounts and write down the balance of the opening balances account 
_________________. 
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3. Item Quantities and Opening Balances 

Note: This exercise assumes that the following items have been created in the database 
in the DTW – Item Master Data exercise. If the items do not exist, you should create 
them first. 

Choose Inventory  Inventory Transactions  Inventory Opening Balance. 

Select the 1st day of the current month as the posting date and enter a reference for the 
journal entry that will be posted. 

Enter the opening balance quantity and item cost for the items. Select the opening 
balance offset account on each row. 

Item  Opening Balance Unit Price Account Code 

Laser Light 200 50 Select the opening 
balance account. 

Flood Light 200 100 Select the opening 
balance account 

Light Bulb - Laser 1000 5 Select the opening 
balance account 

Light Bulb - Flood 2500 10 Select the opening 
balance account 

 

For each row, right-mouse click and select Serial and Batch Selection from the 
context menu. 

Enter a batch number and the quantity. 

Choose Update then OK to save the batch information. 

Choose Add. 

 

Check the journal entries posted by the transaction. The posting has debited the 
inventory account defined in the G/L account determination. 

Write down the account number for the inventory account _________________. 

Open the item master data for one of the items. Select the Inventory Data tab and verify 
the In Stock quantity. 

Open the chart of accounts and write down the balance of the opening balances account 
_________________. 
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4. G/L Account Opening Balances 

Choose Administration  System Initialization  Opening Balances  G/L 
Accounts Opening Balance. 

Make sure the opening balances account is selected from the G/L account determination. 

Enter a reference for the journal entry. 

Select the 1st day of the current month as the posting date. 

Enter balances from the provided Balance Sheet: 

 Avoid entering duplicate values for the inventory account. Postings were made 
to this account when you entered the item opening balances. 

 Avoid entering duplicate values for the A/R and A/P accounts. 

Note: To enter a credit balance, you must use the minus ‘-‘ sign. 

 

5. Check the Opening Balance Account 

If you entered the balances correctly, the Opening Balance Offset account should have 
a zero balance.  

If the account is not zero, investigate the account history. Did you enter credit balances 
correctly? 

 

6. Optional exercise 

Enter a payment for one of the business partners. 

Choose Banking  Incoming Payments  Incoming Payments. 

Select one of the customers for which you entered an opening balance in step 2. 

Select the Opening Balance journal entry and make the payment! 
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Final Preparation: Solutions 

 

 

Unit: Data Migration Tools 

Topic: Opening Balances 

 

Note: the assumption for this exercise is that the client is starting with the SAP Business One 
system at the start of a new fiscal year. Therfore, P&L balances do not need to be carried 
forward. 

The Balance Sheet from the client’s legacy system shows the following: 

Balance Sheet 

Date: today 

Assets: 

National Bank 200,000

Petty cash 5,000

Inventory 60,000

Office buildings (warehouse) 350,000

Office and warehouse 
equipment 

150,000

A/R 79,000

VAT receivable 4,000

Total assets:  848,000 

   

Liabilities: 

A/P 35,000

VAT payable 8,000

Bank loan 150,000

Total liabilities:  193,000 
   

Equity / Capital and Reserves:

Retained earnings 155,000

Share capital  500,000

Total equity:  655,000 
   

Total Liabilities & Equity:  848,000 
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1. Create an Opening Balance Offset Account 

Choose Financials  Chart of Accounts. 

Add a new G/L account called Opening Balance Offset to the Equity / Capital and 
Reserves drawer of the chart of accounts. 

Choose Administration  Setup  Financials  GL Account Determination  GL 
Account Determination. 

In the G/L account determination, set this account as the default Opening Balance 
Account in the General tab. 

Choose Update. 

 

 

2. Business Partner Opening Balances 

Note: This exercise assumes that the following business partners have been created in the 
database in the DTW – Business Partners exercise. If the business partners do not exist, 
you should create them first. 

Choose Administration  System Initialization  Opening Balances  Business 
Partners Opening Balance. 

Choose OK. 

Make sure the opening balances account is selected from the G/L account 
determination. 

Select the 1st day of the current month as the posting date. 

Enter reference information in the Ref.1 field. 

Enter the balances for the business partners: 

Due Date Business Partner Balance 

One week ago London Coliseum 64,000 

One week ago MAX Hotel Group 15,000 

Two weeks ago Sound Systems Ltd. -25,000 

Two weeks ago Global Electronics 
Corp 

-10,000 

Note: To enter a credit balance, you must use the minus ‘-‘ sign. 

Choose Add. 

Open one of the journal entries posted by the opening balance transaction. 

Open the business partner master data for one of the business partners. Drill-down to 
the Account Balance. Run the aging report to check that the due date is correct. 

Open the chart of accounts and write down the balance of the opening balances account 
_________________. 
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3. Item Quantities and Opening Balances 

Note: This exercise assumes that the following items have been created in the database in 
the DTW – Item Master Data exercise. If the items do not exist, you should create them 
first. 

Choose Inventory  Inventory Transactions  Inventory Opening Balance. 

Select the 1st day of the current month as the posting date and enter a reference for the 
journal entry that will be posted. 

Enter the opening balance quantity and item cost for the items. Select the opening 
balance offset account on the row. 

Item  Opening Balance Unit Price Account Code 

Laser Light 200 50 Select the opening 
balance account. 

Flood Light 200 100 Select the opening 
balance account 

Light Bulb - Laser 1000 5 Select the opening 
balance account 

Light Bulb - Flood 2500 10 Select the opening 
balance account 

 

Add batch information for each item row. For each row, right-mouse click and select 
Serial and Batch Selection from the context menu. 

Enter a batch number and the quantity. 

Choose Update then OK to save the batch information. 

Choose Add. 

 

Check the journal entries posted by the transaction. The posting has debited the 
inventory account defined in the G/L account determination. 

Write down the account number for the inventory account _________________. 

Open the item master data for one of the items. Select the Inventory Data tab and verify 
the In Stock quantity. 

Open the chart of accounts and write down the balance of the opening balances account 
_________________. 
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4. G/L Account Opening Balances 

Choose Administration  System Initialization  Opening Balances  G/L 
Accounts Opening Balance. 

Choose OK. 

Make sure the opening balances account is selected from the G/L account determination. 

Enter a reference for the journal entry. 

Select the 1st day of the current month as the posting date. 

Enter balances from the provided Balance Sheet: 

 Avoid entering duplicate values for the inventory account. Postings were made 
to this account when you entered the item opening balances. 

 Avoid entering duplicate values for the A/R and A/P accounts. 

Note: To enter a credit balance, you must use the minus ‘-‘ sign. 

 

5. Check the Opening Balance Account 

If you entered the balances correctly, the Opening Balance Offset account should have 
a zero balance.  

If the account is not zero, investigate the account history. Did you enter credit balances 
correctly? 

 

6. Optional exercise 

Enter a payment for one of the business partners. 

Choose Banking  Incoming Payments  Incoming Payments. 

Select one of the customers for which you entered an opening balance in step 2. 

Select the Opening Balance journal entry and make the payment! 
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This topic focuses on how to prepare a customer for support, and how to use the 
SAP support processes to solve your customer’s problems.
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On completion of this topic, you will be able to:

• Explain the partner support responsibilities 

• Use the SAP search and logging tools

• Follow the required process for reproducing, researching and submitting a 
support message to SAP supportsupport message to SAP support

• Describe the advantages of Remote Support Platform for supporting a 
customer
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Partner companies are required to set up a support organization with an 
experienced, fully staffed support desk. When setting up a support department to 
support your customers, you need to make sure that the support consultant 
follows the SAP standard support processes.

In addition to knowledge of the SAP Business One application, a support 
consultant needs to know how to use the tools provided by SAP to diagnose and p y g
manage customer problems.
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In the first part of this topic, we will cover setting up support.
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The SAP Business One Support Cycle Navigator is available on the PartnerEdge
portal and provides the overall process and guidelines for a partner to establish a 
support department and work with SAP support.

After the customer has gone live, and when critical post go-live issues are 
resolved, you need to transition the customer to support mode. Follow these 
steps:p

 Review and agree support procedures with the customer. The responsibilities 
for the production system may have been defined in a Service Level 
Agreement. In addition, you as the partner may agree to perform additonal 
duties such as database administration, if requested by the customer.

 Install and activate Remote Support Platform (RSP) to monitor and maintain 
the system status. Run the System Status Report which gets transmitted to 
SAP t R t S t Pl tf i d l t i thi t iSAP support. Remote Support Platform is covered later in this topic. 

 Hand over the customer to your own (partner) support department. Provide 
your support hotline number and support hours to the customer. 

 Provide an S-User number to the customer. Make sure the customer can use 
the customer portal and can create support messages. 
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Support at level 1 and 2 is provided by the partner, and SAP only gets involved at 
level 3* when there is a software defect with the SAP Business One application. 

Customers purchase maintenance from the partner, and not from SAP. A portion 
of the maintenance that customers pay goes to you as a partner for level 1 and 2 
support. The customer must be current on maintenance in order to receive Level 3 
support from SAP. pp

Customers who pay maintenance also receive upgrades to new releases, 
patches, legal enhancements from SAP, and proactive monitoring from SAP using 
the Remote Support Platform. Therefore as a partner you should ensure your 
customer is on maintenance. If a customer’s maintenance contract has lapsed, 
the customer  will be redirected to the license portal) instead of the Customer 
Portal when they try to log in. Furthermore, as a partner you will be unable to 
create a support ticket for customers who are out of maintenancecreate a support ticket for customers who are out of maintenance.

Note: Always check the latest maintenance policy published on the PartnerEdge 
portal.

*Some large enterprise customers receive support from the SAP LE Competence 
Center.
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It is essential that you have a clear understanding of the support levels:

 Level 1 and 2: When the customer reports a problem to you, you are required 
to perform initial troubleshooting. This includes searching existing information 
sources, including SAP notes, to determine if there is an available solution. If 
you cannot find a documented solution, you should reproduce the problem on 
your own system, using the demo database and the latest patch level. If y y , g p
possible, provide a workaround to the customer. Only if you are sure the 
problem is in SAP Business One, and is reproducible, should you create a 
message to SAP. You need to provide as much information as possible, 
including screen shots, and events leading up to the problem. 

 Level 3: SAP is only responsible for supporting problems that are directly 
caused by the SAP Business One software. SAP will validate the accuracy 
and completeness of the message analyze and reproduce the incident and ifand completeness of the message, analyze, and reproduce the incident, and if 
necessary, with your help will access the customer system or request the 
customer database to diagnose the problem.  SAP will provide a fix or 
workaround to get the customer working again. SAP will document the 
problem and solution as an SAP Note to assist other partners.
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You need to provide your customer with the s-user account and password. This 
enables them to login to the SAP Business One customer portal, where they can 
create support messages to you, as an alternative to using your support hotline. 

Customers can create support messages from either the SAP Business One 
application using the menu Help  Support Desk, or from the support area on the 
customer portal. Customers can additionally research problems including p y p g
searching the SAP Notes database to solve problems on their own. 

Note: If the customer creates a support message, it will be automatically 
forwarded to you for Level 1 and 2 support. It does not go to SAP. If the customer 
reports the problem directly to you by phone, you will create the support message 
if you require Level 3 support from SAP.
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There are several ways for a partner to contact SAP Business One Product 
Support:

• Message Wizard: To report a problem to SAP for level 3 support, use the 
message wizard. This is the preferred way of contacting support.

• SAP support hotline: Use the hotline to contact SAP Support in case you need 
to follow up on a previously submitted support message or in case you areto follow up on a previously-submitted support message, or in case you are 
working at the customer site and there is no Internet access. The hotline 
number is published in the portal on the contacts page per country. Hotlines are 
open from 9 am to 6 pm local time. 

• SAP Business One Duty Manager: The Duty Manager can be contacted only in
very exceptional cases, in which the core business processes of your 
customer’s system are affected outside the working hours. 

When communicating with SAP support, English is the preferred language, and a 
local language is provided only where available.
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In the next part of this topic, we will cover support tools.
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If a problem occurs with SAP Business One, your customer can use the Support 
Desk function in the SAP Business One application to connect directly to the 
support services.

The customer can perform the following actions:

• Search the support databases for known solutions to a problem they are 
encounteringencountering

• Access the customer portal to create a support message to the partner

• Track the status of existing support messages

To use the SAP Support Desk the customer needs:

• A valid maintenance contract with SAP

• A valid S-User

• An Internet connection
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The Partner Support Dashboard is the partner’s main interface for supporting 
customers and is accessed from the Support area of the PartnerEdge portal.

Here you can see a summary of your open support messages, and you can create 
new support messages from here using the SAP Message Wizard.

You can also view messages for the partner organization, and messages 
submitted to SAPsubmitted to SAP.

Customers can track messages in the customer portal. Additionally the customer 
can be notified by email when you send them a new message.

© SAP AG 572 TB1200



Before creating a support message to SAP, you should search to see if this is a 
known problem, with a solution.

The cross search is the main tool for research, and allows you to search several 
SAP Business One repositories simultaneously, making your search process 
faster. The cross search searches in:

• Support Content• Support Content

• SAP Notes

• Portal pages

• Help and product documentation, including add-on documentation

• Community content. Note: SAP assumes no responsibility and offers no 
guarantee for the information or content in the community content.
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SAP Notes are solutions for known problems. Whenever a new problem occurs 
and is subsequently solved by SAP, SAP creates an SAP Note describing the 
problem and the solution. 

You can search by keywords, by application area, by software release, or any 
combination of these. 

A selection of SAP notes is published as SAP Hot News and you can subscribe toA selection of SAP notes is published as SAP Hot News and you can subscribe to 
receive them on your partner portal homepage or in a personalized newsletter. 
SAP Hot News are very high priority SAP customer notes. These notes tell you 
how to resolve or avoid problems that can cause the SAP system to shut down or 
lose data. 
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SAP Business One supports logging and tracing of events at the business 
information level and the system information level during application 
execution. Only SAP channel partners, SAP Business One super users, 
and SAP Business One authorized regular users can access the Logger 
Settings window. 

During support processing you may be asked by SAP support to enableDuring support processing, you may be asked by SAP support to enable 
this logging. 

The business information level logs information about business flow and 
business objects. The logs contain all events that are triggered by the 
actions of users in SAP Business One. This information is displayed to 
users in the System Messages Log at the bottom of the client screen.

Th t i f ti l l l ll i t l t h i l ThThe system information level logs all internal technical messages. These 
messages contain technical information about the following: 

• Internal errors (for example, ODBC error codes, memory errors), 
warnings, and information messages 

• Comments from developers 

• Performance loggingPerformance logging 

You can select the severity levels at both the Business Information level 
and the System Information level. 
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The log files provide a source of information that is useful when dealing with 
incident reports and searching for solutions. 

SAP Business One creates a new log file on every startup. The log files are text 
files containing:

• The event

Th ti th t h d• The time the event happened 

• The exact source code line the event refers to 

• The event’s message content 

The log files have a unique, predefined name that contains a date, a time stamp, 
and the Process ID (PID) of the SAP Business One application that created the 
file. Tracing and logging information, all types of event levels, and severity levels 

t d t th i l filare stored together in one log file. 

The log file size is restricted to 5 MB. After the file exceeds the maximum size, 
SAP Business One creates a new file. The number of log files that can be stored 
in a logging directory depends on the configuration of the folder size. 

For more information, refer to the how-to guide How to Work with Logging and 
Tracing in SAP Business OneTracing in SAP Business One.
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In the next part of this topic, we will cover the creation of support messages to 
SAP support.
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When the customer reports an error to you, you must follow SAP’s support 
processes:

• Search all available SAP resources to see if known solutions to the customer 
problem have been clearly documented by SAP. If the issue is known and is 
resolved in a patch, it is your responsibility to upgrade the customer.

• Reproduce the problem at your own site using a copy of the customer• Reproduce the problem at your own site using a copy of the customer 
database.  If you can reproduce the problem, test it again using the latest patch 
and release level.

• Even if you can reproduce the problem, it might be caused by something in the 
client environment that is outside of SAP Business One. Therefore you need to 
determine if the problem is caused by SAP Business One. You may need to 
check log files in SAP Business One. 

• If you can reproduce the problem at the latest patch and release level, and 
have isolated it to SAP Business One, then create a support message to SAP.  
You should discuss the business impact with the customer so you can assign 
the appropriate priority.

• Provide enough detail for SAP to process the problem. Include a clear 
description of the problem, with the exact error message, screenshots, and the 
steps you have taken at level 1 and 2 You should create messages in Englishsteps you have taken at level 1 and 2. You should create messages in English.

© SAP AG 578 TB1200



From the Partner Support Dashboard, you can launch the SAP Message Wizard. 
The wizard guides you through the process:

• Choose the customer from your list of customers. SAP expects the partner to 
open a message using the correct customer ID.

• Choose the system (if the customer has multiple systems)

SAP Note 722980 contains some guidelines for creating a support message. 
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Prepare the solution by entering a brief description of the problem and selecting 
the applicable component so that the message can be routed quickly to the right 
support group in SAP.
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The wizard will automatically display all know issues that match the problem 
description you entered. This allows you to thoroughly research possible solutions.

You can also use the cross-search, or search SAP Notes from this step in the 
wizard.
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When you create a support message to SAP, you must select a priority. The 
priority reflects the impact that the problem has on the customer’s business 
operations:

• Very High - You should only assign the Very High priority if the problem is 
business-critical, has serious consequences for business operations, and 
requires an immediate solution. Note: You must provide a phone number so 
th t SAP t t t Thi i ll d b th f ll ithat SAP support can contact you. This is generally caused by the following 
circumstances:

 Absolute loss of a system

 Malfunctions of core SAP system functions in the production system

• High - You should assign the High priority if critical business transactions are 
affected and urgent tasks cannot be executed. There is some disruption to the 
customer’s business but the whole business is not stopped. pp

• Medium - You should assign the Medium priority if non-critical business 
operations are affected. This includes a function that is temporarily unavailable 
or does not work properly. Work can continue.

• Low – You should assign the Low priority if the problem has little influence on 
business operations and does not hinder daily operations. This includes a 
function that is temporarily unavailable or does not work properly, which is not 
required for the daily business processrequired for the daily business process.

Tip: SAP Note 795206 contains a full definition of the priorities, and instructions 
for proceeding with a very high message priority.
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In the first scenario, there is a possibility that the database is corrupt. In this case 
the priority would be set as Very High; otherwise the priority should be set as High.

In the second scenario, even through the system is working normally, the printing 
of invoices is a key task. If no invoices can be printed by all users, the priority 
should be set as High. If some users can print invoices, the priority should be set 
as Medium.

When assessing the priority of a message, a partner can also consider the 
following factors to help evaluate the business impact to the customer:

• Volume: How many documents or transactions are affected? 

• Frequency: How often is the error occurring? 

I th t h i b t t h th t i ht ff t th• Is there any event happening or about to happen that might affect the 
frequency, such as end-of-year processing or financial audits?

• Value: What is the cost/value of the transactions/documents affected?

• Workaround: Is there one?
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In the final step you need to supply information on the scenario that caused the 
problem, the actual and expected result, and the research you have done so far.

You can include attachments in this step of the wizard. 

At any time you can save the message as a draft and work on it later, or submit to 
SAP support.
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In the final part of this topic, we will cover the Remote Support Platform.
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It is an obligation to install and activate Remote Support Platform (RSP) for 
customer installations as outlined in the Maintenance Contract for SAP Business 
One.

Remote Support Platform (RSP) is the primary platform for monitoring your 
customer’s systems. RSP is provided with the software installation files. RSP can 
be automatically installed with the SAP Business One Server, or can be installed y ,
independently.

RSP monitors the health of the SAP Business One applications, the databases, 
and the underlying hardware such as disk and memory. It also enables SAP to 
proactively diagnose system bottlenecks and prevent system issues. 

Note: RSP is updated independently of SAP Business One releases. p p y
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Remote support platform is installed on the customer’s SAP Business One server. 
It uses its own database, and does not affect any company databases. RSP 
provides a secure connection between the customer and SAP for end-to-end 
support. The components of RSP include:

• RSP agent service. The server side of the remote support platform for SAP 
Business One is installed on the SAP Business One server. The agent service g
downloads tasks from and uploads task results to the SAP backend of the 
remote support platform. The agent service also requires that the customer 
provide an SMTP server for email delivery of reports. 

• RSP agent console. The client side of the remote support platform for SAP 
Business One is either installed on the same computer as the agent service, or 
can connect to the agent service from a different computer on the same 
network The customer can administer RSP from this dashboard consolenetwork. The customer can administer RSP from this dashboard console. 

• SAP backend. Management software installed at SAP that is used to manage 
the remote support platform for SAP Business One support tasks. The SAP 
backend is exposed as Web services, and the agent service communicates 
with the SAP backend via HTTPS-based Web services calls. The customer’s 
server must have an internet connection.

• RSP studio for SAP Business One. The studio is a development and p
management tool for SAP partners. With this tool, partners can develop tasks, 
deliver self-developed tasks to customers, and manage self-delivered tasks for 
different customer installations. 
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The agent console provides an on site interface for the customer to monitor their 
system. 

The console displays the system status indicators for each database. 

Once the connection is set up, SAP will send tasks to the RSP agent. 

From the console you can access and run these tasks, and send the results to 
SAP Y l d l d ft d t d l d d t b t SAPSAP. You can also download software updates, and upload databases to SAP 
support.

As a partner you can access the tasks in the customer’s console remotely. If you 
enable Allow Remote Management in the agent consoles for your customers, you 
can monitor multiple customers using a web-based interface called remote 
console A link to the remote console is provided on the SAP Partneredge portalconsole. A link to the remote console is provided on the SAP Partneredge portal. 
You need an s-user to access the web-based interface.
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After installation, you need to configure RSP by running the initialization wizard. The 
wizard opens up automatically after you install RSP. After you successfully configure the 
settings, in the final step, you can generate and automatically send a system status report 
to SAP, which registers the installation of the remote support platform. You can also 
configure RSP from the agent console screen by choosing Configuration from the menu.

The four main configuration areas are:

• Directory channel. This is optional. If you enable it, provide a file path for the storage of 
task results. A path to a folder for content upload. You can specify a window of time for 
the upload as well as a maximum upload rate to conserve network bandwidth.

• E-mail channel. The e-mail channel optional and is used to send notifications to the 
customer when certain events occur. To configure it, provide the customer SMTP 
server settings and email address. If you do not want the remote support platform to 
send out e-mail notifications, do not enable the e-mail channel.

• SAP channel. You must configure the SAP channel. Provide the license information 
and the s-user and password for authentication. The agent service cannot connect to 
the SAP backend without these credentials. From here you can select the option to 
allow the partner to remotely manage the system using the remote console.

• Partner channel. The partner channel is optional, but if you enable and configure it, the 
RSP agent service can retrieve tasks created by the partner and send task results 
back to the partner’s WebDAV server.

Other menus are available from the agent console Configuration menu to configure and 
schedule database backups using RSP. 
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RSP uses tasks to monitor and manage a system. At scheduled times, the agent 
service automatically connects to SAP to download new and updated tasks. From 
the agent console you can view and run tasks from SAP. The customer always 
has the option to approve or reject a task and can elect to run tasks automatically, 
based on a schedule, or manually.

The task for the system status report is built-in and visible immediately after RSP 
is installed. It checks available disk space, backup statistics, and data load of the 
customer’s installation. The customer is informed of the results. The system status 
report must be run at this point, since it registers RSP with SAP support. 

This report should be run on a regular basis, and identifies critical issues before 
they become a problem. And since SAP has this information, it can result in faster 
support from SAP.
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Other tasks are provided to streamline support and maintenance and include:

• System data describes the technical information on a customer’s installation 
and must be kept up-to-date by the partner. RSP eliminates the need to 
manually update this data by automatically sending the installation data to SAP.

• Ongoing diagnosis of issues is provided without manual intervention. For 
known problems SAP transmits a report with a resolution to the issue Theknown problems, SAP transmits a report with a resolution to the issue. The 
support partner can, with the customer agreement, run a self-healing wizard 
task and apply a fix to the customer’s system.

• Customers and partners receive proactive notifications on new software 
updates and can either set RSP to automatically download recommended 
updates, or choose to manually manage the updates. There is an option to 
specify a bandwidth speed and time of day to avoid connectivity lags during 
b i h N t RSP i it lf i t i d i il t i t ll ti dbusiness hours. Note: RSP is itself maintained using silent installations and 
upgrades, eliminating additional configuration or maintenance efforts from the 
customer.

• Using RSP, partners or customers can establish a backup schedule to 
automatically backup company databases, including attachments, according to 
the schedule.
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Company databases can be backed using either the Microsoft SQL Server backup 
function, or using the Remote Support Platform (RSP).

• The Microsoft SQL Server Management Studio backup supports backup to both 
disk and tape. It does not backup the files in the shared server folders, 
therefore you must back these up separately.

• The Remote Support Platform provides built in backup services You need to• The Remote Support Platform provides built-in backup services. You need to 
enable RSP backups first, from the agent console. You can schedule daily, 
weekly, and monthly backups and perform differential and full database 
backups. The RSP backup service also includes the shared server folders. 

Note that the SBO-Backup service from older releases of SAP Business One has 
been superseded by functionality in Remote Support Platform (RSP).p y y pp ( )
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During the process of level 3 support,  a partner may receive a request for the 
customer database from SAP.  The support partner can easily upload the 
database using RSP. The database is automatically compressed for upload.

If you receive a task requesting you to upload a company database to SAP 
Support, you can do this using the Content Upload Wizard available on the 
Download & Upload tab of the agent console.p g

This replaces the FTP service used in prior releases of SAP Business One.
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The Remote Support Platform (RSP) Studio for SAP Business One enables 
partner companies to create their own tasks for customers. Partners can 
download tasks to customers and upload task results. An example might be a task 
to monitor an installed add-on.

The Studio provides a development environment for creating simple and 
d d t kadvanced tasks:

• Simple SQL tasks allow the partner to run perform basic database operations

• Simple PowerShell tasks allow the partner to perform remote administrative 
tasks on customers' Microsoft Windows operating systems. These tasks are 
created using Microsoft Windows PowerShell scripting. Templates are provided 
to quickly create these tasks based on common scenarios.

• Advanced tasks enable the partner to perform remote administration on the 
customer’s system, or to request a customer database upload.

Note: For more information, refer to the how-to guide Working with the Remote 
Support Platform Studio for SAP Business One .
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Write down the quick links for access to the resources on the portal:

_______________________________________________________

_______________________________________________________

_______________________________________________________

_______________________________________________________

_______________________________________________________

_______________________________________________________

_______________________________________________________

_______________________________________________________

_______________________________________________________

_______________________________________________________
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Here are some key points to take away from this session:

 The SAP Business One Support Cycle Navigator is a guide that you can follow to set 
up a support department. You can find the information on the PartnerEdge Portal.

 Customers must pay for maintenance in order to receive support. Support level 1 and 
2 is provided by the partner, and SAP only gets involved at level 3 when there is a 
software defect in SAP Business One If the customer creates a support message itsoftware defect in SAP Business One. If the customer creates a support message, it 
will be automatically forwarded to you for support. It does not go to SAP. 

• You are required to follow SAP’s support processes. You must isolate the problem to 
SAP Business One before you create a support message. The Partner Support 
Dashboard is the partner’s main interface for supporting customers and is accessed 
from the Support area of the PartnerEdge portal. You can use SAP search tools from 
here to search for known solutions for a problem.

• When you create a support message to SAP, you must select a priority. The priorityWhen you create a support message to SAP, you must select a priority. The priority 
reflects the impact that the problem has on the customer’s business operations.

• It is an obligation to install and use Remote Support Platform (RSP) for customer 
installations as outlined in the Maintenance Contract for SAP Business One.

• Remote Support Platform enables proactive support for customers and performs 
ongoing diagnosis of issues without manual intervention.

• RSP automatically updates the customer’s system data, thereby eliminating the need 
to manually update this datato manually update this data.
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In the case study, you will put together a prototype solution for Light & Music.
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Your instructor will notify you of how much time you have to work on the case 
study. After you have finished the case study, you will have a fixed time slot to 
demo your solution, usually 30 minutes for each team. 

The project manager in the team should introduce the team, show the project 
plan, and outline the requirements you have identified as a team. 

The other team members are implementation consultants and should be preparedThe other team members are implementation consultants, and should be prepared 
to demo the solution meet the requirements.

© SAP AG 599 TB1200



© SAP AG 600 TB1200



 

 

TB1200 Case Study    Page 1 

Case Study 
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SAP Business One 
to Depict the Business Processes at 

Light & Music Ltd. 
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1. Introduction 
Light & Music Ltd. needs an integrated Enterprise Resource Planning (ERP) system to 
support its business processes and advance its plans for expansion. A comparison of various 
products revealed that SAP Business One provides the best solution to meet the company's 
requirements and its plans for expansion. Therefore, Light & Music Ltd. has purchased a 
license for SAP Business One and now wishes to install the product in the company.  

The managing director and company owner, Michael Smith, has decided to hire you to 
implement SAP Business One. However, before beginning the implementation, Mr. Smith 
wants to see how you intend to depict some of their special business processes using SAP 
Business One. This is the system specifications document that outlines those requirements.  

Your task is to implement the business processes defined in the system specifications in SAP 
Business One and to present an implementation plan and your prototype to Mr. Smith 
tomorrow. 

2. Company Background 
Light & Music Ltd. is a legally independent company that specializes in selling and installing 
professional media presentation systems for exhibitions and events. They also offer 
consultancy services in planning audio-visual communication systems for new concert 
stadiums and concert halls.  

The company was founded 1990 in London but they have expanded with additional offices to 
make their services available nationwide. The head office, which also includes their 
administration, is in London but they also have offices in Cardiff, Wales and Glasgow, 
Scotland.  

Michael Smith sees the introduction of an ERP system as his own personal duty and wants to 
be able to control the efficiency of his business processes at any time. In addition, he also 
wants to have full security over user access to the system. 

3. Implementation Methodology 
The SAP Business One Accelerated Implementation Program (AIP) provides a 
comprehensive implementation methodology for SAP Business One partners with detailed 
information on how to successfully complete and manage the implementation of SAP 
Business One.  

The project plan that you will present to Light & Music will be based on the tasks and phases 
in the AIP. You should also state which of the tools and templates you will find useful to 
manage the project. 

The stakeholders at Light & Music want to monitor the progress of the SAP Business One 
implementation and the tasks assigned to members of the implementation project team. 
Project documentation must be stored in a central, shared location so that all business 
process owners can access it.  
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4. Master Data 

4.1.  Items 

Light & Music Ltd. stocks a total of 500 items. They can be grouped in the following way: 

 Screens. Screens are LCD and LED displays. They are sold as multi-screens, which 
are huge presentation screens made up from several 40-inch LCD displays. Light & 
Music Ltd. produces these multi-screens themselves and they are offered in the 
standard sizes 3x3, 4x4, and 5x5. They always keep a few multi-screens in stock 
since these are very popular and Light & Music Ltd. is the only supplier in the UK. 
Each multi-screen consists of the required number of 40-inch LCD displays together 
with a PC that splits the picture into the screen segments. Larger multi-screens can be 
built to order for a customer.  

 

 Projectors. This group includes video projectors, slide projectors, and overhead 
projectors. 

 Lights. Laser lights, flood lights and spotlights are sold individually to customers. 

 Light bulbs. Replacement bulbs are sold for the lighting equipment. Light & Music 
buys bulbs in bulk, usually in containers of 50 boxes. Each box contains 10 bulbs. 
Bulbs can be sold as individual replacements, or may also be sold in boxes or 
containers.  

 Computers. This group includes PCs, laptops, and presentation terminals. 

 Sound systems. This group includes wireless and cable microphones, amplifiers and 
pre-amplifiers of different power, and two way speakers or three way speakers with 
different power levels. 

 Accessories. This group includes all types of accessories, such as cables, 
microphone stands, traverses, interfaces, and so on. These are not sold directly but 
are included with other products as needed. 

 Sets. Presentation sets, sound sets, and stage sets sell or rent more cheaply than the 
single components combined:  

o A presentation set consists of a laptop, a projector, and a projector screen. 

o A sound set consists of a microphone, speakers, and amplifiers.  

o A stage set consists of everything needed for a stage presentation. This 
includes a complete stage plus an adequate presentation and sound set.  

 

Only create those item groups and items in your prototype that are required in the business 
processes described in this specification document. However, you should be able to present a 
path for transferring data from the customer’s previous system. 
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4.2. Vendors 

Light & Music Ltd. has a total of 46 vendors. Light & Music Ltd has an agreement with some of 
them to receive special prices and payment terms. These vendors are called contractors and 
Light & Music Ltd. usually buys most of its material from them. All the other vendors are called 
suppliers. For your prototype, it is sufficient if you create four vendors. 

 Contractors:   

Sound Systems Ltd. 
Media Equipment Corp 
 

 Suppliers:   

Global Electronics Corp 
Spotlights Ltd. 
 

Sound Systems Ltd. supplies microphones, amplifiers, and speakers, while Media Equipment 
Corp supplies screens, computers, and players.  

Global Electronics Corp supplies Light & Music Ltd. with accessories. Spotlights Ltd supplies 
lights and light bulbs. 

Light & Music Ltd. is trying to get a master agreement with Spotlights Ltd. from whom they buy 
stages and lights, but they are still in negotiations. Please show how they can store the 
progress of their negotiations in the system.  

Show how Light & Music Ltd. can store their vendor agreements in the system. These vendor 
agreements are in the form of Word documents.  

All vendors offer a 3% discount if payment is made within the first week and 2% discount in 
the second week. Full payment is expected within 30 days.  

4.3. Customers 

Light & Music Ltd. has 152 regular customers in four countries. To enable better analysis of 
these customers and their usage habits, they have categorized them in four groups: 

 Hotels 

 Stadiums  

 Companies 

 Architects 

For your prototype, it is sufficient to create the following customers: 

 Hotels:  
MAX Hotel Group, London, UK 

 Stadiums:  

London Coliseum, London 
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 Companies:  
English Oil Corp, 23 Business Street, Bath 

 Architects: 
Christopher Wren Jr., Church Street, Glasgow 
 

Purchases made by occasional customers are processed under the generic account K999. 

Light & Music Ltd. offers a 2% discount to stadiums and architects when paid within the first 
14 days. Full payment must be received within 30 days. Hotels are required to pay within one 
week. Occasional customers must pay immediately. 

Existing customers get 5% discount provided there are no overdue payments and they placed 
an order previously during the last 6 months.  However, Michael Smith wants to be informed if 
the gross profit on a sales order falls below 30%.   

For orders over 25,000, customers must pay a deposit of 15%.  

Light & Music wants to offer promotional discounts for a limited time on some products, such 
as sound systems and computers. Please show how this can be supported.  

For equipment rental, the customer must pay a deposit by credit card or other advanced 
payment. Credit card deposits require authorization of funds.  

International customers need to be billed in their own currency, and Michael would like you to 
show how these customers can receive correspondence automatically in the correct language.  

In order to maintain good customer relations, Light & Music Ltd. sends a birthday present to 
the managing directors of their 18 major customers. Please show how SAP Business One can 
automatically remind them a week before the birthday. 

 

4.4. Employees 

The company has 30 employees. For the prototype, it is sufficient if you create the following 
employees: 

o Michael Smith - CEO 

o Claire Thomas – Chief Accountant 

o Richard Long – Warehouse Manager 

o Sarah Miller – Sales Manager (responsible for sales and rental revenues) 

o Edward Petty – Purchasing Manager 

o John Edison – Production Manager 

o Clark Spencer – Service Manager 

o Mark Myers ‐ Technician 
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5. Accounting 
Light & Music Ltd. uses the standard UK chart of accounts. They do not need account 
segmentation. Mr. Smith would like you to demonstrate how to create and delete additional 
accounts.  

The company’s fiscal year corresponds to the calendar year and they create the annual 
financial statement once a year. They need twelve posting periods for their internal controlling.  

One goal of the implementation of SAP Business One is so Light & Music Ltd. can report on 
the revenues and expenses of its different business areas. These areas are sales, rentals, 
installations, and consulting.  

Light & Music Ltd. runs its accounts at National Bank in London. Please rename the relevant 
accounts in the standard chart of accounts accordingly.  

Light & Music Ltd. pays its expenses via bank transfer. Customers pay by check or credit card. 
For the prototype you should to show a fast and efficient method for creating outgoing 
payments and show how incoming payments are handled.  

The accounting department requests that you use the following accounts. Please create them 
if they are not available in the standard chart of accounts. 

Control Accounts 

140000 Domestic Receivables 

140030 Foreign Receivables 

203000 Domestic Payables 

203030 Foreign Payables 

Tax Accounts 

207000 VAT Payable (output tax) 

143030 VAT Receivable (input tax) 

Banking Accounts 

161000 National Bank 

161016 Checks received 

140100 Master Card Settlement 

140110 Visa Settlement 

140120 American Express Settlement 

161012 Bank transfer 

160000 Petty Cash 

700010 Cash Discount received 

450005 Cash Discount granted 

650010 Bank charges paid 
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655040 Rounding Account for currency differences 

700020 Realized Exchange Rate Differences Gain 

650040 Realized Exchange Rate Differences Loss 

Stock Postings 

130000 Raw Materials 

131000 Work in Progress 

132000 Finished Products 

500500 Stock Difference Gains 

500510 Stock Difference Losses 

Sales Postings 

400000 Domestic Revenues Account 

410000 Foreign Revenues Account 

500005 Raw Materials – COGS  

500025 Finished Good – COGS  

132008 Returned Goods 

Purchasing Postings 

500520 Expense Account for Consumables 

208040 Allocation Costs (GRNI) 

500200 Price Difference Account 

Other accounts 

615100 Stock Insurances 

510000 Wages and salaries 

144080 Advance Payments 

340000 Retained Earning Account 

399999 Opening Balances 

 

Currently all stock is posted only to one of three stock accounts: raw materials, work in 
progress, and finished goods. With the implementation of SAP Business One, they would like 
each item group to have its own stock account.  

When there are special events, Light & Music Ltd. wants to know how much they earned with 
it, even if they were working for different customers during that event. This is especially true 
when it is a big event such as a trade fair with products and services. Please show how this 
can be realized with SAP Business One.  

Light & Music Ltd. has insured its stock against damage by fire and water. The annual cost for 
insurance is £12,000 (12000 British Pounds). In January Light & Music Ltd. posts the entire 
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sum to an Advance Payment account immediately after posting the invoice. This account is 
then gradually cleared throughout the year as an insurance payment of £1,000 is posted every 
month to the stock insurance account. Mr. Smith would like you to demonstrate how this can 
be handled as easily as possible.  

Monitoring their liquidity is very important to Light & Music Ltd. Recurring postings need to be 
automatically included in the cash flow forecast. Future investments should also be included 
when they are already known. For example, Mr. Smith is planning to purchase three new 
company cars next month for £50,000. These will be paid for in five monthly installments of 
£10,000 each. He would like you to show how this can be done in the SAP Business One 
system.  

Light & Music has invested heavily in specialized equipment for building the multi-screen 
products and would like to depreciate these costs. They also own 2 large articulated trucks for 
delivery of multi-screens to large events.   

 

6. Logistical Business Processes 

6.1. Warehouse Management 

Each office (London, Cardiff, and Glasgow) has its own warehouse where it stores rental 
items and sales items. Rental and sales items are kept separated because Light & Music Ltd. 
only sells new items.  

The warehouse in London consists of two areas. Each area has five rows and each row 
consists of three shelves. The bottom shelves within a row of an area are used to store the 
larger items groups such as Screens, Sound Systems, Projectors and Computers. These 
bottom shelves need to be marked clearly as to which item belongs there. The middle and top 
shelves store the smaller items. Because Light & Music Ltd. often employs temporary workers 
for picking, they would like to be able to show and print the storage location of the item on the 
pick list.  

Light & Music Ltd. conducts their inventory valuation once a year. With SAP Business One, 
they expect to have a permanent overview of their current stock level. All purchased goods 
should be valued with the moving average price per item and warehouse. The multi screens 
should be valued with a standard price of:  

 £10000 for a 3x3 multi screen 

 £18000 for a 4x4 multi screen 

 £28000 for a 5x5 multi screen 
 

Light & Music Ltd. has an extensive sales and rental catalog covering their range of products. 
They would like to store the catalog pictures in the corresponding item master records so that 
they can use them in printed quotations. 

For the prototype, show how SAP Business One can meet all of Light & Music’s warehousing 
needs.  
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6.2. Purchasing 

Light & Music Ltd. purchases most of their items from their contractors. When entering an 
order, they would like the system to suggest only the items that are supplied by the contractor 
already entered.  

Once an order is placed, the system needs to show that the stock is ordered. When the stock 
is delivered the warehouse, the items are receipted into the warehouse. This document should 
not affect the supplier balance, but only update the stock quantity on-hand. Only once the 
supplier has invoiced Light and Music Ltd., should the supplier account balance be affected.  

They have all their suppliers’ price lists available. In general, prices are valid for one calendar 
year and the suppliers send Light & Music Ltd. new price lists regularly. The contractors send 
the price lists as Excel sheets. Mr. Smith is wondering if there is a way to import these Excel 
sheets into the system. If there is, can you please demonstrate this to him.  

In order to compare supplier prices, Light & Music Ltd. wants to be able to display all price lists 
in a table, so if this is possible, please also demonstrate this.  

Light & Music Ltd. has a special agreement with Media Equipment Corp for the 40-inch LCD 
displays for the multi screens. When they buy 50 pieces, they get a discount of 10%. When 
they buy 100 pieces, they get a discount of 15%.  

Please configure and demonstrate the entire purchasing process in an SAP Business One 
scenario while taking into account these basic conditions.  

 

6.3. Sales 

Light & Music Ltd. sells items from all item groups and they want to optimize their sales. In 
order to ensure punctual delivery, they wish to implement an automatic availability check. If an 
item is not in stock, they want to be able to offer him similar items. Please show how this can 
be accomplished.   

The normal credit limit for all of their customers is £20,000. If this limit is exceeded by up to 
£1000, the employee entering the order should receive a warning so that he or she can inform 
the customer about it. If the deviation from the credit limit is more than £1000, the system 
should block the order. Only Michael Smith can approve such a sales order.  

An important feature for Light & Music Ltd is to allow sales employees to display the gross 
profit per item when they are processing sales documents. They calculate the gross profit 
percentage as profit divided by the costs of the item.  

Some concert venues might require additional lights or speakers that were not planned for. 
This means that Light & Music Ltd. will deliver lights and speakers to the customer’s 
warehouse. The customer informs Light & Music Ltd. whenever they use an item from the 
warehouse. Then the customer receives an invoice for these items. The items stored in the 
warehouse at the customer still belong to Light & Music Ltd. and therefore must appear with 
the correct amount in the stock list. 

Accessories are drop shipped directly from the supplier to the customer. Light & Music Ltd. 
only accepts the purchase order and forwards it to the vendor. The supplier invoices the 
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delivery to Light & Music Ltd. and they invoice the items to their customers. This process 
should run automatically as much as possible. 

Once the order has been placed, the stock will be picked from the warehouse and packed 
ready for delivery. Mr. Smith would like you to depict the entire sales process in an SAP 
Business One scenario including the picking and packing functionality. For packing, Light & 
Music Ltd. works with two package types; one for items up to and including 100 kg and the 
other for items that are than 100 kg. For every delivery Light & Music Ltd. charges a freight fee 
of £5.  

In addition, Light & Music Ltd. consults with architects and engineers planning communication 
systems for complex building projects. They would like you to show how these consulting 
services can be invoiced.  

Some scenarios exist where the customer’s delivery might be earlier than expected resulting 
in some items being returned temporarily to Light & Music Ltd. The customer would like to 
keep these items available for the next delivery by referencing the original order that was 
placed.  

Michael Smith and Richard Long have a question regarding stock returns from customers that 
might have been based on deliveries in their previous legacy system. When the stock is 
returned into SAP Business One, could they indicate what the cost of the item should be 
before posting the return?  

 

6.4. Production / MRP 

Multi-screens are produced in their London premises. From here they are shipped to the 
customers. They would like you to demonstrate their production order recommendations 
through MRP. They want to see the system process for producing some of the standard multi 
screens as well as how SAP Business One would handle the production of a special extra 
large multi screen (7x7) ordered by a customer.  

 

6.5. Rental 

Light & Music Ltd. rents out items from all item groups. Rental customers receive a printed 
rental agreement that should contain a note informing them that the items must be brought 
back in an undamaged state and if there is any damage, the customer will have to pay for 
repairs.  

The estimated return date should be saved in the system. When the item is returned, an 
invoice is created for the rental based on the amount of time it was out. At this point, all open 
transactions need to be closed and the item should be available once again. 

If an item is already rented, Light & Music Ltd. wants to be able to run a report to show its 
expected return date. In order to optimize their rental offers, Light & Music Ltd. would like to 
have an assessment of the rental time and rental frequency of their rental items.  
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Mr. Smith would like you to demonstrate how the SAP Business One system can address their 
rental requirements.  

 

6.6. Service 

Light & Music Ltd. includes a two year warranty with every item they sell. The items have a 
serial number that is comprised of the item code, the year, and a sequential number. The 
standard service is limited to working days from 08:00 to 17:00 and does not include holidays. 
If necessary, a technician travels to the customer to fix the problem within 5 business days. 
Labor and travel are free of charge, as are any parts required to make the repair.  

Of course, Light & Music Ltd. also wants to submit a warranty claim to the vendor if a product 
is defective. Therefore, when Light & Music Ltd. receives items equipped with serial numbers 
by the manufacturer, these serial numbers must be entered.  

 

 

7. Conclusion 
Provide an implementation plan and a prototype demonstrating how SAP Business One can 
meet all of the needs of Light & Music Ltd. Use the Accelerated Implementation Program 
(AIP) to help you put this together. You will present this to Mr. Smith and the key 
stakeholders at Light & Music Ltd (otherwise known as your instructor and classmates).  

 

 

Good Luck! 
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